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Before you begin… 

What’s in this course? 

This course is designed to introduce you to MetaSolv Solution and teach you how to use the network 

templates. MetaSolv Solution is an inventory tracking application designed to help 

telecommunications and network engineers perform two major tasks: document the equipment used to 

provision data and voice communication, create facilities and assign customer circuits. 

Who’s it for? 

This course is for the people who will be using MetaSolv Solution to create products, build and 

maintain networks, enter customer service requests and provision the customer service requests. 

Typically the groups of people that use MetaSolv Solution include: network planners, network 

engineers, network implementators and network provisioners.  

What should you know? 

Before taking this course, you should have general telecommunications knowledge. You should 

understand how to enter, modify and assign to equipment in the MetaSolv Solution. 

What’s the course plan? 

The plan is to create networks, build products, enter customer service requests,  and provision 

customer services. 

PART 1—Part one will help you understand the basics of MetaSolv Solution. You will understand the 

layout and the graphical user interface before you begin using the functionality to manage your 

inventory.  

PART 2—In part two, you will install equipment, build networks, a product and provision a customer 

service request. 

PART 3— In part three, you will build a virtual private network (VPN) product, enter a customer 

service request and then provision the customer VPN. 
 

PART 4—The fourth part of this course consists of several labs to be performed by students. It also 

contains the answers to reviews and exercises throughout the course. 
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You are here 

The diagram below depicts where Objectel fits into the end-to-end service activation process. 
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Part 1 

Part one will help you understand the basics of MetaSolv Solution. You 

will understand the layout and the graphical user interface before you 

begin using the functionality to manage your inventory.  
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Introduction 

What you’ll learn in this chapter 

n this chapter, you will learn how to navigate through the graphical user interface and customize 

menus and toolbars. 

 

Objectives 

At the end of this chapter, you will be able to: 

• Customize your desktop 

• Understand the available working windows 

Desktop 

When you first logon to MetaSolv Solution, you are brought to My Desktop and all available modules 

may be viewed. If there are specific areas of the software that you will be working in, you can 

customize your desktop to view only those areas.  

Chapter 

1 

I 
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Customize navigation bar 

You can customize the navigation bar at the left side of the screen. You can add new groups, edit 

groups and change the order of groups. Groups contain a collection of links. You can also create 

separators. Separators are lines that separate links within a group. 

Change color schemes 

You can select from several color schemes to change the colors of the windows. 

Basic navigation 

You can hide the navigation bar on the left side of the window by clicking the left arrow next to the 

words My Desktop. 

 

To show the navigation bar again, click the right arrow underneath the MetaSolv Solution bar. 

Navigation Bar 

Menu 

Group 

Groups 

Links 
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When you are working in the graphical canvas with templates or network designs, you can hide the 

panels by using the left arrow button above the panels. 

 

To show the panels again, click the right arrow below the menu. 
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Network Template Overview 

What you’ll learn in this chapter 

his chapter is designed to provide high-level background information on the features and 

functionalities of network templates. It also provides some core definitions you will need to 

customize templates and design network systems. MetaSolv Solution 5.1 includes a template-

based platform that includes predefined rules specifying how to design networks, order products, and 

provision service. These rules are not hard-coded into the software, but by customizing the templates, 

you can modify them to meet your specific business needs. 

Objectives 

At the end of this chapter, you will be able to: 

• Define various terms supporting network templates. 

• Navigate the graphical canvas. 

• Describe the downstream effects of network templates. 

• Identify processes for securing templates. 

Network template terms 

When you license a specific technology with MetaSolv, you receive a technology module that 

includes predefined template types, templates, and documentation about the contents of those 

templates. The templates include the rules that you use to build network systems and to provision 

across those networks. To change the rules, you modify the network templates. 

Network templates 

A template type can have multiple templates. For example, the ATM/FR template type has two main 

network templates: ATM/FR Network and Layer 2 VPN. These two templates have several other 

embedded templates, such as ATM Access and Frame Relay Access. 

Chapter 
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Most of the template types include core and access network templates. The core network template is 

generally used to represent the provider network that customers do not directly connect with. The 

access network template is generally used to represent the network that directly connects the customer 

to the provider network. 

In this document, you will see the word “transport” used to reference a network template that includes 

both the access and core network templates. 

Network templates include elements, connections, graphics, and rules for a specific technology. If you 

do not have the technology module or network system type, you will not be able to create templates 

based on that particular technology. 

You can license the following technology modules: 

Technology Module Included Templates 

ATM/Frame Relay ATM/Frame Relay Transport 

Layer 2 VPN 

DSL DSL Transport 

DLC DLC Transport 

IP IP Transport 

IP/VPN 

MPLS MPLS Transport 

MPLS VPN 

Optical Optical Network 

Optical Sub-Network 

SONET/SDH SONET/SDH 

Ethernet Ethernet Transport 

Unclass PSTN 

 

The template provides a graphical view in the Network Design function that you can customize to 

reflect the elements and connections types that make up your network systems. With network 

templates, network designers can quickly design network systems. 

You can associate a template customized for a specific network system type with the products that 

your company offers over that network system type. This association prompts the ordering specialist 

to enter the appropriate data that is pertinent to the product type. 

Element types 

Element types are representations of nodes that can exist in a network system. Examples of element 

types include: 



N E T W O R K  T E M P L A T E  O V E R V I E W  

©MetaSolv Software, Inc. 9 

• Switch 

• Router 

• Another Network (cloud) 

• Aggregator 

Relationships 

The MetaSolv Solution software has Connection Types, Connection Specifications, and Prioritized 

Paths. The physical connections can be grouped as prioritized paths for virtual connections to ride. 

Connection relationship 

The template relationship is a future connection between elements. It defines the types of elements 

that an element can be connected with. The connection relationship can be either of the following: 

• Intranetworking—You can connect the element to another element in the same network. 

• Internetworking—You can connect the element to another element in a different 

network. 

Connection types & specifications 

The connection specs are the specific connections you can click to connect elements. They fall into 

one of the following connection types: 

• Physical—The bandwidth connections that are assigned to ports and connect elements.  

• Virtual—The connections that traverse the ATM/FR transport networks. These logical 

connections ride physical, bandwidth circuits and are not assigned to port assignment 

positions. A logical path is defined through the network. Bandwidth is allocated to the path 

when the data is transmitted. 

• Group—A group of physical connections aggregated to act as one connection. 

Prioritized paths 

Prioritized paths define the physical paths that a virtual connection can take through a network system 

when you use path analysis to provision a service. 

Assignable connection specs 

You can define the connection specifications that the virtual connection specification can relate to on 

other segments of the network template. 
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Custom attributes 

Custom attributes (CAs) are what you use to add an attribute, property, or value to a building block. 

They are custom because your specific business processes and practices dictate their use. 

Building blocks are the only areas of the software that you can associate with CAs. Templates, 

elements, connections, and connection allocations are the four building block types. The building 

blocks are predefined and are unchangeable. 

Approximately 80 CAs are included in the data that comes preloaded with M/5.1 and are available 

immediately so that you can associate them with building blocks. 

Navigating the canvas 

The primary areas in the Network System module of the software are the panel and the graphical 

canvas. The panels change, depending on whether you are in the Network Template Maintenance 

window or in the Network System Design window. 

Many of the panels have a menu icon. When you click the menu icon, a list of software options 

appears. These options differ, depending on the panel you have chosen. 

The graphical canvas is the tool that you use to view graphical representations of templates or 

networks. It provides a view of each element, as well as relationships between the elements. An 

example of the graphical canvas is shown below. 

 
 

Template panels 

A template panel provides a flexible means of defining what goes into the template canvas.  

Graphical Canvas 

Panel List 

 

Menu Icon 
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The panel lists the available network templates, element types, and connection specs for each 

available technology purchased. In MetaSolv Solution, you will find four different panels:  

 

The Network Templates panel contains the network systems and the templates for every licensed 

technology.  

The Element Types panel lists all of the elements that are included with the licensed technology 

modules. You can use the menu icon to view elements in text format or in a graphical view. 

The Connection Specs panel contains the details pertaining to each connection specification. 

The Network Template Detail provides an at-a-glance look at which element types and relationships 

are available for a specific template.  

Template canvas 

Below is an example of a canvas for an Ethernet access network template.  

 

 

The above canvas includes a switched router, an IP Network, and a subscriber management system 

(SMS).  

It also reflects the possible future connections (or relationships allowed) between elements.  
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Navigation tips and tricks 

To navigate throughout the canvas and panel, you can: 

• Add, move, or delete elements and relationships. 

• View properties. 

• Expand or open clouds. 

• Change the viewing size.  

• To add an element, you select it from the panel on the left and drag it to the canvas. Or you 

can right-click and click Add to Drawing. 

• To move an element on the canvas, click and hold down the mouse button on the element 

and drag it to the canvas. 

• To delete an element, right click and click Delete. Then click OK to the message prompt. 

Sometimes, you will not be able to delete an element because a relationship exists between that 

element and another. You will have to remove the relationship first, and then delete the element. 

You can view the properties of a template, element, or connection by right-clicking on any of them 

and selecting Properties. 

You can use the keyboard to navigate between the fields:  

• Ctrl-Arrow—To move to the following or previous word in a field. 

• Home—To advance to the beginning of the field. 

• End—To advance to the end of the field. 

You can expand and collapse clouds by double-clicking them. When you expand a cloud, the 

elements within the cloud appear. 
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Buttons and zoom features 

The graphical canvas has the following buttons:  

Button Purpose 

 

To save your template or network system. 

 

To print the text specifics of your network. (Available only on 
Network System Design.) 

 
Click the minus or plus button and highlight the area you want to 
zoom by dragging the cursor across the canvas to create a stretch 
box. 

 
TO INCREASE OR DECREASE THE SIZE OF THE IMAGES ON THE CANVAS 

IN PRESET INCREMENTS. 

 
To set the size of the images by selecting a percentage from the 
drop-down. The default value is 100 percent. 

 

Together—Navigate the canvas 

1. To view element properties, right-click the frame relay switch and click Properties. 

Note: Template Properties 

A list of the template property definitions are in Appendix B. 

2. To expand an embedded template, double-click the IP Network cloud. 

Note: Collapsing Networks 

Double-click a cloud again to collapse an embedded template. 

 

3. To resize element types on the canvas, click 400% from the size drop-down. 

4. In the size list, click 50%. 

5. In the size list, click Page. 

6. Click the Click and Zoom In tool . 

7. Use the mouse to draw a box around the SMS and the frame relay switch. 
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8. Click the Zoom Out tool . 

9. Right-click the canvas, and click Close Template. 

10. Click Yes to save. 

11. Double-click the USERnn Frame Relay Access Network template to open it. 

The network template should have the same view as when you saved the drawing with the 

IP Network expanded. 

12. To add element types, click the Element Types panel. 

13. Drag the Other Provider Network element onto the canvas area. 

14. In the panel, right-click and click Close Template. 

15. Click Yes to save.  

Downstream effects 

How you define the network element types and connection specs in your network templates will 

affect: 

• Network design 

• Orders 

• Provisioning 

Downstream effects—Network design 

The element and connection relationships you use to design a network inherit the properties you 

defined for that element and connection relationship in the template.  

For example, assume in the frame relay core template, you customize a bandwidth connection 

between two frame relay switches to have a transmission rate of OC-3. If you use that template to 

design a network, you will not be able to associate any bandwidth connections between frame relay 

switches that do not have the rate code of OC-3. 

With the template, you do not need to redefine properties every time you add an element or 

connection to a system, and you cannot break any rules that underlie how your networks are to be 

designed.  

Downstream effects—Orders 

Network templates determine which systems, elements, and connections you can order on a product 

service request (PSR). 

When you build product offerings, you associate them with network templates, and those templates 

drive what you can order. 
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For example, assume an order has been placed for a virtual private network (VPN), and you are the 

ordering specialist. You select the VPN item type from the product catalog. The template previously 

associated with the product determines the types of elements and connections you can add to the PSR 

from that point forward. As you add items to the PSR, the properties defined for those items in the 

template may prompt you for additional information.  

Downstream effects—Provisioning 

The rules, properties, and custom attributes of an ordered item (system, element, or connection) 

associated with a template control how you provision that item.  

For example, assume you are the engineer on the VPN that was ordered in the preceding example. 

When you execute the NET DSGN task from your work queue, you will see the new network canvas. 

As you design each connection for the ordered VPN, the assignments you make will be driven by and 

will depend on the connection specs and equipment associated with the element types that you are 

making the assignment to. 

Customize a template 

From MetaSolv’s standpoint, the purpose of a technology module is to provide you with all the tools 

you will need to design your networks, process orders, and provision across those networks.  

When MetaSolv engineers designed the technology modules, they tried to consider every element and 

connection that might be needed to support the given technology.  

You can modify element types, connection relationships and specifications, and prioritized paths.  

For example, you can set the properties on a connection to Auto ID so that if you have correctly set up 

the provisioning plans and tasks, the software will identify the connections automatically. Also, if a 

connection is to be customer ordered, you must set the connection properties to be orderable. 

INACTIVATE AN ELEMENT  

You can prevent elements from being used, either by inactivating it.  

To inactivate an element, you remove the check from the Active check box in the element properties. 
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Remove locks 

It is recommended that the security administrator secure the templates and limit the access to 

individuals who are familiar with the networks. 

When a template is being modified, it is locked so that others see it in read-only mode and cannot 

modify it at the same time. Security administrators should have rights to this area of the software so 

that they can “unlock” templates. 

Removing locks allows you to have access to a network template, element type, or connection 

specification currently open by another user. It also lets you unlock an object that—because of a 

server crash—was never closed. 

Warning: Unlocking Templates 

The system does not warn the person who is using the template, element type, or connection 

specification that you are going to unlock it. Removing Locks does not automatically save any 

changes made by the person who locked the object. 

You should inform the person listed in the Locked By column that you intend to unlock the 

template, element type, or connection specification. Do not remove locks until you get that 

person’s consent. 

Steps to remove locks 

1. Click Engineering>Net Systems. 

2. From the primary toolbar, click Options>Remove Locks. 

Uncheck this checkbox. 
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3. From the Remove Locks window, right-click an object you want to unlock and click Remove 

Lock. 

4. Click Apply. 

Note: No Remove Locks Option 

To see the Remove Locks option from the menu, you must close out of any templates or 

network designs and return to the Network Systems window.
 

On Your Own 

Please answer the following questions and complete the fill-in-the-blanks exercise on the following 

page. 

 

1. In your own words, define the difference between a template and a template type. 

 ____________________________________________________________________  

 ____________________________________________________________________  

2.What is the primary reason for including templates from each technology that you license into a 

holding template? 

 ____________________________________________________________________  

 ____________________________________________________________________  

3.To create a reference template for the ATM/Frame TEM, what template or templates will you 

embed in the Holding template? 

 ____________________________________________________________________  

 ____________________________________________________________________  

4.2. Open the FR Access Network Template. What is the name of the embedded network template 

that resides in this template? 

 ____________________________________________________________________  

 ____________________________________________________________________  

5.3. Fill in the numbered blanks with the following terms: Element Type, Network Template, 

Relationship. 

 

 

Formatted: Bullets and Numbering

Formatted: Bullets and Numbering

Formatted: Bullets and Numbering

Formatted: Bullets and Numbering
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IP Network

Customer  Site

Voice Gateway

PSTN Switch

ATM  Switch

Aggregator

Service Management

System (SMS)

ATM  Core Network

1.

3.

4.

2.

 

 

Chapter Review 

N this module, you learned how to navigate the template canvas, remove locks and customize 

templates. 

 
I 
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Identify Technology Module data 

What you’ll learn in this chapter 

his chapter is designed to define the various data provided with MetaSolv Technology 

Modules.  To learn about technology modules, you will review the ATM/Frame Relay 

technology module. 

 

Objectives 

At the end of this chapter, you will be able to: 

• Identify technology module data. 

• Identify the data included with the ATM/Frame Relay technology module. 

Technology module data 

Each technology module includes various data including rules, elements, connections and custom 

attributes. Different technology modules will include various network templates. Some modules such 

as ATM/Frame Relay include six network templates, whereas, the SONET/SDH module includes one 

network template. In this chapter, you will review the data included with the ATM/Frame Relay 

technology module. 

ATM/Frame Relay technology module data 

The data included with the ATM/Frame Relay technology module appears in the various ATM/Frame 

Relay network templates. The data includes element types, relationships, and custom attributes. You 

can customize data to implement your products with your network systems. 

You can purchase various technology modules as software options. When MetaSolv Solution is 

delivered, the base data for the technology modules is included. The product key given to the 
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installation person is encoded to activate the purchased technology modules. After the product is 

installed, the technology module should be active. 

ATM/FR network templates 

The ATM/FR technology module has six network templates. 

You can use any combination of templates to build an ATM network, a frame relay network, or an 

Interworking network system. 

You build or customize your access and core network templates first and then embed them into the 

MetaSolv TM ATM/Frame Relay Network template. The core network template does not have a 

customer access connection to the network. You must use the access network template if you want to 

offer service that can be ordered and provisioned to customers. Or you can customize the core 

network template to include customer access connections. 

INCLUDED NETWORK TEMPLATES 

The following network templates are included with the ATM/ Frame Relay technology module or 

ATM_FR template type: 

 

Element types 

As with network systems, you can pick and choose the element types that meet your network 

requirements, or you can add new ones. Below are the element types included with the various 

network templates. 

ATM/FRAME RELAY 

The following diagram illustrates the data that is included with the MetaSolv TM ATM/Frame Relay 

network template. You can see four different clouds displayed on the graphic canvas. Each one of 

these clouds is considered an embedded template in the MetaSolv TM ATM/Frame Relay Network 

template. 
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The customer site appears on the network template above. However, when you use this template for 

designing the transport network system, the customer site will not be an available element because it 

is not part of the provider’s transport network. The customer site appears on the template so that you 

can order customer access and provision across the transport network. 

ATM CORE 

The ATM Core network template includes only the ATM switch as an element type. 

Below is an example of the ATM Core Network template. 

 

The large loop around the switch means that you can connect to the same element type in a network 

system that you used this template to build. 
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FRAME RELAY CORE 

The Frame Relay Core network template includes only the frame relay switch as a network element. 

 

ATM ACCESS 

The following element types are included with the ATM Access Network template: 

• Customer Site 

• Aggregator 

• IP Network 

• Public Switched Telephone Network  

• Voice Gateway 

• Subscriber Management System (SMS) 

• ATM Switch 

Below is the ATM Access Network template: 
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The PSTN and the IP Network are represented as clouds because they are considered embedded 

element types. To modify data for one of these element types, it would be necessary to open the 

corresponding network template to make the changes.  

FRAME RELAY ACCESS 

The following element types are included with the Frame Relay Access Network template: 

• Customer Site 

• IP Network 

• Frame Switch 

• SMS 

Below is an example of the Frame Relay Access Network template: 
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As you can see, connections to element types appear inside the expanded (or embedded) cloud (IP 

Network). The IP Other Provider Network, as indicated by the cloud with the diagonal lines, cannot 

be expanded in this template or in the IP Network template. Other than a connection to the cloud, no 

direct association exists to any element within the IP Other Provider Network. 

Connection specs 

Several connection specifications are included with the ATM/FR technology module: 

• Assignable Bandwidth Links—The physical connections between elements. 

• Unassignable Bandwidth Links—The physical connections, such as DS1s, that are used 

with inverse multiplexing. 

• Inverse Multiplexing Group—An aggregate group of connections used together to 

allocate more capacity. 

• Enterprise Connection—A virtual connection that you use to connect one customer site 

to another customer site. 

• Internet Connection—A virtual connection that connects a customer site to the Internet. 

• Switched Virtual Circuit—A virtual connection that can connect a customer site to a 

switch. No set path exists through the network because the route is established on a call-

by-call basis. 

• Voice Connection—A virtual connection from a customer site to the Public Switch 

Telephone Network (PSTN). 

• V5.2 Facility Circuit—A physical connection used to access the PSTN over E1 facilities.  

• GR-303 Group—A group of GR-303 connections to access the PSTN.  

• V5.2 Group—A group of 5.2 connections to access the PSTN. 

• GR-303 Facility Circuit—A physical connection to access the PSTN. 

Demo—Look at relationships and specs 

Watch as your instructor opens the Frame Relay Access network template and views the connection 

relationships and the associated specifications. The instructor will also show you how to add 

connection specs to a relationship. 
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Prioritized paths 

Prioritized Paths are the physical paths that a virtual circuit can ride over a transport network. You can 

create multiple paths for virtual circuits and prioritize them.  

The figure below shows two paths between the customer site and the PSTN. The thin lines represent 

the physical connections and the thicker lines represent two different virtual paths. 

 

 

During service provisioning, a designer can manually provision service or have it done through path 

analysis. If the designer decides to let the software select the path used for provisioning, the highest 

priority path with available positions will be used to provision service.  

Custom attributes 

Numerous custom attributes are predefined for use with the ATM/Frame Relay technology module. 

Many of the items covered in the ATM/Frame Relay Overview in this module might appear as custom 

attributes throughout the process of ordering and provisioning ATM/Frame Relay services. 

You will most likely see the following Custom Attributes: 

• Broadband Service Category—To choose “Cell” for ATM or “frame relay” for frame 

relay transport. 
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• Bit Rate—To select the bit rate of a connection. 

• UNI/NNI—To choose whether the connection is a User to Network Interface (UNI) or a 

Network to Network Interface (NNI). 

• Tagging Option—To identify the customer’s cell loss priority, related to discarded cells 

during congestion. 

• Service Parameters/QoS—To identify parameters based on the Broadband Service 

Category selected. 

Together—View the FR access template 

 

1. Click Engineering>Net Systems>Templates. 

2. Click the Network Templates panel. 

3. Expand ATM_FR by clicking the “+.” 

4. Double-click Usernn FR Access Network. 

5. In the Network Template Detail panel, expand Element Types to view the element types 

available with this template. 

6. In the Network Template Detail panel, expand Relationships to view the available connection 

types. 

7. In the Network Template Detail panel, expand a relationship to view the connection 

specifications associated with the connection types. 

8. Right-click the canvas and click Close Template. 

Together—View prioritized paths 

Open the ATM Access Network template and view the connection between the customer site and the 

PSTN.  

1. Open the ATM Access template. 

2. Right-click the relationship between the customer site and the PSTN and click Properties. 

3. Click the Connection Specs link. 

4. Double-click Voice Connection. 

5. Click the Assignable Connection Specs link. 

6. Various segments can connect the customer site to the PSTN. (You can add your own 

segments from this window.) 

7. Click the Prioritized Paths link. 
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8. Double-click a prioritized path to open it. 

A path is shown between the customer site and the PSTN. You can change the paths, based 

on the assignable connection specs. 

9. Open the Layer 2 VPN template. 

10. Right-click the connection from Customer Edge Router to Customer Edge Router. 

11. Click the Connection Specs link. 

12. Double-click Layer 2 VPN Connection. 

13. Click the Assignable Connection Specs link and view the available assignable connection 

specs. 

Note: Layer 2 VPN Assignable Connection Specs 

The Layer 2 VPN template is preloaded, with VPN Links as the only type of assignable 

connection specs. This template has been modified to include various assignable bandwidth 

connections between ATM/FR elements. 

Because of this modification, you can provision the virtual connection over the VPN Links 

from the customer site and over the ATM/FR transport network. (You will see this 

provisioning in the Layer 2 VPN module.)
 

 

14. Close back to the Network Template window. 

Together—View custom attributes 

1. From the network template window, click the Connection Spec panel. 

2. Expand Virtual Connection. 

3. Double-click Internet Connection. 

4. Click the Custom Attributes link. 

5. Right-click the canvas and click Close Template. 

6. Click No to not save the template changes. 
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On your own—Review and exercises 

Open the Frame Relay Access Network template and answer the following questions: 

1. What connection specs are associated with the relationship between the customer site and the 

frame relay switch?  

 ____________________________________________________________________  

 ____________________________________________________________________   

2. What connection specs are associated between the SMS and the IP Network? In the current 

template configuration, what, if any, is the relationship from the customer site to the SMS?  

 ____________________________________________________________________  

 ____________________________________________________________________  

Open the ATM/Frame Relay Network template and answer the following questions: 

3. What connection specification is available to connect two customer sites?  

 ____________________________________________________________________  

 ____________________________________________________________________  

4. List four element types included in the ATM Access Network template.  

 ____________________________________________________________________  

 ____________________________________________________________________  

5. List the intermediate elements in the first prioritized path that connects one customer site to 

another customer site.  

 ____________________________________________________________________  

6. List three custom attributes associated with an Enterprise connection. Hint: Look at the panel 

list. Enterprise is a virtual connection.  

 ____________________________________________________________________  
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Equipment Overview 

What you’ll learn in this chapter 

his chapter is designed to provide very high-level background information on equipment 

specifications and installing equipment. 

Objectives 

At the end of this chapter, you will be able to: 

• Enter equipment specifications 

• Install equipment 

Equipment specifications 

An equipment specification is a reusable definition of a specific equipment type. Equipment 

specifications identify the basic characteristics of a piece of equipment. 

An equipment specification or spec can also be described as a generic template for a specific piece of 

equipment that will be re-used for installing equipment. For example, if you use the same type of shelf 

in multiple locations, you would have one equipment specification, but you would install it in the 

different locations. Once the equipment has been installed, you can add more specific information. 

Equipment types 

Equipment Types are the basic classification or category of equipment specifications. You can use 

equipment types to describe either a function or a grouping of specific equipment. MetaSolv Solution 

is preloaded with an extensive number of equipment types, or you can create your own equipment 

types. 
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Positions occupied 

The value in the Positions Occupied field indicates how many positions a specific piece of equipment 

occupies on another type of equipment. For example, a relay rack occupies zero positions in another 

piece of equipment because a relay rack is generally mounted to the floor or a wall; therefore, it is not 

occupying space in additional equipment. An OC12 SONET shelf might occupy twelve positions on a 

relay rack, while a DS3 Interface card occupies one position on the OC12 SONET shelf. 

 

 

Note: Relay Racks and Zero Mounting Positions 

Some equipment, such as a digital switch or a digital cross-connect system, can include a 

higher-level piece of equipment than a relay rack. For example, a Lucent 5ESS switch 

incorporates a piece of equipment called an “aisle,” which contains several cabinets (similar to 

relay racks). In this case, the aisle occupies zero mounting positions, and the cabinet occupies 

one position. 

 

Mounting positions 

The value in the Mounting Positions field specifies the number of positions or spaces in which you 

can mount or attach additional pieces of equipment. A mounting position can contain transmission 

and non-transmission pieces of equipment. The mounting positions of a specific piece of equipment 

can also have different names. For example, you could refer to the mounting positions on a relay rack 

as “bolt holes” and the mounting positions on a shelf as “slots.” 
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Port addresses 

A port address is the physical location, such as a wire connection, on a piece of equipment where 

signals enter or leave. Each port address has an assigned rate code. The rate code specifies the type of 

connection that can attach to the piece of equipment. Generally, cards have a physical port address, 

but shelves can also have physical ports. For example, a di-group channel bank has two DS1 ports, 

and an M-1-3 has one DS3 port. 

Line side – drop side 

Each physical port can have either a line side designation or a drop side designation. Typically, the 

line side ports represent the high-speed or incoming signal toward your network. The drop side ports 

represent the low-speed signals, either dropping to other equipment or away from the network to end 

users. 

Enabled port address 

An enabled port address is a software address associated with the physical port address. A physical 

port can have one or more levels of enabled port addresses. 
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The example above shows a physical DS3 port on a card. The DS3 card enables 28 DS1 port 

addresses. Each DS1 signal enables 24 DS0 port addresses. Therefore, after a connection is assigned 

to this DS3 physical port, you can assign 28 DS1 connections and 24 DS0 connections to each DS1. 

Virtual ports 

Virtual ports are conceptual ports on a piece of equipment that do not physically exist. You can use 

them to work with digital loop carrier (DLC) systems, where the capacity of the system is greater than 

the available transport channels. If you have enabled the IP Address Management software option, 

you can also use virtual ports to assign IP addresses generically to a piece of equipment. 

 

For example, you can design a DS1 port with 96 DS0 virtual ports. After installing the equipment, 

you can assign 96 DS0 connections to the DS1, although the DS1 has only 24 DS0 positions. 
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Port address placeholders 

Port address placeholders are associated with a specific mounting position on a shelf. They specify the 

number of ports and the associated rate code for the port on the cards installed in a mounting position. 

 

With port address placeholders, you can specify cross-connections between the mounting positions on 

the shelf and other pieces of equipment before you actually install cards in the mounting positions. 

For example, a typical OC12 add/drop multiplexer shelf has four groups of low-speed interface cards. 

When installed, the shelf will accept DS3, STS1, or OC3 cards. When you create an equipment 

specification for the OC12 shelf, you specify placeholders for the cards you will cross-connect after 

installation. Since each card has three ports, you specify three placeholders for each of the mounting 

positions. 

Each placeholder has an associated rate code. However, when you install cards with different rate 

codes (such as DS3 and STS1), you can specify a rate code of N/A to cross-connect to ports of any 

rate code. 

Software specifications 

A software specification is a reusable definition of a specific software type. It defines the basic 

characteristics of the software associated with a piece of equipment. 

Typically, you use software specifications with Internet equipment such as servers. Like equipment 

specifications, you categorize software specifications by software types. There are preloaded types, 

and you can create your own software types. 

Equipment specifications tab 

The Equipment Spec tab contains the basic required information about a piece of equipment, 

including the manufacturer’s name, equipment part and model numbers, and the number of mounting 

positions the equipment occupies. You must complete all o f the required fields, which appear in blue 

on this tab. The non-required fields add detail to the spec.  
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Some companies require additional information to assist in equipment installation and for maintaining 

an equipment inventory. Below is a list of the fields on the Equipment Spec tab: 

 

Field Name Field Description 

Type Displays equipment categories. For example, all relay racks are categorized as type 
RELAY RACK, regardless of the manufacturer or part number. 

Manufacturer The name of the manufacturer of the piece of equipment.  

Part Number A part number or serial number that the manufacturer assigns to the piece of equipment.  

Comm Code Manufacturer or vendor code that identifies a unit of equipment beyond its part number. 
(AT&T frequently uses Comm codes.) 

Issue Number The manufacturer’s issue number for the equipment. An issue number may simply identify 
a later version (or issue) of a piece of equipment.  

Model Number Displays the model number that the equipment manufacturer assigned to the equipment.  

ACRONYM Identifies an abbreviated name for a specific piece of equipment. The acronym can be up 
to ten characters and appears on the design lines, the CLR, and the DLR.  

Mounting Type A free-form text area to enter additional information about where and how this equipment is 
installed. 

Description A free-form text area to enter information that further describes an abbreviation or a code.  

Notes A free-form text area to enter comments describing the usage of the equipment. 

Positions Occupied Specifies the number of slots or mounting positions that this piece of equipment occupies 
in another piece of equipment. All base equipment must occupy zero mounting positions.  

Height in Inches Identifies the vertical dimensions of the equipment, measured in inches 

Depth in Inches Identifies the dimensions of the equipment from front to back, measured in inches.  

Width in Inches Identifies the dimensions of the equipment across the front, measured in inches.  

Material Code Identifies the material control code assigned to this equipment for inventory purposes.  

CLEI (checkbox) Common Language Equipment Identification; identifies a specific piece of equipment. 
Telcordia Technologies administers this standardized code. 

Line Equipment Indicator 
(LEN) 

Indicates that this is the last piece of equipment in a dedicated plant assignment block and 
can be used to terminate an outside plant at a central office. 

CPE Capable (checkbox) Customer Premise Equipment Capable; indicates that the equipment spec will be used for 
installation at the customer site.  

Virtual Mapping Capable  

(checkbox) 

Specifies that the equipment spec is for a device in the equipment hierarchy that supports 
cards with ports that can be pre-provisioned with the virtual path utility. 

Dynamic Build Virtual 
Port 

Indicates that you want to build the virtual ports after you install the equipment. 

Active Indicates that the status of an equipment or software specification is "Active." The number 
of equipment pieces using the spec appears beside this checkbox. 
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Configuration tab 

The Configuration tab contains configuration information about a piece of equipment. Use this tab to 

specify power requirements, loss and resistance ranges, transmit and receive signal levels, and signal 

loss or gain information. 

Filling in the Configuration tab is optional; however, if you want to automatically calculate analog 

transmission level points for channel units, you must fill out the fields on this tab. 

Field Name Field Description 

Power Requirements The amount of power that this equipment uses. 

Loss Range The amount of loss in dB that the equipment will tolerate on a cable pair. 

Resistance Range The maximum resistance in ohms that the equipment will tolerate on a cable 
pair. 

Transmit In Level The recommended input level in dB. 

Transmit Loss or Gain The recommended loss or gain in dB across the transmit side. 

Transmit Out Level The recommended dB value of the signal strength leaving the equipment on 
the transmit side. 

Receive In Level The recommended receive level in dB. 

Receive Loss or Gain The recommended loss or gain in dB across the receive side. 

Receive Out Level The recommended output level in dB on the receive side of the equipment. 

 

Mounting positions tab 

The Mounting Positions tab describes the physical view of mounting positions on a piece of 

equipment. For a shelf, the mounting positions represent where you install cards. A good practice is to 

specify the slot name for mounting positions on the shelf, whether the equipment has programmable 

or engineering capability or not. 

On a relay rack, mounting positions represent where you install other pieces of equipment. The slot 

names are not critical to the functionality of the specification. 

The Mounting Positions tab has the following fields: 

Field Name Field Description 

Line The system-generated line number assigned to each mounting position. 

Position A user-defined line number preference that identifies a specific mounting position on a piece of 
equipment. The number can start from 00 or 01. 

Group The user-defined group assigned to the mounting position. 

Slot Name The name for this slot on this piece of equipment. 

Slot Node Address The shelf mounting position of the node address. 

 Note: The Slot Node Address displays on an installed piece of equipment and in the 
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Field Name Field Description 

miscellaneous column of the CLR and DLR. 

Port Address Placeholders The port address placeholders specify the rate code and the number of ports a mounting position 
will have after a piece of equipment is installed in that mounting position. The best practice is to 
create placeholders only for the ports that can be cross-connected. 

The  (arrow) icon displays in the column after the slot node address and specifies that the slot 
has at least one port address placeholder. 

Sequential Port 
Numbering 

If a mounting position has a sequential port numbering scheme defined, a  (pound sign) 
displays in this field. 

Related Mounting 
Positions 

If a mounting position has a relationship to another mounting position, the port icon  displays 
in this field. 

Numbering mounting positions 

Several shelves include multiple rows to which you can attach cards or modules. For these types of 

equipment specifications, you must decide how you want them represented in the software. For 

example, in the drawing below, mounting positions 07 through 14 appear on two rows within the 

shelf. Therefore, it is necessary to define how the shelf numbering will be represented in the software. 

 

The SONET shelf above has sixteen card slots. You can see by the associated numbering in the 

graphic above and the software screenshot below how the card slots are represented in this example. 
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Port address tab 

Physical ports, also referred to as port addresses, are assigned a rate code and represent where the 

signals enter or exit the respective equipment. The rate code assigned to a port implies the ability to 

attach a connection with a rate code of equal value. 

The Port Addresses tab describes each port on a piece of equipment and has the following fields: 

Field Name Field Description 

Line System-generated number that uniquely identifies and sequences mounting positions and 
port addresses for an equipment spec or a piece of installed equipment. 

Node Address Concatenated node address for a port. Used to number a rack or shelf on the equipment 
spec or uniquely identify the rack or shelf at installation. 

Group User-defined field that indicates to which group a specific piece of equipment belongs. 
Groups within pieces of equipment allow for greater capacity. 

Rate Code Transmission rate code associated with a connection position or equipment port address.  

Line/Drop Identifies whether the port address is for the line side or the drop side of the equipment.  

VC Limit Maximum number of virtual connections allowed for the equipment port. 

Address Levels Number of pieces of equipment MetaSolv Solution takes into consideration when 
concatenating the node address for a port. 

Enabled Port Address Arrow 
(Not Labeled) 

Indicates that the corresponding port address has at least one enabled port address. If there 
is an enabled port address, it will be marked with an arrow in the column to the right of the 
virtual column. 

Port Addresses Total number of port addresses that this equipment provides. 

Default Mapping Type Specifies the default mapping scheme that a piece of equipment uses; VT1 to DS1 default 
mapping. The options are Lucent, Nortel, and straight. 

Use Async/Sync Indicator Specifies whether the port is asynchronous or synchronous. 

Prior View or create the previous level of enabled port addresses. 
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Field Name Field Description 

Next View or create the next level of port addresses or enabled port addresses. 

Virtual (checkbox) Indicates whether the selected port is virtual, if checked, or is physical, if unchecked.  

OPTIONS TAB 

The Options tab establishes a comprehensive list of all software and hardware options associated with 

the equipment specification that the vendor provides. When you install this equipment, you can 

specify which options, if any, are present on the installed equipment.  

At installation, when you define options for an equipment spec, you can use the Options tab to assign 

the options to a specific piece of equipment. Equipment options that you assign to installed equipment 

display in the Notes section on the CLR/DLR. 

The Options tab has the following fields: 

Field Name Field Description 

Option A code describing a specific option that is installed or can be installed in a piece of 
equipment. 

Description Information that further describes an abbreviation or code on a particular window. The 
description field displays the free-format description that was entered for the code. 

New Creates or adds a new record. 

Delete Removes an existing record. 

 

Together—Enter equipment specification  

You will enter an equipment specification for an OC1 SONET shelf that occupies 10 mounting 

positions in a relay rack. The Common Code of this OC1 shelf is 0, and this is the first issue of this 

shelf. The following graphic displays the cards to be installed and their mounting positions on the 

ACMETEL OC1 shelf. 

 

The OC1 SONET shelf has 14 mounting positions in which cards will be installed or placed. Each of 

the seven DS1 interface cards has four DS1 port address placeholders. (The DS1 INFP protect card 

does not have any port address placeholders.) 
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COMPLETE THE EQUIPMENT SPEC TAB 

1. Click Equipment>Equip Spec. 

2. Click New. 

3. In the Type list, click SHELF-SONET. 

4. On the Equipment Spec tab, enter the information from the table below: 
 

Field Name Input Value 

Manufacturer ACMETEL 

Part Number ACM-01-nn 

Comm Code 0 

Issue Number 1 

Model Number ACM-01 

Acronym OC1 Shelf 

Description OC1 Shelf used for 28 DS1s 

Positions Occupied 10 

Active Checked (default) 

COMPLETE THE MOUNTING POSITIONS TAB 

1. Click the Mounting Positions tab. 

2. In the Mounting Positions field, type 14. 

3. Press the Tab key on your keyboard. 

4. Enter information for the first four mounting positions as follows: 
 

Position Slot Name Slot node Address 

1 OAM  

2 Timing  

3 Main-1 M-1 

4 Main-2 M-2 

 

USE THE EQUIPMENT SPEC EDITS WINDOW TO ENTER MOUNTING POSITION DATA  

You use the Edits tool for editing multiple lines of information at a time. You can select a range of 

line numbers and enter data that is common to all lines in that range. 

1. Click the Edits button. 

2. Complete the following fields on the Equipment Specs Edits window: 
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Field Name Data 

Line Number (Left) 5 

Line Number (Right) 11 

Slot Name LS- 

Placeholders 4 

Rate Code DS1 

 

3. Click Apply. 

4. Click Close. 

The Mounting Positions tab displays “LS-“ in the Slot Name column for mounting 

positions 5 through 11. It also shows a port address placeholder arrow in the Port Address 

Placeholder column. 

Note: Port Address Placeholders 

For this spec, the DS1 “drop” ports are the only ports that will be cross-connected. 

5. Manually add the numerals to each slot name for mounting positions 5 through 11, as shown 

below: 
 

Position Slot Names Slot Node Address 

5 LS-1  

6 LS-2  

7 LS-3  

8 LS-4  

9 LS-5  

10 LS-6  

11 LS-7  

 

6. Manually complete mounting positions 12 through 14, as shown below: 

Position Slot Names Slot Node Address 

12 LS-8 (P)  

13 SYS CTL  

14 USER PANEL  

 

7. Click View. 

The Equipment Spec View window displays a treeview of what your installed equipment 

will look like. 
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8. Click Close. 

9. Click OK. 

10. Close back to the primary toolbar. 

Note: Port Address Placeholders 

The mounting positions for the high-speed slots (Main 1 and Main 2) and the low-speed 

protection slot (LS-8(P)) do not have port address placeholders. For this spec, the DS1 “drop” 

ports are the only ports that will be cross-connected. 

Together—Enter equipment specification  

You will create an equipment specification for the OC1 Optical Line Interface Unit (OLIU) card, 

which will be installed in the high-speed (or main) slots of the OC1 SONET shelf. The OC1 OLIU 

card has a line side port address of OC1 and drop side enabled port addresses of STS1, VT1, and DS1. 

The card uses the following signal hierarchy: 

• 1 OC1 = 1 STS1 

• 1 STS1 = 28 VT1s  

• 28 VT1s = 28 DS1s (1 DS1 signal for each VT1) 

For a digital signal (DS1) to ride on an optical network (SONET), it must be broken down through an 

electrical signal (STS1) and compartmentalized into virtual tributaries (VT1). 

COMPLETE THE EQUIPMENT SPEC TAB 

1. Click Equipment>Equip Spec. 

2. Click New. 

3. In the type list, click CARD-SONET. 

4. On the Equipment Spec tab, enter the information from the table below: 
 

Field Name Input Value 

Manufacturer ACMETEL 

Part Number ACM-02-nn 

Comm Code 0 

Issue Number 1 

Model Number ACM-02 

Acronym OC1 OLIU 

Description OC1 Optical Line Interface Unit 
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Field Name Input Value 

Positions Occupied 1 

Active Checked (default) 

 

COMPLETE THE PORT ADDRESSES TAB 

1. Select the Port Addresses tab. 

2. In the Port Addresses field, type 1. 

3. Press the Tab key. 

The specified number of port addresses displays on the screen. 

4. Complete the line 1 information as follows: 

Field Name Data 

Node Address Leave blank 

Group Leave blank 

Rate Code OC1 

Line/Drop Line 

VC Limit Leave blank 

Address Level Three 

SPECIFY THE FIRST LEVEL OF ENABLED PORT ADDRESSES 

The specification for accommodating subtending ring relationships includes three levels of enabled 

port addresses. The first level is for STS1. To specify the first level, perform the following steps: 

1. Place the cursor on the line for the physical OC1 port address. 

2. Click the Next (right arrow) button. 

A blank Port Addresses tab displays. 

3. In the Port Address field, type 1. 

4. Press the Tab key. 

5. Complete the line 1 information as follows: 

 

Field Name Data 

Node Address 1 

Group Leave blank 

Rate Code STS1 

Line/Drop Drop 

Address Level Three 
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SPECIFY THE SECOND LEVEL OF ENABLED PORT ADDRESSES 

The STS1 enabled port has 28 VT1 enabled ports. To specify the second level, perform the following 

steps: 

1. Place the cursor on the line for the enabled STS1 port. 

2. Click the Next (right arrow) button. 

A blank Port Addresses tab displays. 

3. In the Port Addresses field, type 1. 

4. Press the Tab key. 

The Port Address tab displays 28 lines with the default DS0 rate code. You are now ready 

to edit the enabled port address information. 

COMPLETE THE ENABLED PORT ADDRESS INFORMATION 

Next, you will use the Equipment Specs Edits window to complete the enabled port address 

information: 

1. Click the Edits button. 

2. Complete the following fields on the Equipment Specs Edits window. 
 

Field Data 

Line Number (Left) 1 

Line Number (Right) 28 

Group Leave blank 

Rate Code VT1 

Line/Drop Drop 

Address Level Three 

 

3. Click Apply. 

4. Click Close. 

 

SPECIFY THE THIRD LEVEL OF ENABLED PORT ADDRESSES 

Each VT1 enabled port has one DS1 enabled port address. Perform the steps below to specify the 

third level of enabled port addresses: 

1. Place the cursor in line 1 and click the Next (right arrow) button. 

A Port Addresses tab displays one line with a DS0 rate code. 
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2. In the Port Addresses, type 1. 

3. Press the Tab key. 

4. In the Rate Code list, click DS1. 

5. Click the Prior (left arrow) button. 

The second level of enabled port addresses displays. Notice that an arrow displays in the 

far right column to specify that the port has at least one enabled port. 

6. Place the cursor on the next line and repeat steps 1 through 5 for the next two VT1 enabled 

ports. Then each VT1 enabled port will have one DS1 enabled port. 

On Your Own—Enter equipment specification  

NewTel is growing rapidly and has purchased some DSL equipment from Alcatel, including a DSL 

shelf. Using the information provided below and on the following page, enter a new equipment 

specification in the equipment inventory.  

This DSL shelf includes slots for two main or high-speed cards and four low-speed DS3 interface 

cards, as well as slots for the corresponding DS3 protection cards. 

In addition, this shelf has mounting positions for the following: 

• Common cards (including a monitoring and alarm unit) 

• Power cards 

• Timing cards and control units 

Use the equipment specification graphic below and the data sheet on the next page to enter the 

equipment specification for this shelf. 
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Equipment Specification Data Sheet 

Type of Equipment Shelf - DSL  

Manufacturer Alcatel 

Part Number 7350 ASAMnn 

Common Code 0 

Issue Number  1 

Model Number 7350 DSL 

Acronym DSL shelf 

Positions Occupied 8  

Description Alcatel 7350 ASAM DSL Access Concentrator 

Mounting Positions and Descriptions  

Mounting Positions  14 (Refer to the drawing on the previous page to see the layout of the mounting 
positions.) 

PWRE (1 AND 2) Power - Converts primary power to secondary power. 

Main (1 and 2)  High-speed interface for Optical Line Interface Unit (OLIU) card (Include a slot node 
address of M-1 and M-2 respectively for the two main cards.) 

MAU Monitoring and Alarm Unit – Monitors and provides alarms for the near end and far end. 

TCU Timing and Control Unit – Provides a local clock for the system. 

LS-INF Low Speed Interface – Each position provides three DS3 port address placeholders. 

Hint: You may want to use the Edits function when entering the low-speed cards, and use 
the Groups field to enter Group information, as shown in the drawing. Remember, if you 
are entering the Group name on the Edits pop-up window, you will be able to enter only 
two lines at a time. 

LS–INF (P) Provides protection for the LS–INF working slot. 

 

On Your Own—Enter equipment specification  

In addition to the DSL shelf, NewTel also purchased a new ADSL line card to be installed in the low-

speed (LS - INF) slot of the DSL shelf. Use the information provided on the Equipment Specification 

Data Sheet that follows to enter equipment specifications for the ADSL line card.  

 

Equipment Specification Data Sheet 

Type of Equipment Card – DSLAM 

Manufacturer Alcatel 

Part Number 24A-nn 

Common Code 0 

Issue Number 1 
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Model Number 24 ADSL 

Acronym 24 ADSL 

Positions Occupied 1 

Description Alcatel 24 Port ADSL card fits 7350 ASAM 

Port Address Description 

Port Addresses 1 

Rate Code DS0 

Line/Drop Drop 

Address Levels Three 

Enabled Port Addresses Leave Blank (For this exercise, you will not define enabled port addresses.) 

 

Install equipment 

Once you have entered your equipment specifications, you can use them to install equipment at 

network locations. When you click on the Equipment Install button in MetaSolv Solution, the 

Equipment Install Query window displays. 

Because of the number of network locations stored in the MetaSolv Solution database, the query 

window forces you to enter at least the first letter of the network location you are querying. After 

entering the first letter of the network location, you can use the drop-down to search for the exact 

network location. To further narrow your search results, you can enter additional information in other 

fields. 

You can install equipment in three different ways: 

• Use an equipment specification. 

• Copy equipment from a “template” network location. 

• Use an equipment spec and associate it with a work order. 

When you install equipment at a network location, you must follow a hierarchy. For example, you 

must install a relay rack (or a piece of equipment occupying 0 mounting positions) before you install a 

shelf, card, or jack panel. Furthermore, before you can install equipment at a network location, you 

must have already created the network locations in the Infrastructure subsystem. 

 

Together—View installed equipment  

1. From the primary toolbar, click Equipment. 

2. On the secondary toolbar, click Install. 
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3. In the Network Location field, type DLLSTX00, and click Retrieve. 

4. Double-click relay rack 01.01.02 to expand the equipment hierarchy and display the installed 

shelves. 

ICONS ON THE EQUIPMENT INSTALL SCREENS 

The Equipment Install window displays many different icons. When you view the installed 

equipment, the following two icons are the most important: 

Icon Description 

 
Vacant Position – No equipment has been installed at this mounting position. 

 
Occupied Position - Equipment occupies (or equipment is installed at) this position.  

When you install a shelf on a relay rack, only the shelf’s first mounting position displays the Vendor, 

Part Number, and Shelf name. The remaining positions that the shelf occupies display in the mounting 

position <occupied>. 

To enter specific information, such as an Equipment Network Location or the name of a relay rack, 

for a specific piece of equipment after it has been installed, click the equipment mounting position and 

edit the equipment specification. 

Icon Description 

 

Default Position Numbering – This default numbering example identifies the 
mounting position (49), that a shelf is mounted in the relay rack, and the first two shelf 
mounting positions are 01 and 02. 

 
Line Side Port Assigned - A connection is assigned at this line position. 

Note: The complete connection icon and connection identification display to the right of 
the icon. The “L” shown above the connection icon indicates that this port is a line side 
port. If a plus sign displays, then you can expand the view of the position to display 
enabled port addresses. 

 
Line Side Port Unassigned - No connection is assigned at this line position, indicated 
by the incomplete connection icon. “Unassigned” displays to the right of the icon.  

 
Drop Side Port - A “D” identifies a drop side port. The open connection means that this 
port is unassigned. 

 
Mapped Position Indicator - The tiny “M” to the right of the D indicates that the 
enabled port has been mapped to a connection. 

 
Network Element Icon - The “N” indicates that the piece of equipment (almost always 
a shelf) is part of a network element such as a SONET network, digital loop carrier 
system, or a digital cross-connect system. 

 

Cross-Connected Indicator – The tiny “x” to the left of the connection icon indicates 
that the port has been hard-wired cross-connected to another port. A hard-wired cross-
connection can exist for both an Assigned and an Unassigned position. 
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Together—Install equipment 

You will install equipment using equipment specifications. The Houston NewTel office recently 

signed up a customer for a variety of dedicated line services. To accommodate this customer, NewTel 

will install one of its recently purchased OC1 SONET shelves (including OLIU cards) in the Houston 

office (HSTNTXnn). 

Install OC1 SONET 

1. On the primary toolbar, click Equipment. 

2. On the secondary toolbar, click Install. 

3. Enter HSTNTXnn in the Network Location field and click Retrieve. 

4. Open the equipment hierarchy of relay rack 01.01.02 to display the occupied and vacant 

mounting positions. 

5. Right-click mounting position 14 and click Add. 

6. Enter the following information on the Equipment Spec tab: 

Field Name Input Value 

Equipment type Shelf – SONET 

Equipment spec ACMETEL OC1 Mux, ACM-01-XX 

Network Location 
(Equipment) 

HSTNTXnnH02 

Node Address S14 

Notes Terminal Mode 

Install the OC1 OLIU Cards 

1. Double-click the OC1 SONET shelf just installed in mounting position 14 of the relay rack to 

expand the equipment. 

2. Right-click vacant mounting position 1403 and click Add. 

3. Use the following information to install the OC1 OLIU cards in mounting positions 1403 on 

the OC1 Shelf: 

Field Name Input Value 

Equipment type Card – SONET 

Equipment spec ACMETEL OC1 Card, ACM-02-nn 

4. Click OK. 

The ACMETEL OC1 OLIU card appears in mounting position 1403. 

5. Right-click the card you installed in position 1403 of the OC1 SONET shelf and click Copy. 

6. Right-click position 1404 of the relay rack and click Copy To. 
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The ACMETEL OC1 OLIU card appears in the 1404 position. 

7. Close back to the Equipment Install window. 

On Your Own—Install a DCS  

NewTel is in the process of adding more equipment to its Houston office. You will install a digital 

cross-connect system (DCS) to your MetaSolv Solution inventory, which includes a relay rack, two 

DS1 shelves, and two DS1 interface cards. All of the equipment that you install will be added to your 

HSTNTXnn network location.  

 

Installation Data Sheet 

Item 

No. 

Equipment Relay Rack 

Mounting Position 

Equip. 

Name 

Network 

Location 

Node 

Address 

01 Newton NWT-001 relay rack NA 01.02.01 NA R01 

02 Lucent DS1 DACS IV 8901 
(shelf-DCS) 

01 (01.02.01) NA HSTNTXxxK01 S01 

03 Lucent DS1 IV-2000-A (card-
DCS) 

1A and 2A of the DS1 shelf NA NA NA 

04 Lucent DS1 DACS IV 8901 
(shelf-DCS) 

17 (01.02.01) NA HSTNTXxxK01 S17 

05 Lucent DS1 IV-2000-A (card-
DCS) 

1A and 2A of the DS1 shelf NA NA NA 

Chapter Review 

n this module, you entered equipment specifications and installed equipment to network locations 

by adding the specifications hierarchically. I 
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Design Networks and Unordered 

Connections 

What you’ll learn in this chapter 

n this chapter you will learn the basics involved in designing networks and connections in 

MetaSolv Solution. 

At the end of this chapter, you will be able to: 

• Describe the process for designing networks 

• Navigate the graphical canvas 

• Identify the design line tools for connection design 

Process to design a network system 

Designing a network system involves the following high-level steps: 

• Select a network template and modify network properties 

• Add elements 

• Associate equipment or port addresses with the equipment 

• Add relationships between the elements 

• Design connections 

• Set network to "In Service” 

Chapter 
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Navigate network systems 

The area of the software on which you will design your networks is the Network System Design 

window, which is similar to the Template window. 

The Network System Design window contains two panes. The left pane, which you can drag to 

expand, contains panels you can use to select templates, or elements, or network systems. On the right 

is the canvas that displays the network system design. 

Graphical canvas 

You can view and work with the graphical representation of your network system on the graphical 

canvas. You control what appears on the canvas by making selections in the panel list on the left pane 

of the window. You can hide the main tool bar and the panel list to enlarge the canvas work area. 

To expand the canvas work area, click the hide/display buttons. 

Network system panels 

When you open the Network System Design window, the following panels display: 

The Network Template List panel contains a complete list of the templates available for designing a 

network. If you are creating a new network system, use this list to open a template. 

The Network List panel contains a complete list of all current network systems. The networks are 

sorted and presented by network system type. Use this list to open and display an existing network 

system that you want to view or modify.  

Detail panels 

When you select a network system to begin work, the panels change to show the details you need. 

When you are actively working on a network system on the canvas, the following panels display: 

The Network Template Detail panel provides details about the template used for the current network 

system. This is the same panel seen in the Network Template Maintenance window. 

 

 

The Network Detail panel provides details about the elements and relationships that appear in the 

network system that is displayed on the canvas. 
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Tool tips 

Tool tips provide a brief description of an element when the cursor floats over it on the canvas. To 

show tool tips, right-click on the canvas and select Show Tool Tips. To turn off the tool tips, right 

click and select Hide Tool Tips.  

Connection design 

Below is the process for designing non-ordered connections: 

• Create relationship between elements 

• Create connection and assign the connection identification 

• Save the network (?????) Will this change??? 

• Use the design tools to design the connection 

Steps to create a relationship 

To create a relationship: 

1. Right-click an element and click Connect. 

2. Drag the mouse to the second element you wish to connect and click the element. 

You will see a line connecting the elements. 

Steps to create connection and assign the connection 
identification 

1. Right-click the relationship between elements and click Properties. 

2. In the Template Connection Specs pane, select the type of connection to create and drag it to 

the Network Connection Specs pane. 

3. Right-click the connection type, and click New Connection. 

The connection identification window appears. 

4. Enter the connection information and click OK until you are returned to the canvas. 

Design tools 

Below are the various tools that you can use to create your connection design. 
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Design Optical and SONET 

Networks 

What you’ll learn in this chapter 

his chapter covers both the Optical and the SONET technology modules to help clear up the 

differences in which module should be used for building networks. This chapter consists of a 

hands-on activity in which you will use the Optical template to build a network. You will also 

use the SONET template to build a SONET ring.  

At the end of this chapter, you will be able to: 

• Build a DWDM network 

• Build a USPR network 

The optical technology module supports dense wavelength division multiplexing (DWDM) and 

meshed SONET networks. 

The SONET/SDH technology module supports ring validation for Unidirectional Path Switched Rings 

(UPSR) and Bidirectional Line Switched Rings (BLSR). You should use this template when building 

SONET rings so that MetaSolv Solution can validate the ring. 

When building networks you have the following options: 

• Inherent Protect—Set this to yes to create two paths through a network. 

• Same channel indicator—Set this to yes so that the same channel assignment is used 

throughout the network. This does not apply to subnetworks. When no is selected, the first 

available position for every network segment is selected. 

When building out SONET and Optical networks, you use the auto build feature to create the 

connection hierarchy for the underlying facilities.  

Chapter 
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Optical technology module data 

The data included with the Optical technology module appears in the Optical network template. The 

data includes network elements, connections, and custom attributes. There are two templates: optical 

and optical sub-network. The subnetwork element is embedded within the optical template. 

ELEMENTS 

As with network systems, you can select the elements that meet your network requirements or add 

new ones. Below are the elements included in both optical templates:  

• OADM—Optical Add/Drop Multiplexer. This network element offers access to traffic 

carried over optical wavelengths. Wavelengths are multiplexed together according to 

specifications administered by the ITU T-G.  Wavelengths are added or dropped to or from 

a fiber, without requiring a SONET terminal.   

• OXC—Optical Cross-Connect. Allows the connection of two different wavelengths of a 

DWDM network. 

• Filter—Equipment designed to pass signals in one or more frequency bands while 

attenuating signals in other frequency bands. 

• Optical Sub-Network—Used to embed smaller DWDM or meshed optical networks. 

• SONET/SDH network—SONET rings that can be embedded into DWDM networks. 

Optical template connection specs 

In the Optical template, the following connection types are available: 

• Facility Circuit—A facility that connects elements. 

Together—build DWDM network 

You will work with your instructor and on your own to build a DWDM network. You will add three 

nodes in Dallas, Boston, and Tulsa and connect them with OM04 facilities. 

Add element and associate equipment 

1. Select Engineering on the navigation bar, and click Network Designs. 

2. Click Network Template List. 

3. Expand Optical. 

4. Right-click MetaSolv TM Optical Template, and click Add Network Design. 

5. In the canvas, right-click and click Properties. 

6. In the Short Name field, type DWDMnn, and click OK. 
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7. Expand MetaSolv TM Optical Template>Element Types. 

8. Drag OADM to the canvas. 

9. On the canvas, double-click OADM. 

10. In the Name field, type Dallas OADMnn. 

11. In the Network Location field, type DLLSTXnn???? 

12. In the Status list, click In Service. 

13. Click the Equipment Assoc link. 

14. Double-click Add Equipment Association. 

15. Double-click Relay Rack ___________. 

16. Right-click 01 Cisco __------ and click Associate to Element, and click Close. 

17. Click OK. 

On Your Own—Add elements and associate 

equipment 

Use the steps above to add elements for the following locations: BSTNMAnnHnn, TULSOKnnHnn. 

You will associate the Cisco 15808 shelves to each element. 

Together—Add and design connection 

You will add a connection between the Dallas and Boston elements and design the connections. 

1. Right-click the Dallas Node and click Connect. 

2. Drag the cursor and click the Boston Node. 

3. Right-click the connection line from Dallas to Boston, and click Properties. 

4. In the Network Connection Specs window, right-click Facility Circuit, and click New 

Connection. 

5. Enter the following information: 

Field Name Input Value 

Service Type Category CLFI 

Service Type Code OM04 

Jurisdiction Interstate 

Facility Designation nn123 

Notes Terminal Mode 

 

6. Click OK, and click Yes to have CLLI codes alphabetized. 
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Rename connection 

1. Right-click the connection identification, click Set Connection Name, and click OK. 

2. Click Save. (You must save new connections to the network before you design them). 

Design connection 

You will add fiber and the equipment assignments to connect the Dallas and Boston locations. 

1. Right-click the Dallas/Boston connection, and click Properties. 

2. Right-click the nn123 connection, and click Connection Maintenance. 

3. Click the DLR Design link. 

ADD FIBER 

1. Click the Cable Pair link. 

2. (See Dave Campbell about what to enter here) 

 

 

Do we add cable pair sets? 

Functions: transmit, receive, S1, S2, X2, X4, none. 

 

It appears I must put this in plant first. Is this typical? 

 

ADD EQUIPMENT ASSIGNMENTS 

1. Click the Equipment link. 

2. At the A Location, double-click the equipment until the Cisco XC10G shelf shows the OM04 

port. 

3. Right-click the OM04 port and click Assign Connection. 
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4. At the Z Location, double-click the equipment until the Cisco XC10G shelf shows the OM04 

port. 

5. Right-click the OM04 port, click Assign Connection, and click Close. 

6. Click Save. 

On your own—Add and design connections 

Use the steps above to add a connection between Boston and Tulsa, and a connection between Tulsa 

and Dallas. Rename and design both connections. 

DWDM 
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SONET/SDH technology module data 

The data included with the SONET/SDH technology module appears in the SONET/SDH network 

template.  

ELEMENTS 

As with network systems, you can select the elements that meet your network requirements or add 

new ones. Below are the elements included in both optical templates:  

• OADM—Optical Add/Drop Multiplexer. This network element offers access to traffic 

carried over optical wavelengths. Wavelengths are multiplexed together according to 

specifications administered by the ITU T-G.  Wavelengths are added or dropped to or from 

a fiber, without requiring a SONET terminal.   

SONET/SDH template connection specs 

In the Optical template, the following connection types are available: 

• Facility Circuit—A facility that connects to elements. 

 

Build a SONET network 

You will build an OC48 SONET network between Dallas, Plano and Denton. You will build a UPSR. 

Together—Add elements and associate 

equipment 

1. Select Engineering on the navigation bar, and click Network Designs. 
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2. Click Network Template List. 

3. Expand SONET/SDH. 

4. Right-click MetaSolv TM SONET/SDH Template, and click Add Network Design. 

5. In the canvas, right-click and click Network Properties. 

6. Enter the following information: 

Field Name Input Value 

FNI  

Topology Ring 

Ring Type Physical 

Rate Code OC48 

Fiber Count 2 

Protection Type Path Switched SNCP 

TSI Enabled Unchecked 

Status Pending 

 

7. Click OK. 

8. Expand MetaSolv TM SONET/SDH Template>Element Types. 

9. Drag OADM to the canvas. 

10. On the canvas, double-click OADM. 

11. Click the Equipment Assoc link. 

12. Double-click Add Equipment Association. 

13. Double-click the relay rack. 

14. Right-click 01 Lucent LIN and click Associate, and click OK. 

15. Click OK. 

On Your Own—Add elements and associate 

equipment 

Use the steps above to add elements for the following locations: DNTNTXnnHnn, PLANTXnnHnn. 

You will associate the Lucent 15252 shelves to each element. 

Together—Add connection 

You will add a connection between the Dallas and Boston elements and design the connections. 

1. Right-click the Dallas Node and click Add Connection (from). 
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2. Right-click the Plano Node and click Add Connection (to). 

3. Click Next. 

4. Click Next. 

5. Click Finish. 

On your own—Add connections 

Use the steps above to add the connection from Denton to Plano and  Denton to Dallas. 

Together—Activate and validate network 

1. From the menu, click Options>Activate Pending Changes. 

This changes all the connections from Pending to In Service. 

2. From the menu, click Options>Validate Topology. 

A message appears that the topology is valid. 

3. Click OK. 

Step to add mileage (separations route) 

You can add the connection mileage known as separations route to each connection in a ring. You can 

create a new separations route or associate a separations route with the connection. 

1. Right-click a connection, and click Open>Separations Route. 

2. Click New to enter a new separations route. 

OR 

3. Select an existing separations route from the lower pane of the window and click the Up arrow 

to add it to the connection. 

 

Together—Build network facilities 

1. From the menu, click Options>AutoBuild. 

2. Click Next through the dialog, and then click Finish. 

The defaults create an OC48 connection between each node, with 48 STS1 and virtual 

tributaries. 

3. Click Save. 



D E S I G N  O P T I C A L  A N D  S O N E T  N E T W O R K S  

©Metasolv Software, Inc. 65 

Together—Design connection 

You will add fiber and the equipment assignments to connect the Dallas and Plano locations. 

1. Right-click the Dallas/Plano connection, and click Open>Circuit Design. 

2. Right-click the nn123 connection, and click Connection Maintenance. 

3. Click the DLR Design link. 

ADD FIBER 

4. Click the Cable Pair link. 

 

Do we add cable pair sets? 

Functions: transmit, receive, S1, S2, X2, X4, 

none. 

 

It appears I must put this in plant first. Is this 

typical? 

 

ADD EQUIPMENT ASSIGNMENTS 

1. Click the Equipment link. 

2. At the A Location, double-click the 

equipment until the OC48 port is available. 

3. Right-click the OM04 port and click Assign Connection. 

4. At the Z Location, double-click the equipment until the OC48 port is available. 

5. Right-click the oc48 port and click Assign Connection, and click Close. 

6. Click Save. 

On your own—Add and design connections 

Use the steps above to add a connection between Plano and Denton, and a connection between Denton 

and Dallas. Rename and design both connections. 

Together—Put the network In Service 

1. Right-click the canvas, and click Network Properties. 

2. In the Status list, click In Service. 

3. Click OK to clear the message. 

4. Click OK to close the network properties window. 
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Chapter Review 

n this chapter, you used the Optical Template to build a DWDM network, and you used the 

SONET/SDH template to create and validate an Unidirectional Path Switched Ring. 

 
I 
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Design ATM/FR Network  

What you’ll learn in this chapter 

his chapter is designed to teach you how to use the network templates in MetaSolv Solution to 

build out your network systems. Then you will enter your locations, equipment, elements, and 

relationships. Finally, you will design your connections. 

 

Objectives 

At the end of this chapter, you will be able to: 

• Design an ATM Core network. 

• Design an ATM Access network. 

• Design a Frame Relay Access network. 

• Embed networks. 

Scenario 

Based in Dallas, Texas, Zesty Communications is an integrated service provider that offers high-speed 

Internet access and data services primarily to medium- and large-sized organizations. In the Dallas 

market area, where it owns a great deal of local fiber, Zesty Communications has built out a 

substantial access network. 

The company owns an ATM/Frame Relay transport network that comprises three metropolitan areas: 

• Dallas 

• Tulsa 

Chapter 
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• Boston 

The Dallas ATM Access Network and the Boston Frame Relay Access Network are connected to the 

core network. The Dallas ATM Access Network consists of ATM access switches located in Denton, 

Dallas, and Plano. These three switches are connected with OC3 fiber. The Boston Frame Relay 

Switch connects to the core through an ATM switch that enables Service Interworking. The access 

networks are connected to the core with OC3 fiber. 

 

ATM Access Network

OC-3

Dallas ATM Switch

 Lucent GX550

Central ATM Core

Network

OC-48

Dallas ATM

Access Switch

Lucent CBX500

Tulsa ATM Switch

 Lucent GX550

Boston ATM Switch

 Lucent GX550

Boston Frame

Relay Switch

Lucent STDX 8000

Frame Relay Access

Network OC-3

Plano ATM

Access Switch

Lucent CBX500

Denton ATM

Access Switch

Lucent CBX500

 

 



D E S I G N  A T M / F R  T M  D A T A  

©Metasolv Software, Inc. 71 

Together—Design network 

You need an OC48 ATM Core, with switches in Boston, Dallas, and Tulsa. To build this network, 

perform the following steps: 

SELECT NETWORK TEMPLATE AND MODIFY PROPERTIES 

1. Click Engineering>Net Systems>NetDes. 

2. Click the Network Template List panel. 

3. Click the “+” next to ATM_FR to expand the template listing. 

4. Right-click MetaSolv TM ATM Core Network and click Add Network Design. 

5. Right-click the canvas, and click Properties. 

6. Type the following information: 

 

Field Value 

Short Name nn ATM Core 

Long Name nn Central ATM Core 

7. In the Status list, click In Service. 

8. Click OK. 

DEFINE ELEMENT  

One switch appears on the canvas because the template rules require a minimum of one switch. 

1. Right-click ATM Switch (1) and click Properties. 

2. Type the following information: 

 

Field Value 

Name nn Dallas ATM Core Switch 

Network Location DLLSTXnnATM 

 

 

Note: Network Location 

 A network location is required because the network template rule requires a network location 

for this element type. 

3. In the Status list, click In Service. 
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ASSOCIATE EQUIPMENT 

1. Click the Equipment Association link. 

2. Double-click Add Equipment Association. 

3. Double-click the relay rack labeled Newton RR Zesty TBND ATM CORE. 

4. Right-click the shelf labeled Lucent GX550 and click Associate to Element. 

5. Click Close. 

6. Click OK. 

7. Click Save. 

ADD ELEMENT 

1. Expand the MetaSolv TM ATM Core Network>Element Types. 

2. Drag the ATM Switch to the canvas. 

3. Drag another ATM Switch to the canvas. 

Note: Spinner Control 

You can change the spinner to add multiple elements to the canvas simultaneously. Before 

you can save the network, you must associate locations with all of the elements.
 

On Your Own—Define elements and 

associate equipment 

Using the steps above, define the Boston and Tulsa switches. Then associate the equipment at the 

shelf level. Use the following information for the switch properties. 

 

Field Value 

Name nn Boston Core Switch 

Network Location BSTNMAnnATM 

Status In Service 

Equipment Newton RR Zesty TBND ATM Core (relay rack) 

Lucent GX550 (shelf) 

 

Use the following information for the Tulsa location: 

Field Input Data 

Name nn Tulsa Core Switch 
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Network Location TULSOKnnATM 

Status In Service 

Equipment Newton RR Zesty TBND ATM Core (relay rack) 

Lucent GX550 (shelf) 

 

Together—Add relationship 

1. Right-click the Dallas switch and click Connect. 

2. Click the Tulsa switch. 

3. Right-click the ATM Switch Intranetworking connection between Dallas and Tulsa and click 

Properties. 

4. In the Template Connection Specs pane, drag Assignable Bandwidth Link to the Network 

Connection Specs pane. 

5. Right-click Assignable Bandwidth Link and click New Connection. 

6. Enter the following information: 

 

Field Value 

Connection Type OTS 

Service Type Category CLFI 

Service Type Code OC48 

 

7. Click OK. 

8. Right-click the connection and click Set Connection Name. 

9. Click OK. 

10. Click the Save button. 

 Note
 

Save
 

You should save often. When items are added to the 

canvas, they are stored in memory and are not saved 

to the Oracle database tables until you click the save 

button. 

After you enter a new connection identification, you 

must click the Save button before you can design the 

connection. 
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Together—Design connection 

1. Right-click the connection between Dallas and Tulsa and click Properties. 

2. Right-click the connection identifier and click Connection Maintenance. 

3. Click the Design Lines tab. 

4. Right-click the canvas area and click Equipment. 

5. In View 1, right-click 01-OC48 and click Assign Circuit. 

6. The port should change from”Unassigned” to “In Service.” 

7. In View 2, right-click 01-OC48 and click Assign Circuit. 

8. Click Close. 

9. Click the Custom Attr tab. 

10. Type the following information: 

Field Value 

Broadband Service Category Cell 

Bit Rate 2.4 Gbps 

NNI/UNI NNI 

 

11. Add DWDM facility assignment. 

12.  

13. Click “x” to close window. 

14. Click Yes to save the design lines. 

15. Click OK to close back to the Network System Design window. 

On Your Own—Add relationships and design 

connections 

Use the steps above to add the following connection relationships: 

• Dallas to Boston 

• Boston to Tulsa 

Also, use the steps above to design the two bandwidth links. You will use the same type of equipment 

and information that you used to design the link from Dallas to Tulsa. 
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On Your Own—Create a Frame Relay access 

network 

The Frame Relay access network in Boston is very small and consists of only one switch. Use the 

instructions on the preceding pages to build the access network. 

Define Network Properties 

Use the Design Network steps. To view all of the network templates, use the menu icon to click the 

Network Template List. Then expand ATM/FR to find your FR Access network. 

Field Value 

Short Name nn BSTN FR access 

Status In Service 

 

Define elements and associate equipment 

Next, define your network properties and the elements, and associate equipment. 

Field Value 

Name nn BSTN FR Access 

Network Location BSTNMAnnFRM 

Status In Service 

Equipment Newton RR Zesty TBND Frame Access (relay rack) 

Lucent B-STDX8000 (shelf) 

 

You will not be creating any connections at this time. 

On Your Own—Create an ATM access 

network 

You will now create an ATM access network that connects to the core network. (It will have lower 

rate cards to connect to customers.) 

Modify network properties 

Field Value 

Short Name nn DLLS ATM Access 

Status In Service 
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Define elements and associate equipment 

Field Value 

Name nn Dallas access ATM Switch 

Network Location DLLSTXnnATM 

Status In Service 

Equipment Newton RR Zesty TBND ATM Access 

Lucent CBX500 

 

Field Value 

Name nn Denton access ATM switch 

Network Location DNTNTXnnATM 

Status In Service 

Equipment Newton RR Zesty TBND ATM Access  

Lucent CBX500 

 

Field Value 

Name nn Plano access ATM switch 

Network Location PLANTXnnATM 

Status In Service 

Equipment Newton RR Zesty TBND ATM Access  

Lucent CBX500 

 

On your own—Add relationships and design 

connections 

Use the instruction labeled Add Relationship to add the relationship between your switches. Then 

create connection identifications. 

DALLAS TO DENTON CONNECTION 

Field Value 

Connection Spec Assignable Bandwidth Link 

Connection Type OTS Format 

Service Type Category CLFI 

Service Type Code OC03 

Rate Code OC03 
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Connection ID ( default) 

DALLAS TO PLANO CONNECTION 

Field Value 

Connection Spec Assignable Bandwidth Link 

Connection Type OTS Format 

Service Type Category CLFI 

Service Type Code OC03 

Rate Code OC03 

Connection ID (default) 

PLANO TO DENTON CONNECTION 

Field Value 

Connection Spec Assignable Bandwidth Link 

Connection Type OTS Format 

Service Type Category CLFI 

Service Type Code OC03 

Rate Code OC03 

Connection ID (default) 

 

Design connections 

Use the instructions labeled Design Bandwidth Link Connection to design the bandwidth 

connections you just identified. 

Use the information below to design your connections to the first available OC3 port. 

Field Value 

Equipment Assign to first unassigned OC3 port located at: 

Newton RR Zesty TBND ATM Access (shelf) 

Lucent CBX500 (shelf) 

Lucent OC3/STM-1 

Broadband Service Category Cell 

Bit Rate 155.52 Mbps 

NNI/UNI NNI 
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Embedded networks 

In the MetaSolv Solution, a network system consists of elements, connections, and can also consist of 

other network systems or embedded networks. As mentioned before, the template rules govern how 

everything fits together so that you can model and design simple to complex network configurations 

with ease. 

Essentially, you can build several small regional networks, name them, and put them in service. You 

can also create a large national network and embed all the regional networks as elements to support 

the national network.  

In the case of Zesty Comm, you have built three networks: 

• ATM Core 

• Frame Access 

• ATM Access 

Now you have the opportunity to embed these networks to create one large ATM/Frame Relay 

Network for Zesty Comm. 

Together—Embed networks 

Once you have your access and core network built, you must connect them to create your “big” 

network. 

1. Click the Network Template List panel. 

2. Right-click MetaSolv TM ATM/Frame Relay Network and click Add Network Design. 

3. Right-click the canvas and click Properties. 

4. Type nn Central ATM/FR in the Short Name field. 

5. In the status list, click In Service. 

6. Click OK. 

7. Click the Network Detail panel. 

8. Click the Menu icon and click Network List. 

9. Expand ATM_FR. 

10. Use the mouse to drag nn ATM Core to the canvas. 

11. Use the mouse to drag nn DLLS ATM Access to the canvas. 

12. Use the mouse to drag nn BSTN FR Access to the canvas. 
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Add a relationship 

1. Double-click nn DLLS ATM Access>nn ATM Core to expand . 

2. Right-click the Dallas switch in the core network and click Connect. 

3. Click the Dallas switch in the access network. 

4. Right-click the ATM Switch Intranetworking connection between Dallas core and Dallas 

access and click Properties. 

5. In the Template Connection Specs pane, drag Assignable Bandwidth Link to the Network 

Connection Specs pane. 

6. Right-click Assignable Bandwidth Link and click New Connection. 

7. Type the following information: 

 

Field Value 

Connection Type OTS 

Service Type Category CLFI 

Service Type Code OC03 

Freeformat Circuit (default) 

 

8. Click through the dialog and save. 

On Your Own—Design connection 

Use the instructions in the preceding pages to design the ATM OC3 connection. 

On Your Own—Add relationships and design 

connections 

Create a relationship between the Boston ATM switch in the core to the Boston frame relay switch in 

the access network. Use the following information: 

Field Value 

Connection Type OTS 

Service Type Category CLFI 

Service Type Code OC03 

Rate Code OC3 

Connection Name (default) 

 

Use the following information to design your bandwidth connection: 
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Field Value 

BSTNMAnnFRM Assign to OC3 port on Lucent STDX8000 equipment. 

BSTNMAnnATM Assign to OC3 port on Lucent GX550 equipment. 

Broadband Service 
Category 

Frame 

Bit Rate 155.52 Mbps 

UNI/NNI NNI 
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Build Product 

What you’ll learn in this chapter 

n important part of implementing the MetaSolv Solution is to build the product catalog. 

Before you can build the catalog, you must build generic product specifications, which define 

the type of service or offering you can order through a product service request (PSR). Then 

you use the product specifications to build the product catalog to further specify the type of products. 

You will associate network template types with both the product specifications and the product 

catalog items. By associating the network templates at the product level, the software prompts 

ordering or provisioning specialists to enter the required data during order entry or provisioning of the 

products. 

You must also create a provisioning plan in Work Management so that you can generate tasks to send 

to the specific people or groups required to provision and turn up the ordered service. 

Objectives 

At the end of this chapter, you will be able to: 

• Create product specifications and associate to network templates 

• Create a product catalog and associate to network templates 

• Create provisioning plans 

Product overview 

You need to build a product catalog and a provisioning plan to offer a product and provision the 

service. To build the product catalog, you will first need to identify item types and product 

specifications. 

The item types are predefined in the MetaSolv Solution and have a hierarchal relationship. You use 

the service item types when you define your enter product specifications.  

Chapter 

6 

A 
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Product specifications include information about the products that your transport (internal) network 

supports. You should make the product specifications generic and flexible so that they can be used to 

create various product catalog items. Because you must associate your product specifications with the 

network templates, you must create or customize the templates before you can finish building your 

product specifications. This association ensures that orders are validated, based on the template rules. 

Once the ordering specialist finishes a PSR, and it is validated against the template rules, the PSR 

needs to be sent to the appropriate personnel (work queues) to be provisioned.  

In MetaSolv Solution, you build provisioning plans for products so that tasks are given deadlines and 

sent to the appropriate personnel to provision the service. 

Item types 

Item types are predefined data that you use to build product specifications. MetaSolv has defined 

relationships between many of the item types. 

The new template-based item types include system, element, connector, and prdbundle. They have the 

following hierarchical relationships. 

• SYSTEM - Network System. (MPLS VPN, for example). 

- ELEMENT - Network Element. (Home Office or Branch Office, for example). 

- CONNECTOR - Network Connection. (A virtual connection between a home office and a 

branch office, for example). 

• PRDBUNDLE - Product Bundle. (DSL product bundle, for example). 

- CONNECTOR - Standalone Connection. (An access connection from the IAD at the 

customer site to your DSLAM, for example). 

The System and PRDBUNDLE are known as the top level or level 1 products of the hierarchy; the 

subordinate items are known as the child, or level 2, item types. 

You can use these relationships to create product hierarchies in the software. Most products that a 

telecom company offers have subordinate items or options associated with them. To build the 

specifications for an entire product hierarchy, you need to identify which items are subordinate to 

other items. 

Therefore, not only do you need to understand the processing associated with the MetaSolv Solution 

item types, but you also need to know which item types you can be associate with other item types. 

Think of item types as the building blocks that you use to structure a product hierarchy. 

Also think of item types as predefined rules. The items and relationships are predefined for products 

and services. For example, line products can have lines, and system options, and features. 
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ELEMENT 

The Element item type represents nodes, facilities, or equipment that you use in the provisioning of 

services. A given network element can represent a single piece of equipment or a collection of 

equipment with a common purpose.  

CONNECTOR 

The Connector item type represents all types of orderable circuits, including access circuits or WAN 

links, orderable Internet circuit, virtual circuits such as Enterprise PVCs, and Voice over DSL 

(VoDSL).  

A given Network Connection can be a physical connection, a virtual connection, or a collection of 

logically grouped connections. Ordered Network Connections are associated with their originating 

locations during the ordering process  

SYSTEM 

The System item type represents a collection of Network Elements that are interconnected by 

Network Connections to provide services associated with the customer’s network. 

PRDBUNDLE 

The Prdbundle item type is used to group customer connections with ordered features or options. 

They connect to the provider network but are not associated with a customer ordered network.  

Product specifications 

Product specifications are blueprints for the products your company offers. Product specifications are 

engineering rules that your technical staff and product management usually define. These are items 

that the network can support.  

You create your product specifications based on the item types. Then you associate them with a 

network template.  

By associating templates with the product specs and product catalog, you can use the ordering dialog 

(New Order Entry window in M/5.1) and the service provisioning dialog (New Virtual Connection 

Design window in M/5.1) to collect the appropriate data and design the service. 

The PRDBUNDLE is the only template-based item type that is not associated with a template. 

Relate specs 

Once you have entered the product specifications, you should relate them hierarchically. 

Because all items are displayed on the product specifications hierarchy at the same hierarchical level, 

you must identify subordinate items on the Related Items tab. The items available on this tab are 

based on the item type of the selected product specification.  
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Note: Associating Network Template Types 

Before you can relate items, you must associate the network template types with the product 

specs.
 

Scenario 

You should build your product catalog, based on your networks and the type of network traffic you 

can offer to customers. You have an ATM/Frame Relay network, and you want to offer service to 

customers from your access networks.  

ATM Access Network

OC-3

Dallas ATM Switch

 Lucent GX550

Central ATM Core

Network

OC-48

Dallas ATM

Access Switch

Lucent CBX500

Tulsa ATM Switch

 Lucent GX550

Boston ATM Switch

 Lucent GX550

Boston Frame

Relay Switch

Lucent STDX 8000

Frame Relay Access

Network OC-3

Plano ATM

Access Switch

Lucent CBX500

Denton ATM

Access Switch

Lucent CBX500

ATM Router

Frame Relay RouterOrdered Physical

Connection

Ordered Physical

Connection

 

You want to offer access connections into your Dallas ATM access switch and into your Boston 

frame relay access switch. These switches are built with two different templates: Frame Relay Access 
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and ATM Access. When building the product specifications for the access connections you will need 

to associate both templates.  

You will also offer the dedicated permanent virtual connection over the Zesty ATM/FR transport 

network. Therefore, you will associate this item with the ATM/FR template. You must also ensure 

that the customer site connects to the ATM Access template and that the other customer site connects 

to the FR Access template. 

Together—Build product specs 

To build product specifications for dedicated virtual connections, perform the steps below: 

1. Click Order Management>Order Management Setup. 

2. In the Retail Ordering section, click Product Specifications. 

3. Right-click Product Specifications, and click Add Item. 

4. In the Type list, click Product Bundle.  

5. Type the following input values: 

FIELD NAME Input Value 

Code PRDBnn 

Internal Alias nn Dedicated VC 

6. Select the Product/Package check box. 

Note: Indicator Check Boxes 

With the new template-based products, you do not need to check any of the circuit or switch 

indicator checkboxes. These are required only for non-template products so that information 

entered in the order appears on the tech translation sheet. 

7. Click File>Save. 

8. Right-click and click Add Item. 

9. In the Type list, click Network Connection. 

10. Type the following input values: 

FIELD NAME Input Value 

Code nnAccess 

Internal Alias nn Access connection 

 

11. Click File>Save. 

12. Right-click and click Add Item. 

13. In the Type list, click Network Connection. 
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14. Type the following input values: 

FIELD NAME Input Value 

Code nnVirtual 

Internal Alias nn Virtual connection 

15. Click File>Save. 

Associate specs with network templates 

In the Dallas network, you have an ATM switch in your access network. Your customer site should 

connect to an ATM switch in your ATM Access network. 

To associate product specifications to network templates, perform the following steps: 

1. In the Product Specification pane, click nn Access Connection. 

2. Click the Network Template Types tab. 

3. Scroll through the list to find the MetaSolv ATM Access Network Template Type. Then look 

for the following:  

CONNECTION SPEC Element A Element B 

Assignable Bandwidth ATM Switch Customer Site 

4. Right-click Assignable Bandwidth Link and click Associate. 

In your Boston network, you have a frame relay switch in your access network. Your customer site 

should connect to a frame relay switch in your Frame Relay Access Network. 

5. Click the Network Template Types tab. 

6. Scroll through the list to find the MetaSolv Frame Relay Access Network template type. Then 

look for the following:  

CONNECTION SPEC Element A Element B 

Assignable Bandwidth FR Switch Customer Site 

7. Right-click Assignable Bandwidth Link and click Associate. 

8. Click File>Save. 

Because your dedicated connection from Dallas to Boston traverses your ATM/Frame Relay network, 

you will use the MetaSolv TM ATM/Frame Relay template. However, you will need to ensure that 

the Element A and Element B customer sites use the MetaSolv TM ATM Access and the MetaSolv 

TM Frame Relay Access templates. 

9. In the Product Specification pane, click nn Virtual Connection. 

10. Click the Network Template Types tab. 

11. Scroll through the list to find the MetaSolv ATM/Frame Relay Network Template Type. Then 

look for the following:  



B U I L D  P R O D U C T  

©Metasolv Software, Inc. 87 

CONNECTION SPEC Element A Element B 

Enterprise Customer Site in ATM Access 
Network 

Customer Site in Frame 
Relay Access Network. 

12. Right-click Enterprise and click Associate. 

Relate Items 

1. In the Product Specification pane, click nn Dedicated PVC. 

2. Click the Related Items tab. 

3. Right-click nn Access Connection and click Add. 

4. Click OK. 

5. Right-click nn Virtual Connection and click Add. 

6. Click OK. 

7. Click “x” to close the window. 

Product catalog 

The product catalog includes the marketing rules that product management usually defines. These 

rules address three primary marketing concerns: product availability (by location or by 

business/market segment), pricing, and packaging.  

The product catalog contains all the information about products that ordering specialists need to know 

to place orders. 

The high level steps to build the catalog are listed below: 

• Describe the products.  

• Distinguish business products from residential products. 

• Designate geographic areas where products are available. 

• Add pricing to products. 

Together—Build a dedicated VC product 

Zesty Communications owns an ATM transport network that connects Boston, Tulsa, and Dallas. You 

can have ATM connections in all three locations, plus a frame relay connection in Boston. 

You want to offer business customers the ability to order dedicated virtual circuits and access 

connections at each location. 

The product specifications have already been created for your use in building the catalog. 
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To build the dedicated virtual connection, perform the following steps: 

1. Click Order Management> Order Management Setup>Product Catalog. 

2. Right-click and click Add Item. 

3. Click nn Dedicated PVC, and click OK. 

4. In the Marketing Description field, type nn Dedicated vc over ATM or FR. 

5. In the Service Category list, click Business. 

6. In the Offering Type list, click Retail, and then click File>Save. 

7. Right-click nn Dedicated PVC product and click Add Item. 

8. Click nn Access Connection, and click OK. 

9. Click the Network Template Types tab. 

10. Right-click the MetaSolv TM ATM Access template and click Associate. 

11. Right-click the MetaSolv TM Frame Relay Access template and click Associate. 

On Your Own—Add virtual connection to the 

product 

Now that you have added the physical connection to the product catalog, add the virtual connection 

and associate the network template. 

Provisioning plan overview 

Provisioning plans are required to manage the flow of work and information, from entering service 

requests to provisioning ordered services. Tasks are generated in the Order Management subsystem 

and are accessible through the Work Management subsystem. You can access tasks in the work 

queues and use equipment and facility information stored in the Service Provisioning subsystem and 

the Equipment Administration module to design connections. 

Tasks are the actual work that needs to be done to provision a customer’s order. You can complete 

some tasks in the software, but you use other tasks only to document time and completion of tasks that 

are performed outside of the software. 

When you build a provisioning plan, you select the tasks that need to be performed, the work group 

responsible for each task, and the amount of time that each task should take. 

You can use several types of tasks to provision service and bill the customer. In this module, you will 

use the minimum required tasks to provision service. If you need more detailed information about 

setting up work queues and provisioning plans, you can enroll in the Work Management course. 

To create a provisioning plan, the following information is required: 
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REQUIRED FIELD Definition 

Plan Name The name of the provisioning plan that the ordering 
specialist will select for a specific type of service. 

Service Type Group In this drop-down field, you can select a service type, 
which is built in the Infrastructure subsystem and 
represents various telecommunications and data service 
types. 

Organization In this drop-down field, you can select an organization 
from the available organizations that your company has 
set up.  

Jurisdiction In this drop-down field, you can select various 
jurisdictions.  

After you enter this information, you can select the tasks and work groups to build the provisioning 

plan. 

Disposition days 

With the Disposition Days functionality, you can insert a user-defined number of disposition days 

between provisioning plan tasks. When setting up provisioning plans, you can designate a number of 

days between tasks when there is essentially no work to be completed. When a task is not required to 

be worked until a certain number of days after the completion of its predecessor, you can assign the 

task due dates accordingly.  

In addition, for backward-dated tasks, you can assign task due dates, based on the completion date of 

their follower tasks. For example, if an organization’s process dictates that a Trans Task must always 

be completed three days prior to the order completion task, the user can insert three disposition days 

between these two tasks. This step will assign a due date for the Trans task that is three days prior to 

the order completion task due date. 

Tasks 

MetaSolv Solution includes two task types: 

SYSTEM TASKS 

A system task is a task designated to complete itself automatically without any user intervention in the 

designated system work queue. The Task Server continually polls the tasks until any predecessor tasks 

and gateway events are completed and the system tasks are ready to be completed. Then the system 

tasks are completed automatically. 

SMART TASKS 

When you double-click a smart task the system takes you to another area of the software to perform 

work. Non-smart tasks are associated with a work group and a completion time, but they do not have 

required functions in the software. 

Below are some of the more frequently used tasks. 



B U I L D  P R O D U C T  

©Metasolv Software, Inc. 90 

APP TASK 

The Application Date task identifies the date on which the customer gives an access service request 

(ASR) to the provider. Assign this task to a provisioning plan if you want the APP date on the 

Confirmation Notice to match the due date of the APP task. 

BILLING TASK 

The billing task sends service request billing data from MetaSolv’s software to a specific billing 

system or a third-party vendor server, depending on the billing gateway and API version you are 

using. 

CKTID TASK 

The CKTID task is the Circuit Identification task for PSR circuits only. It is preloaded for customers 

who purchase the Product Service Request module.  

You can also identify the connections at order time by right-clicking the product and selecting Assign 

Circuit. If you do this for all connections on the order, you will not need the CKTID task. 

Double-clicking this task opens the Service Request Connection window, from which you can do the 

following: 

• Create a connection ID for customers that are ordering a new circuit. 

• Retrieve an existing connection ID for customers that are changing or disconnecting their 

existing circuit. 

• Delete a connection ID. 

• Update a connection ID. 

DLRD/RID TASK 

The DLRD task is the Design Layout Report Date task, which is a smart task that provides access to 

the connection design process. Double-clicking the DLRD task opens the Service Request Connection 

window, which lists all connections on a service request. Double-clicking a connection on the Service 

Request Connection window opens the Connection Design window - Administrative tab, from which 

you can design connections and issue the Design Layout Report (DLR) for the selected service 

request. 

The DLRD task is recommended for all provisioning plans that are associated with ASRs or LSRs 

when a connection is provisioned. You can complete this task only if you have placed all the 

connections on the order in “DLR Issued” status. Because the DLRD task validates that the DLR is 

issued, you will get an error message if you try to complete the DLRD before you place the 

connection in "DLR Issued" status. 

The RID task is recommended for all provisioning plans that are associated with PSRs or ISRs when a 

connection is provisioned. You can complete this task only if you have placed all the connections on 
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the order in "Record Issued" status. Because the RID task validates that the record on the connection 

was issued, you will receive an error message if you try to complete the RID task before you place the 

connection in “Record Issued” status. 

NET DSGN TASK 

The NET DSGN task is the Network Design task for designing customer-ordered networks, such as 

virtual private networks. This task launches the new drawing canvas so that you can provision the 

network system of an order. From the drawing canvas, you can: 

• Install Equipment. 

• Make associations with equipment. 

• Identify connections. 

• Add Network Systems specific information. 

EQ INST TASK 

Double-clicking the EQ INST task opens the Equipment Install window, from which you can install 

equipment from an order at an end user location. 

TRANS TASK 

Double-clicking the TRANS task opens the activation summary report for the provisioned service. 

WOT 

You can use the Wired Office Test (WOT) task to allot time to a work group to actually turn up the 

service. 

PTD 

You can use the Plant Test Date (PTD) task to allot time to a work group to test the provisioned 

service. 

DD 

The Due Date (DD) task is a non-smart task; however, when completed, it changes the status of 

connections and networks to “In Service.” Numerous validations can take place when this task is 

completed. 

Provisioning plan examples 

Your business processes should dictate your provisioning plans. Below are two provisioning plan 

examples. To provision a connection, you can install customer premise equipment and design the 

connections. Then Field Services can wire and test. To provision a customer network, you can use the 

NET DSGN task to do much of the provisioning. 
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CONNECTION PROVISIONING PLAN 

• CKTID 

• EQ INST 

• RID 

• TRANS 

• WOT 

• PTD 

• DD 

• BILLING 

VPN PROVISIONING PLAN 

• NETDSGN 

• RID 

• TRANS 

• WOT 

• PTD 

• DD 

• BILLING 

Work queues 

You create work queues in the software for every work group that will be performing tasks to work a 

customer order from beginning to end. 

Individual workers are added to the work groups so that tasks can be assigned to individuals to be 

worked and completed. 

If System Tasks are used, a System and Exception queue should also be created. 

Together—Build a provisioning plan 

You will use existing work groups and tasks to build a bare-minimum provisioning plan for the 

dedicated PVC product type.  
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To build this provisioning plan, perform the following steps: 

1. Click Application Setup>Work Mangement Setup>Provisioning Plans. 

2. Click the Add New link. 

3. In the Plan Name field, type Connection. 

4. In the Service Type Group list, click Spcl Acc/Priv Line. 

5. In the Organization list, click Zesty. 

6. In the Jurisdiction list, click 0=NA. 

7. Click the Task Assignment tab. 

8. In the Available Tasks, click CKTID and click the Up Arrow button. 

9. In the Work Queue list, click Engineer. 

10. In the Work Interval Business Day list, type 1. 

11. Use Steps 7-9 to enter the following information: 

TASK Work Queue Work Interval 

EQ INST Engineer 1 

RID Engineer 2 

TRANS Field Sv 1 

WOT Field Sv 5 

PTD Field Sv 1 

DD Engineer 1 

 

12. Click the File>Save button. 

13. Click “x” to exit the window. 

On your own—Build provisioning plan 

Using the same queues as those for the Connection provisioning plan, build a provisioning plan to be 

used when provisioning VPN services. Name the plan VPN nn. 

Note: VPN Tasks 

You will use the NETDSGN task to identify connections, install equipment, and design the 

VPN access connections.
 

Use the following information to create the provisioning plan properties. 

Field Value 
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Service Type Group Spcl Acc/Priv Line 

Jurisdiction 0=NA 

Organization Zesty 

 

Use the following information to add tasks to your provisioning plan. 

Task Work Queue Work Interval 

NETDSGN Engineer 1 

RID Engineer 2 

TRANS Field Sv 1 

WOT Field Sv 5 

PTD Field Sv 1 

DD Engineer 1 

 

Chapter Review 

n this lesson, you created product specs, product catalog, associated templates to products and 

built a provisioning plan so that work on services can be tracked and provisioned. 

 

 

I 
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Enter Service Requests 

What you’ll learn in this chapter 

hen implementing new products, it is important that you test your product catalog and 

provisioning plan by entering customer orders and generating tasks. 

 

Objectives 

At the end of this chapter, you will be able to: 

• Enter a product service request (PSR) for a dedicated permanent virtual connection. 

• Generate tasks. 

Template-based ordering 

Template-based ordering is a streamlined process for using the MetaSolv Solution to order customer 

networks and connections. The specifications for the network and its connections and elements are 

based on templates.  

The templates are closely tied to equipment specifications in your product catalog. When you select a 

product, the system will already know all of the information that you need to provision the service. 

Templates and PSRs 

Network templates determine which systems, elements, and connections you can include in a product 

service request (PSR). 

When you built the product catalog, you associated a template. The template you chose determines the 

types of elements and connections you can add to the PSR from that point forward. As you add items 

to the PSR, the properties defined for those items in the template may prompt you for additional 

information.  

Chapter 

7 

W 



E N T E R  S E R V I C E  R E Q U E S T  

©Metasolv Software, Inc. 96 

The custom attributes associated with the network element types, connection spec types, and the 

network template types define what these prompts control. 

Ordering dialog 

The ordering dialog is a browser-based interface invoked during the ordering process that enables 

streamlined service configuration. The ordering dialog functions like an assistant, leading the user 

through a number of steps and questions. As a result, the ordering process is more user-friendly, 

quicker, and more accurate. 

Again, the steps and questions are driven by the configuration of the product catalog and the 

associated templates. The ordering dialog interface is configured to know what information to request 

or require from the user.  

You can access the ordering dialog when you enter orders for products that use the four new item 

types of System, Product Bundle, Element, and Connector. When you select one of these products to 

add to the order, the system will ask you if you want to configure the product. If you click YES, the 

ordering dialog is initiated. 

Ordering equipment 

When ordering equipment for other than a private network system, you must order that equipment 

outside of the ordering dialog. You would enter the equipment locations, order the equipment, and 

continue ordering the template-based products. Then the location information you entered will carry 

over to the ordering dialog, and you will not have to enter it a second time. 

Connection identification 

You can identify connections with the CKTID or NETDSGN tasks, or you can identify them on the 

order and skip entering them through a task. 

To identify a connection during ordering, you right-click the ordered connection and select Assign 

Circuit, which takes you to the Connection Identification window. 

Together—Enter order 

Roberts & Associates, a large advertising firm, is changing service providers and orders a dedicated 

virtual connection between its Boston home office and its Dallas branch office. With this connection, 

the firm will be able to transport large graphics files and collaborate on developing ad campaigns. The 

firm will order a frame router for its Boston headquarters and an ATM router for is Dallas branch. 
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Customer Information 

Customer Status Service Type 

 New  Existing  New  Change  Disconnect 

Customer PO # Sales Order # 

 
nn2508 

Customer Acct. # Organization LD Provider Prior LD 
Provider 

 ZestyComm LLD  

Customer Name County Community 

nn Roberts & Associates   

Street Address Customer Phone # Customer Fax 
Phone # 

44nn Teaparty Lane 213/444-2222  

City, State, & Zip Email Address 

Boston, MA 01234 jsmith@mmc.com 

Contact Name Comments 

Rachel Banks Desired Due Date – Two weeks from today 

Sales Order Date – Today’s Date 

Ordered: Dedicated T1 connection from Boston to Dallas. 

Title 

 Manager 

Contact Phone # Contact Fax # 

213/444-5555 

 

Approvals 

Sales Representative Sales Office Date 

   

I have read and understand, and agree to the terms of this order. I understand that changes to this order must 
be in writing and may result in a new in-service date and additional charges.  

Customer Signature Date 

Rachel Banks 
nn/nn/nnnn 
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Query for the customer 

To query for the customer, perform the following steps: 

1. Click Cust Care on the primary toolbar.  

2. Click Customer on the secondary toolbar. 

3. In the Company Name field, type Like nnRoberts%. 

4. Click Retrieve. 

5. Click Cust Profile. 

CREATE THE SERVICE REQUEST 

To create the service request, perform the following steps: 

1. Click the Create link next to Orders to create a new order. 

2. Enter the following information on the Service Order tab. 

Field Value 

Desired Due Date Select a due date two weeks out. 

Ordered by Last Name, 
First Name and Tel Nbr 

See the sales order. 

Organization Zesty Communications 

PON nn2508 

Expedite Check to expedite. 

ADD LOCATIONS 

To add the locations, perform the steps below: 

1. Select the Service Items tab. 

2. Right-click Order Number and click Add Location From Primary Billing Address. 

3. In the Location Name field, type nn Roberts Boston. 

4. In the TN Switch list, type BSTNMAnnDS1. 

5. Click OK. 

6. Click Select. 

7. Right-click Order Number and click Add New Location. 

8. Enter the following address information: 

Field Value 

Location Name nn Roberts Dallas 

TN Switch DLLSTXnnDS3 
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House Nbr 38nn 

Street name Fifth Street 

State TX 

City Dallas 

Postal Code 75038 

9. Click OK. 

10. Click Select. 

Order products 

ORDER EQUIPMENT 

1. Right-click Service Location (nnRoberts Boston) and click Add New Item. 

2. Click Zesty Comm CPE. 

3. Click OK to accept the default of one piece of equipment. 

4. Click OK. 

5. From the tree view of the order, click Zesty Comm CPE-New. 

6. In the Equipment Spec list, click Cisco 2611. 

7. Click 01Roberts Dallas. 

8. Click Yes to save changes. 

9. Right-click 01Roberts Dallas and click Add New Item. 

10. Click Zesty Comm CPE. 

11. Click OK to accept the default of one piece of equipment. 

12. Click OK. 

13. From the tree view of the order below 01Roberts Dallas, click Zesty Comm CPE-New. 

14. In the Equipment Spec list, click Cisco 1750. 

ORDER DEDICATED PVC PRODUCT 

1. Click Global. 

2. Click Yes to save changes. 

3. Right-click Global and click Add New Item. 

4. Click Zesty Comm Dedicated PVC Product. 

5. Click Yes to configure the new product. (This is a new step for template-based products.) 

6. Check both existing locations to include on the order. 

7. Click Next. 
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8. Click Next to verify that all locations are correct. 

9. Click the cell from Loc 1 to Loc 2 to represent the virtual connection between the Dallas 

branch office and the Boston home office. 

10. Click the cell from Loc1 to the cloud to represent the bandwidth circuit from Boston to the 

ATM network. 

11. Click the cell from Loc2 to the cloud to represent the bandwidth circuit from Dallas to the 

ATM network. 

Note: Lightening Bolt 

You can click the lightening bolt to select all connections. Or you can click the column 

headings to select all locations in that column. 

12. Click Next. 

13. In the Connection Type list, click Frame Physical Connection…FR_SW, CUST Site. 

14. Check the Boston location because it needs a frame relay bandwidth connection, and click 

Add. 

15. In the Connection Type list, click ATM Physical Connection…ATM_SW, CUST_SITE. 

16. Check the Dallas location because it needs an ATM connection, and click Add. 

17. In the Connection Type list, click Virtual Connection…. 

18. Check the Boston-to-Dallas location, and click Add. 

19. Click Next. 

20. Enter the following custom attributes for the virtual enterprise connection: 

Field  Value 

Rate Code DS1 

Virtual Broadband 
Service Category 

Use ATM and FR because the Boston location is frame 
access and the Dallas location is ATM access. 

ATM Connection Type Channel 

Svc Category Send & 
Receive 

B=CBR 

PCR Send and Receive 999 

PCR Priority Code Send 
and Receive 

A=0 

CIR Send and Receive 1.544 M 
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Note: Custom Attributes 

These custom attributes appear in ordering because they are preloaded that way in the 

MetaSolv Solution Utility Application. 

21. Click Next Connection. 

22. Enter the following information for the frame physical connection: 

Field Value 

Rate Code DS1 

Broadband Service 
Category 

Frame 

Bit Rate 1.544 M 

NNI/UNI UNI 

 

23. Click Next Connection. 

24. Enter the following information for the ATM physical connection: 

Field Value 

Rate Code DS1 

Broadband Service 
Category 

Cell 

Bit Rate 1.544 M 

NNI/UNI UNI 

25. Click Done. 

26. Click OK. 

27. Click Finish. 

28. Click Yes to generate tasks. 

GENERATE TASKS 

1. From the Provisioning Plan drop-down, click Connection nn. 

2. Click the Queues button. 

3. Click the Task List tab. 

4. Click the CKTID task. 

5. In the Work Queue list, click PROVnn. 

6. Click Yes to change all Engineer tasks to the same queue. 

7. Click OK. 
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8. Close back to the primary toolbar. 

Chapter Review 

n this module, you entered an order for a new product item and you chose a provisioning plan to 

generate tasks to work queues. I 
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Provision Service 

What you’ll learn in this chapter 

n this module, you will provision services ordered through the ordering dialog. 

 

Objectives 

At the end of this chapter, you will be able to: 

• Identify connections. 

• Install customer-ordered equipment. 

• Provision ordered physical connections. 

• Provision ordered virtual connections. 

Design ordered connections 

You must identify all of the connections before you can design them. Once you have identified them, 

you must use a Work Queue Manager task to design them. Since virtual connections are transported 

over bandwidth connections, you must design the physical connections before the software will allow 

you to design the virtual connections.  

There is one connection design interface used for designing both physical and virtual connections. For 

physical connections, you can record issue or DLRD issue the connection, and view the design lines 

on the CLR/DLR design lines or the Schematic design lines. For virtual connections, you can record 

issue the connection and view the design lines in the GLR. 

Chapter 
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CONNECTION IDENTIFICATION 

To identify connections that you order from the Customer Care subsystem, use the CKTID or 

NETDSGN tasks in the Work Management subsystem. Or have the software identify the connections 

for you by setting the connection specs in the template to Auto ID. 

In this module, you will use CKTID task to identify the tasks manually. 

INSTALL EQUIPMENT 

For connections, you can install customer-ordered equipment with the EQ INST task. For virtual 

private networks, you can use the NET DSGN task. In either instance, the Service Request Equipment 

window lists all of the end-user locations and associated equipment specifications that have been 

ordered. Double-clicking one of the rows in the Service Request Equipment window opens the 

Equipment Install window so that you can install equipment ordered for the end-user location on the 

PSR. 

PHYSICAL CONNECTIONS 

You design the physical connection like you design connections during network design, but you will 

access the physical connection through a task instead of on the network design canvas. 

An ordered physical connection connects the customer location with the provider network. You need 

to install ordered equipment to the customer location before designing the physical connection. If the 

customer does not order equipment, you will design only to the provider network equipment. 

You use the RID task to design connections that are not part of a customer-ordered network system.  

You use the NETDSGN task to design the physical connections that are part of a customer-ordered 

network system.  

The customer location will default to the A location. You can enter the network location or CLLI code 

of the provider access network on the General tab. Or you can use the Network tab to locate the access 

network by the network template name, type, status, or by the element name, type, status, network 

element ID, or network location. The element type defaults, based on the template that you used to 

place the order. 

When you make equipment assignments, the first available ports for the correct rate code will appear. 

At that point, you right-click and assign the circuit. 

You must also fill in any required customer attributes for the connection. 

Once the design is complete, you must “Record Issue” the connection, or “DLRD issue” it for a 

regulated order. 

VIRTUAL CONNECTIONS 

To design virtual connections, you use the Graphical Layout Record (GLR). As a reminder, the 

bandwidth connections must be designed before you can design the virtual connections. 
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A virtual connection is a path between two or more points that appears to be a fixed physical path. 

Actually, it is one path out of several possible physical paths that is available in the network. A virtual 

connection provides a connection between two or more points when needed without having to reserve 

or commit to a specific physical path in advance.  

GRAPHICAL LAYOUT RECORD (GLR) 

The Graphical Layout Record (GLR) is a generic term that refers to two items in the application: the 

GLR window and the GLR report. In provisioning, the GLR window displays a graphical and logical 

representation of a connection, showing its path through elements within network systems and also 

elements outside the confines of the network systems.  

You provision virtual connections in the GLR window. The GLR report provides information about a 

specific virtual connection, such as administrative information, design lines, and a graphical view of 

design. 

You use the graphical canvas, which is the white area of the screen to graphically design connections.  

The GLR Buttons include the following: 

 Hide Panel – To hide the left side panel to allow more room for the graphical canvas. 

 Save –To save from the GLR. 

 Print – To print from the GLR. 

 Print Preview –To preview the print screen before you print it. 

 Back/Next –To maneuver between tabs on the GLR. 

 Mark as Record Issue – To mark your design as record issue without going through the print 

screen. 

 Activation Summary Report – To view and print the Activation Summary Report. 

 Redesign – To redesign your connections. 

 Select and Zoom Out – To zoom just the selected element. 

 Select and Zoom In - To zoom just the selected element.  

 Zoom Out – To zoom out on entire design. 

 Zoom In – To zoom in on entire design. 
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 Zoom Percentage – To resize your design. 

 Hide Toolbar – to hide the upper toolbar to allow more room for the graphical canvas. 

USER PANEL 

The user panel helps facilitate the provisioning process by leading you through the network 

assignments for a virtual connection. The panel contains four tabs to assist you with your connection 

design: 

• Provisioning Dialog – Lists the steps for provisioning your connection. These steps will 

vary, depending on the design mode you choose. As you complete each step, a checkmark 

will appear in the checkbox next to that step. 

• Administrative Section – Lists connection information, order information, tasks, contact 

information, and notes associated with your connection. The only fields you can change in 

this tab are the contact information and the notes. 

• Design Options –Allows you to override the design mode selection that is set in 

Preferences. It also allows you to set the maximum number of hops. The three design 

modes include Manual Design, Path Analysis by Hops, and Path Analysis by Distance. 

• Available Connections – Displays a tree view of all the available connections within a 

specified network that fit your connection criteria.  

THE PROVISIONING DIALOG 

The Provisioning Dialog panel has the following sections: 

• Select an Originating Element – Auto-populates with the information from the order and 

from the connection ID. 

• Select a Terminating Element – Auto-populates, but you may have to select the 

terminating element from a list. 

• Custom Attributes – To capture dependencies and values about allocations and 

connections. 

• Bandwidth Allocation – To validate bandwidth allocation and to specify the allocation 

values. Examples include VPI/VCI or DLCI. 
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Depending on the design mode you are using, the Provisioning Dialog panel will also have one of the 

following sections: 

• Graphic Design – While in manual design mode, you can use this tab to add connections 

between elements. When you right-click on the element, you can add a hard connection 

and specify a path between two elements. Or you can add a soft connection, for which 

there is no specific path between the two elements you are connecting. While in the path 

analysis design mode, you can view only the virtual path from the Graphic Design tab. 

• Select a Path - Displays all paths and their available capacity through a network for a 

connection. This tab is available only while in the path analysis mode.  

Scenario 

Recall that Roberts & Associates ordered a dedicated virtual connection between Boston and Dallas. 

They will provision a frame relay connection in Boston and an ATM connection in Dallas. The 

transport network that Zesty Communications owns is ATM. 
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ATM Access Network

OC-3

Dallas ATM Switch

 Lucent GX550

Central ATM Core

Network

OC-48

Dallas ATM

Access Switch

Lucent CBX500

Tulsa ATM Switch

 Lucent GX550

Boston ATM Switch

 Lucent GX550

Boston Frame

Relay Switch

Lucent STDX 8000

Frame Relay Access

Network OC-3

Plano ATM

Access Switch

Lucent CBX500

Denton ATM

Access Switch

Lucent CBX500

Roberts & Associates

ATM Router

Roberts & Associates

Frame Relay RouterOrdered Physical

Connection

Ordered Physical

Connection

 

Together—Identify connections 

You need to identify the two access connections and the virtual connection through the CKTID task. 

In previous modules, you identified connections without going through the Work Queue Manager. 

You will perform many of the same steps. 

1. Click Home>My Work Queue. 

2. In the Work Queue list, click PROVnn. 

3. Double-click the CKTID task for PON nn2508. 

4. Right-click the first bandwidth circuit and click New. 

5. Enter the following information: 
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Field Value 

Connection Type OTS 

Service Type Category CLCI-SS IntraLATA 

Service Type Code AS 

Rate Code DS1 

Freeform Circuit Entry (Default) 

 

6. Click OK. 

7. Right-click the second bandwidth circuit and click New. 

8. Enter the following information: 
 

Field Value 

Connection Type OTS 

Service Type Category CLCI-SS IntraLATA 

Service Type Code YB 

Rate Code DS1 

Freeform Circuit Entry (Default) 

 

9. Click OK. 

10. Right-click the virtual circuit and click New. 

11. Enter the following information: 
 

Field Value 

Connection Type OTS 

Service Type Category CLCI-SS LATA 

Service Type Code YG 

Rate Code DS1 

Freeform Circuit Entry (Default) 

 

12. Click OK. 

13. Close the window. 

14. Right-click the CKTID task and click Complete Task(s). 

15. Click YES to complete. 

Together—Install equipment 

1. Double-click the EQ INST task. 
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2. Double-click nn Roberts Boston. 

3. Right-click and click Add. 

4. In the Type list, click CPE. 

5. In the Spec list, click Cisco 2611. 

6. Click OK. 

7. Close back to the Service Request Equipment window. 

8. Double-click nn Roberts Dallas. 

9. Right-click and click Add. 

10. In the Type list, click CPE. 

11. In the Spec list, click Cisco 1750. 

12. Click OK. 

13. Close back to the Work Queue Manager window. 

14. Right-click the EQ INST task and click Complete task(s). 

15. Click Yes to complete. 

Together—Design the Boston bandwidth 

connection 

DESIGN WITH A KNOWN CLLI LOCATION 

To design the Boston bandwidth with a known CLLI Location, perform the following steps: 

1. From your work queue, double-click the RID task for PON nn2508. 

2. Double-click the connection identification for the Boston bandwidth connection labeled 

“nnRoberts and….” 

3. Click None in the Terminating Location section. 

4. At the bottom of the window, click Network Location. 

5. In the Network Location field, type BSTNMAnnFRM, and click Search. 

6. Click OK. 

7. Click the CLR/DLR Design link, and click Yes to save the details. 

8. In the Network System section, click the Associate link. 

9. Search for the Zestynn Bstn Access and click Search. 

10. Select the Zestynn Bstn Access System and click OK. 
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DESIGN CONNECTION 

1. Click the CLR/DLR Design link. 

2. Click the Add and Equipment Assignment link. 

3. Double-click the Cisco 2611. 

4. Right-click an unassigned DS1 port and click Assign Connection. 

5. Click Yes to associate equipment with the customer site. 

6. Right-click an unassigned DS1 port on a 4-port T1 card and click Assign Connection. 

7. Click Close. 

RECORD ISSUE THE CONNECTION 

8. Click Change Status>Record Issue. 

Note: Custom Attributes 

The custom attributes entered with the order is carried over the Custom Attributes tab on the 

design lines. 

9. Close the window. 

10. Click Yes to save changes. 

DESIGN WITH AN UNKNOWN CLLI LOCATION 

To design the connection with an unknown CLLI location, perform the following steps: 

1. Double-click the connection identification for the bandwidth connection in Dallas. 

2. In the Network System section, click the Associate link. 

3. In the Network Location field, type Like DLLSTX%, and then click Search. 

4. Double-click the ZESTYnn DLLS ATM AC network, and click OK. 

5. Click the CLR/DLR Design link. 

6. Click the Add and Equipment Assignment link.. 

7. Double-click the Cisco 1750. 

8. Right-click an unassigned DS1 port and click Assign Connection. 

9. Click Yes to associate equipment with the customer site. 

10. Right-click an unassigned DS1 port on a 4-port T1 card and click Assign Connection. 

11. Click Close. 
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RECORD ISSUE THE CONNECTION 

12. Click Change Status>Record Issue. 

Note: Custom Attributes 

The custom attributes entered with the order is carried over the Custom Attributes tab on the 

design lines. 

13. Close the window. 

14. Click Yes to save changes. 

Together—Design virtual connection manually 

With your instructor, use Path Analysis – Least Hops mode to design a virtual connection from an 

order: 

1. Double-click the connection identification for the virtual connection. 

The originating element in Boston is selected automatically, and the terminating element 

in Dallas appears. 

2. Click the Schematic Design link. 

3. Click the Auto Layout link. 

4. Right-click nnRoberts Boston customer site and click Add Hard Connection. 

The bandwidth connection is added to the canvas. 

5. Right-click the Boston Frame Switch and click Add Hard Connection. 

6. Click the Zestynn Central Transport network, and then click the connection to the switch, and 

click OK. 

7. Right-click the nn Boston Core Switch and click Add Hard Connection. 

8. Click the Zestynn Central Transport network, and then click the connection to the customer 

site, and click OK. 

9.  

10. Right-click the nn Dallas ATM access switch and click Add Hard Connection. 

11. From the Available Connections panel, double-click Zestynn DLLS ATM Access. 

12. Expand the Assignable Bandwidth Link. 

13. Drag the nn Roberts Dallas connection to the graphical canvas. 

14. Right-click the connection from Dallas Switch to the customer and click Specify Virtual 

Channel. 

15. Type 16 and click OK. 
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The channel displays under the connection identification. An asterisk displays if the 

channel is defaulted from the next available and has NOT been saved yet. 
 

16. Right-click the connection from Boston Switch to the customer and click Specify Virtual 

Channel. 

17. Type 16 and click OK. 

RECORD ISSUE THE CONNECTION 

1. Click Change Status>Record Issue. 

VIEW THE ACTIVATION SUMMARY REPORT 

1. Click Outputs>Activation Summary Report button to view the Activation Report. 

2. Click Close. 

3. Close the window. 

4. Click YES to save changes. 

5. Close back to the work queue manager. 

6. Right-click the RID task for PON nn2508 and click Complete Task(s). 

7. Click Yes to complete. 

8. Close back to the primary toolbar. 

Chapter Review 

n this lesson, you identified connections, installed customer ordered equipment, and designed 

physical and virtual connections using tasks in the work queue. 

 
I 
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Test and Troubleshoot 

What you’ll learn in this chapter 

n this module, you will test the information you entered during this course while implementing a 

product over an ATM/Frame Relay transport network. You will also be able to troubleshoot your 

implementation. 

Objectives 

At the end of this chapter, you will be able to: 

• Use the product catalog that you built in this course to enter a new order. 

• Manually provision a dedicated PVC service over the network you previously designed. 

• Improve your troubleshooting skills. 

Troubleshoot 

Whenever you cannot provision service, check the following items: 

REVIEW SERVICE REQUEST 

• Do the ordered connections match the network system? Example: If you have a frame 

access network in Boston, did you order a frame access connection? 

• Did you order the correct type of physical link for the available network? 

• Did you design both bandwidth circuits before you attempted to open the virtual circuit? 

• Do the installed CPE equipment specification and issue match the CPE equipment 

specifications and issue selected on the service request? 

• Do you have the correct network associated with the order on the Network tab? 

Chapter 
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REVIEW PRODUCT CATALOG 

When offering customer premise equipment, ensure that the equipment specification associated with 

the product offering includes every specification that can be installed. (If equipment is installed but 

still shows as “Uninstalled,” compare the equipment spec with that associated with the product 

specifications.) 

If you cannot locate the originating terminating element when provisioning, do the Element A and 

Element B templates associated with the product specifications match the templates that you used to 

design the network system? Example: If designing to an ATM switch from a customer site, the 

network template that you used to design the network must include an access connection from the 

ATM switch to the customer site. Also, ensure that the network template in the product specs matches 

the network template that you used to build your networks. 

When you associate multiple network templates with the product catalog, can you easily identify them 

during the order process? Example: You created an access connection that could be either frame relay 

or ATM. Can you distinguish between the two during order time? 

REVIEW TEMPLATES AND NETWORKS 

• If you cannot automatically provision service with path analysis, do you have a prioritized 

path in your template that matches the network route you have designed?  

• If you cannot design a VPN virtual connection over the physical connection, does the 

virtual connection in the template list all of the physical connection specs used in the 

network system as assignable connection specs? 

• If you cannot design to a customer, does the customer connection in the template have the 

“network extension” property? 

• If you cannot provision, are all of your networks and elements “In Service”? 

You can modify your network and product catalog at any time; however, you may need to supplement 

your order and use the new or modified products.  

On Your Own—Test implementation 

Use the steps in previous modules to enter an order. You will also use the product catalog and the 

provisioning plan you built. Then you will locate the design tasks in your work queue and provision 

the service over the network you previously built. 

Stevens and Stevens law firm has requested a dedicated connection from its Plano office to its Dallas 

office. They already own ATM equipment at both locations, so you do not need to order equipment.  

You will order an ATM physical connection from the Dallas customer site to the provider network. 

You will also order an ATM physical connection from the Plano customer site to the provider 

network. 
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Finally, you will order the ATM virtual connection to connect the customer sites. 
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You will find the information you need to complete this module on the following page. 
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Customer Information 

Customer Status Service Type 

 New  Existing  New  Change  Disconnect 

Customer PO # Sales Order # 

 
nn9999 

Customer Acct. # Organization LD Provider Prior LD 
Provider 

 ZestyComm   

Customer Name County Community 

nn Stevens & Stevens   

Street Address Customer Phone # Customer Fax 
Phone # 

80nn Corporate Lane 972/405-1111  

City, State, & Zip Email Address 

Plano, TX 75024 tstevens@stevenslaw.com 

Contact Name Comments 

Sherri Walker Desired Due Date – Two weeks from today 

Sales Order Date – Today’s Date 

Ordered: Dedicated T1 connection from Plano to Dallas. 

Title 

IT Manager 

Contact Phone # Contact Fax # 

972/405-1111 

 

Approvals 

Sales Representative Sales Office Date 

   

I have read and understand, and agree to the terms of this order. I understand that changes to this order must 
be in writing and may result in a new in-service date and additional charges. I acknowledge that the prices of 
the ordered products are those in effect on the date that I sign this sales order. 

Customer Signature Date 

Sherri Walker 
nn/nn/nnnn 
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Use the following information to enter your order: 

Field Value 

Global product nn Dedicated PVC 

Location 1 Use the location on the order form. 

 

Location 2 Stevens Dallas Branch 

96nn Mockingbird Lane 

Dallas, TX 75038 

Connectivity Matrix Select all checkboxes to get two access connections from 
each location and a virtual connection between customer 
sites. 

Connections nn access connection (Because an ATM access network is 
in this area, you will use the access connection from 
ATM_SW, CUST SITE for both access connections). 

nn virtual connection 

 

Enter the following custom attributes for your virtual connection. 

Field Value 

Rate Code DS1 

Virtual Broadband Service 
Category 

ATM  

ATM Connection Type Path 

Svc Category Send & Receive B=CBR 

PCR Send and Receive 968 

PCR Priority Code Send and 
Receive 

B=0+1 

Enter the following custom attributes for both of your ATM connections. 

Field Value 

Rate Code DS1 

Broadband Service Category Cell 

Bit Rate 1.544 M 

NNI/UNI UNI 

Use the following information to generate tasks. 

Field Value 

Provisioning Plan Connection nn 

Work Queues for Engineering Tasks Provnn 
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Delete the EQ INST task because the customer is not ordering equipment. 

WORK TASKS 

Identify all connections through the CKTID task.  Use the following for the access connections: 

Field Value 

Connection Type OTS 

Service Type Category CLCI-SS IntraLATA 

Service Type Code AS 

Rate Code DS1 

Freeform Circuit Entry (Default) 

Enter the following for the virtual connection: 

Field Value 

Connection Type OTS 

Service Type Category CLCI-SS IntraLATA 

Service Type Code YG 

Rate Code DS1 

Freeform Circuit Entry (Default) 

Then design your connections with the RID task.  

On your detail tab for each access connection, you need to enter the network location. You will use 

DLLSTXxxATM for the Dallas connection and PLANTXxxATM. 

If you have problems designing your service request, see the troubleshooting tips in this module or the 

completed GLR in Appendix A. 

Chapter Review 

n this module, you used the product catalog you built to manually provision dedicated PVC 

service on your network. I 



C R E A T E  L A Y E R 2  V P N  

©Metasolv Software, Inc. 123 

Create Layer 2 VPN 

What you’ll learn in this chapter 

his module consists of a hands-on activity in which you will use the Layer 2 VPN template 

from the ATM/Frame Relay technology module to implement a product. 

Objectives 

At the end of this chapter, you will be able to: 

• Identify a Layer 2 VPN. 

• Identify the elements, connections, and custom attributes loaded with the Layer 2 VPN 

technology module. 

• Create the product catalog for the VPN product. 

• Enter a service request and provision a customer-ordered Layer 2 VPN. 

Layer 2 VPN technology module data 

The data included with the Layer 2 VPN technology module appears in the ATM/Frame Relay 

network template. The data includes, network elements, connections, and custom attributes. 

ELEMENTS 

As with other network templates, you can select the elements that meet your network requirements, or 

you can add new ones. Below are the elements included with the Layer 2 VPN templates. 

LAYER 2 ELEMENTS 

The following elements are included with the ATM Access Network: 

• Customer Edge Router 

• ATM/FR Network 

Chapter 
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The ATM/FR Network is considered an embedded template (as represented by the cloud). Each of the 

clouds shown inside the ATM/FR Network is embedded templates in the ATM/FR Network. You will 

use the Layer 2 VPN template to build ordered VPN networks. 

The customer edge (CE) router has a loop, which means that you can connect it to another CE router 

in the same network. 

Layer 2 VPN template connection specs 

The following connection types are available: 

• VPN Links—The physical connections that connect the customer edge routers to other 

elements. 

• Layer 2 VPN Connection—The virtual connections that connect one customer edge 

router to another customer edge router.  

• Internet Connection—A virtual connection that connects a customer edge router to other 

elements for Internet connectivity. 

PRIORITIZED PATHS 

Prioritized Paths are the physical paths that a virtual circuit can ride over a transport backbone 

network. You can create multiple paths for virtual circuits and prioritize them.  

You will not see prioritized paths for physical circuits. 

CUSTOM ATTRIBUTES 

Following are some of the predefined custom attributes included with Layer 2 VPN: 

• CE Manager—This CA is a property of the CE router. You determine who manages the 

router (the customer or the provider). 

• SA Agent Status—This CA is a property of the CE router, which determines the type of 

Service Assurance Agent status on the router. You can select None, Regular, or Shadow. 
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Selecting None indicates that the CE router does not employ the SA Agent feature.  

Selecting Regular indicates that the CE router has a dual function as a CE router and as an SA Agent 

router. That is, while device operating as an SA Agent device must also be a managed CE router. 

Selecting functioning as a CE router in the VPN, it is also monitoring traffic response times between 

the CE routers in the same VPN. 

Note that a CE Shadow indicates that the designated CE router is actually a provider edge (PE) router 

that is functioning as an SA Agent device. 

Scenario 

Metropolitan Medical Center orders a virtual private network to connect its Dallas-based hospital, the 

Denton outpatient facility, and the Plano research facility. This VPN will enable each location to share 

patient information, as well as provide a database of medical advances and treatments. Metropolitan 

Medical Center does not have routers installed at any of the locations and wants T1 connections. 

ATM Access Network

OC-3

Dallas ATM

Access Switch

Lucent CBX500

Plano ATM

Access Switch

Lucent CBX500

Denton ATM

Access Switch

Lucent CBX500

Cisco 2611

Ordered Physical

Connection

Cisco 1750

Cisco 1750

O
rdered Physical

Connection
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Design a network system 

A customer Layer 2 VPN will be transported on an ATM/Frame Relay transport network. Because 

several VPNs are customer ordered, you will design them through the Work Management subsystem 

as part of the provisioning process. You have already built out your ATM/Frame Relay transport 

network, and no further modifications to the network are necessary. 
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Together—Build product specs 

1. Click Infrastructure>List> Product Catalog>Product Specifications. 

2. Right-click and click Add Item. 

3. In the Type list, click Network System. 

4. Enter the following input values. 
 

Field Name Input Value 

Code nnatmvpn 

Internal Alias nn ATM VPN 

 

5. Select the Product/Package check box, and click Save. 

6. Right-click and click Add Item. 

7. In the Type list, click Network Element. 

8. Enter the following input values. 
 

Field Name Input Value 

Code nneuloc 

Internal Alias nn End User Location 

 

9. Click Save. 

10. Right-click and click Add Item. 

11. In the Type list, click Network Connection. 

12. Enter the following input values. 

Field Name Input Value 

Code nnVPNlink 

Internal Alias nn VPN physical link 

13. Click Save. 

14. Right-click and click Add Item. 

15. In the Type list, click Network Connection. 

16. Enter the following input values. 

FIELD NAME INPUT VALUE 

Code nnvpnvirt 

Internal Alias nn vpn virtual connection 

17. Click Save. 
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Associate specs with network templates 

1. In the Product Specification pane, click nn End User Location. 

2. Click the Network Template Types tab. 

3. Scroll through the list to find the Network Template Name and Element Type shown below. 

 

4. Right-click and click Associate. 

5. Click the Related Items tab. 

6. Right-click Equipment and click Add. 

7. Click Save. 

8. In the panel, click Equipment spec. 

9. Click the Equipment Spec tab. 

10. Ensure that the Cisco 1750 and the Cisco 2611 are displayed. 

11. In the Product Specification pane, click nn vpn physical link. 

12. Click the Network Templates Types tab. 

13. Scroll through the list to find the Network Template Name, Connection Spec Type, and 

Elements shown below. 

 

14. Right-click the VPN Link that goes from Customer Edge Router to ATM Switch and click 

Associate. 

15. Click Save. 

16. In the Product Specification pane, click nn vpn virtual connection. 

17. Scroll through the list to find the Network Template Name, Connection, and the Element A 

and Element B types shown below. 
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18. Right-click the Layer 2 VPN Connection that goes from Customer Edge Router to Customer 

Edge Router and click Associate. 

19. Click Save. 

20. In the Product Specifications pane, click nn ATM VPN. 

21. Click Network Template Types tab. 

22. Right-click the MetaSolv TM Layer 2 VPN Network Template Type and click Associate.  

23. Click the Related Items tab. 

24. Right-click nn vpn virtual connection and click Add, and then click OK. 

25. Right-click nn vpn physical link and click Add, and then click OK. 

26. Right-click nn End User Location and click Add, and then click OK. 

27. Click “x” to close the window. 

28. Click YES to save changes. 

Build product catalog 

1. Click Infrastructure>Product Catalog>Product Catalog. 

2. Right-click and click Add Item. 

3. Click the nn ATM VPN product specification and click OK. 

4. In the Marketing Description field, type VPN for customers with ATM as Layer 2. 

5. In the Service Category list, click Business. 

6. In the Offering Type list, click Retail. 

7. Click the Network Template Type tab. 

8. Right-click the Layer 2 VPN template and click Associate. 

9. Click Save. 

Add virtual connection 

1. Right-click nn ATM VPN and click Add Item. 

2. Click nn vpn virtual connection, and then click OK. 
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3. Click the Network Template Type tab. 

4. Right-click the VPN Link from Customer Edge Router to Customer Edge Router and click 

Associate. 

5. Click Save. 

On your own—Add physical connection 

Use the steps for adding a virtual connection to add the VPN Physical Link product specification to 

the product catalog. Then associate the template. 

Together—Add network elements 

1. Right-click nn ATM VPN and click Add Item. 

2. In the Product Spec Item list, click nn End User Location. 

3. Click OK. 

4. In the Item Alias field, type Branch Office. 

5. Click the Network Template Type tab. 

6. Right-click the CE_RTR element type, and click Associate, and then click Save. 

7. Right-click Branch Office and click Add Item. 

8. In the Product Spec Item list, click Equipment, and then click OK. 

9. Click Yes to save changes. 

10. In the Item Alias field, type CE Router. 

11. Click the Equipment Spec tab. 

12. Right-click and click Add. 

13. Click the Cisco 1750, and click OK. 

On your own—Add network elements 

Use the previous steps to enter a CPE product that allows the customer to order a Cisco 2611 router 

for its home office. 

Field Name Input Value 

End User Item Alias Home Office 

Equipment Item Alias CE Router 

Equipment Spec Cisco 2611 
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Enter a service request 

Scenario 

You will enter a service request for a VPN. Order three physical connections from each site into the 

provider network, plus three virtual connections to connect all customer sites to each other. You will 

also order the equipment for each location. 

Cisco 2611
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Enter service request 

ENTER CUSTOMER INFOMATION 

1. Click Customer Care>Service Requests. 

2. Click Add New. 

3. Click Product Service Request, and click OK. 

4. Enter the following information on the Customer Account tab: 

FIELD Value 

Service Category Business 

Company Name nnMetropolitan Medical 
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5. Click  and enter the following address: 

88nn Hospital Blvd. 

Dallas, TX 75248 

6. Click OK. 

7. Click the Billing Cycle drop-down and select Dallas, and click OK. 

8. In the Order Information section, enter the following information: 
 

Field Value 

Desired Due Date: One week out 

Ordered by Last Name Schmidt 

Ordered by First Name John 

Ordered by Telephone 
Nbr 

214 457-0099 

Organization Zesty 

PON nn4500 

 

ORDER VPN 

1. Click Services. 

2. Click Add New Location. 

3. Enter location information and click OK. 

4. From the Service Item Actions section, click Add New Item. 

5. Click nn ATM VPN and click Yes to configure the product. 

The ordering dialog appears. 

6. In the Short Name field, type nn Metro Medical and click Next. 

The customer location you entered will appear. 

7. Click add a new customer location link. 

8. Edit the Location Name to read nn Metropolitan Home. 

9. Enter the following information: 
 

FIELD VALUE 

Location Name nn Metro Denton  

Nbr 77nn 

Street Maple 
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City, State Denton, TX  

Zip 76205 

 

10. Click Add Another. 

11. Enter the following information: 
 

FIELD VALUE 

Location Name nn Metro Plano  

Nbr 66nn 

Street Park 

City, State Plano, TX  

Zip 75026 

 

12. Click Next. 

13. Click Next to verify that the list of locations is correct. 

14. In the Network Element Type field, click Home Office, CE_RTR. 

15. Select the check box by Location/Network Element, and click Add. 

This will add network elements under both locations. 

16. In the Network Element Type field, click Branch Office, CE_RTR. 

17. Select the check boxes next to the Denton and Plano locations, and click Add. 

18. Click Next. 

Note: Instructions 

By clicking the action at the top of the Network Element window, you can get a list of 

instructions for various actions. For example, if you click the “Delete Network Element” link, 

the instructions for deleting a network element will appear. 

19. Enter the following information: 

FIELD VALUE 

Name Home Office Router 

CE Manager Provider 

SA Agent Regular 

20. Click Next Network Element. 

21. Enter the following information: 

FIELD  VALUE 

Name Denton Branch Office Router 
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CE Manager Provider 

SA Agent Regular 

22. Click Next Network Element. 

23. Enter the following information: 

FIELD  VALUE 

Name Plano Branch Office Router 

CE Manager Provider 

SA Agent Regular 

24. Click Next. 

25. In the Equipment Spec list, click CPE Router Cisco 1750. 

26. Select the check boxes next to the Denton and Plano locations, and click Add. 

27. In the Equipment Spec list, click CPE Router – Cisco 2611. 

28. Select the check box next to the Dallas location, and click Add. 

29. Click Next. 

30. Click the lightning bolt in the connectivity matrix to connect all locations physically to the 

provider network and virtually to each other, and click Next. 

31. In the Connection Type list, click nn VPN Physical Link, VPN Link CE_RTR, ATM_SW. 

32. Select all the available check boxes for Dallas, Denton, and Plano, and click Add. 

33. In the Connection Type list, click nn VPN Virtual Connection, Layer 2 VPN Connection 

CE_RTR, CE-RTR. 

34. Select all the available check boxes for Dallas, Denton, and Plano, and click Add. 

35. Click Next. 

Note: Custom Attributes 

To go to the next connection, you need to complete the CAs for a connection and then click 

Next Connection. You have six connections in all: three virtual and three physical 

connections. Use the information in the next two tables to provide data for the appropriate 

connection type. 

ENTER CUSTOM ATTRIBUTES 

1. For the virtual connections, enter the following information: 

FIELD VALUE 

Rate Code DS1 

Virtual Broadband Service 
Category 

ATM 
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ATM Connection Type Channel 

Svc Category Send A=ABR 

PCR Send 768 

PCR Receive 768 

PCR Priority Code Send B=0+1 

 

2. For the VPN data link connections, enter the following information: 

  
Rate Code DS1 

Virtual Broadband 
Service Category 

Cell 

Bit Rate 1.544 M 

NNI/UNI UNI 

 

3. Click Done, and click OK. 

4. Click Validate Order, and click OK 

5. From the menu, click Options>Finish order. 

6. Click Yes. 

7. Click the nn VPN provisioning plan. 

8. Click Queues. 

9. Click the NETDSGN task. 

10. In the Work Queue list, click PROVnn. 

11. Click YES to change all Engineer tasks to the same queue. 

12. Click OK. 

13. Close back to the primary toolbar. 

Provision service 

1. Click Work Mgmt>Queue Mgr. 

2. Click the PROVnn work queue. 

3. Double-click the NET DSGN task. 

4. Expand the MetaSolv TM Layer 2 VPN Network. 

5. Double-click nn Metro Medical. 

INSTALL ORDERED EQUIPMENT 

1. Click the Unincorporated tab. 
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2. Click the menu icon and click Install Equipment. 

 

 

3. Double-click the nn Metropolitan Home. 

4. Right-click on the canvas area and click Add. 

5. In the Type list, click CPE. 

6. In the Spec list, click Cisco 2611. 

7. Click OK. 

8. Close the Equipment Install window. 

9. Double-click the nn Metro Denton. 

10. Right-click on the canvas area and click Add. 

11. In the Type list, click CPE. 

12. In the Spec list, click Cisco 1750. 

13. Click OK. 

14. Close the Equipment Install window. 

15. Double-click nn Metro Plano. 

16. Right-click on the canvas area and click Add. 

17. In the Type list, click CPE. 

18. In the Spec list, click Cisco 1750. 

19. Click OK. 

20. Close the Service Request Equipment window. 

21. Click the menu icon on the Unincorporated tab and click Refresh. 

The status of each piece of equipment changes to “Installed.” 

ASSOCIATE CUSTOMER PREMISE EQUIPMENT WITH THE CUSTOMER LOCATION 

1. Right-click on the Dallas Home Office element on the graphical canvas and click Properties. 

2. In the Name field type nn. 

3. In the Status list, click In Service. 

4. Click the Equipment Assoc link. 
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5. Double-click Add Equipment Association. 

The Equipment Install window appears. 

6. Right-click on Cisco 2611 and click Associate to Element. 

The network element icon appears next to this piece of equipment. 

7. Click Close on the Equipment Install window, and click OK. 

The validation runs, the Managing an Element window closes, and that piece of equipment 

disappears from the Unincorporated Items list. 

On your own—Associate CPE with network 

Use the previous steps to add the Cisco 1750 routers to the two branch offices. Then place the 

elements “In Service.” 

ASSIGN CONNECTION IDS 

In the Network System Design window, you are designing only the physical connections for your 

network. However, you should assign IDs to both the physical and virtual connections. 

1. Click the Unprovisioned tab. 

The tab opens, displaying all ordered physical connections for your network. 

2. Click the menu icon and click Connection Identification. 

The Service Request Connections window opens, displaying all of your physical and 

virtual ordered connections. Because Auto ID is checked on the template for these 

connection specs, the connections have been identified for you. 

3. Click the menu icon on the Unprovisioned tab and click Refresh. 

The connection IDs appear for all of the physical connections listed. (The virtual 

connections are not listed because you do not design them with this task.) 
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EMBED THE NETWORK 

1. Click the Network Template Detail tab. 

2. Expand the MetaSolv TM Layer 2 VPN Network. 

3. Expand the Element Types. 

4. Drag and drop the ATM/FR Network onto the canvas. 

5. Right-click the ATM/FR cloud and click Properties. 

6. Click the Embedded Network Prop link. 

7. Click the browse link. 

The Network System Query window appears. 

8. Enter “like nn central%” in the Short Name field. 

9. Click Retrieve. 

A list of network systems appears in the query window. 

10. Click the nn central atm/fr network. 

11. Click OK. 

12. Click Yes to update the element information. 

13. Click OK. 

14. Click Save. 

ASSOCIATE CONNECTIONS WITH THE NETWORK 

1. Double-click the nn Central ATM/FR Network to expand it. 

2. Double-click the nn Dallas ATM Access Network to expand it. 

3. Right-click on the Dallas home office on the graphical canvas and click Connect. 

4. Drag your cursor to the Dallas ATM Switch element and release it on the element. 

5. Right-click on the Plano office on the graphical canvas and click Connect. 

6. Drag your cursor to the Plano ATM Switch element and release it on the element. 

7. Right-click on the Denton office on the graphical canvas and click Connect. 

8. Drag your cursor to the Denton ATM Switch element and release it on the element. 

9. Click Save. 

DESIGN THE PHYSICAL CONNECTIONS 

1. Right-click the “home office” connection and click Properties. 

The Managing a Connection window appears. 
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2. Click the (OPT) VPN Link in the Template Connection Specs view and drag and drop it into the 

Network Connection Specs view. 

3. Right-click VPN Link and click Associate Ordered Connections. 

4. Click the “nnMetropolitan Home” connection and click OK. 

5. Click OK. 

6. Click Save. 

7. Right-click on the same connection and click Properties. 

8. Right-click the connection and click Connection Maintenance. 

9. Click the Design Lines tab. 

10. Click Equipment from the list on the right side of the Design Lines tab and drag and drop the 

hand into the design window. 

11. Right-click the unassigned port on the Cisco router and click Assign Circuit. 

12. Right-click the first unassigned DS1 port in the DLLSTXnn location and click Assign Circuit. 

13. Click Close.  

14. Enter the following custom attributes: 
 

FIELD VALUE 

Broadband Service 
Category 

Cell 

NNI/UNI UNI 

Bit Rate 1.544 M 

 

15. Click Print on the secondary toolbar. 

16. Click Yes. 

17. Uncheck the Print CLR/DLR checkbox. 

18. Check the Mark as Record Issued checkbox. 

19. Click OK. 

20. Close back to the graphical canvas. 

21. Click No to not save. 

22. Click OK. 

23. Click Save on the graphical canvas toolbar. 

On Your Own—Add and design physical connections 

Use the steps above to add and design the physical connections for the Denton and Plano sites. 

Save and close the network system design window. Complete the NET DSGN task. 
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Together—Design virtual data connection 

With your instructor, perform the following steps to design the Dallas to Denton virtual data 

connection: 

1. Double-click the RID task. 

2. Double-click the virtual connection from Dallas to Denton. 

The graphical layout record appears. 

3. Click Next to access the Custom Attributes screen. 

4. Click Next to get the Graphical Design window. 

5. Right-click the Dallas Home Router and click Add Hard Connection. 

6. Under Available Connections, expand the nn Metro Medical. 

7. Expand the VPN Link. 

8. Drag the nn Metropolitan Home connection to the canvas. 

9. Right-click the nn Dallas ATM Access Switch and click Add Hard Connection. 

10. Under Available Connections, expand the nn DLLS ATM AC. 

11. Expand the Assignable Bandwidth Link. 

12. Drag the Dallas to Denton connection to the canvas. 

13. Right-click the nn Denton ATM Access Switch and click Add Hard Connection. 

14. Under Available Connections, expand the nn Metro Medical. 

15. Expand the Assignable Bandwidth Link. 

16. Drag the nn Dallas to Denton connection to the canvas. 

17. Click Next. 

18. Click OK on the error message. 

19. Enter the following information: 
 

FIELD VALUE 

VPI/VCI 1/32 

VPI/VCI 1/32 

 

20. Click Next. 

21. Check the N/A checkbox for both customer locations. 

22. Click Mark as Record. 

23. Close the window. 
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On Your Own—Design virtual data connections 

Use the steps above to design the virtual data connections between Denton and Plano and Dallas and 

Plano. 

After you have designed all of the virtual connections, complete the RID task. 

Chapter Review 

n this module, you: identified a Layer 2 VPN, identified the elements, connections, and 

customized attributes loaded with the Layer 2 VPN technology module. You also created the 

product catalog for the VPN product and entered a service request and provisioned a customer-

ordered Layer 2 VPN. 

 

I 
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DSL Lab 

What you’ll learn in this chapter 

his module consists of a hands-on activity in which you will use the DSL template to build a 

network, enter an order for DSL service and provision the service. 

 

DSL technology module data 

The data included with the DSL technology module appears in the DSL network template. The data 

includes network elements, connections, and custom attributes. (Only one network template is 

included with the DSL technology module.) 

ELEMENTS 

As with network systems, you can select the elements that meet your network requirements or add 

new ones. Below are the elements included with the DSL template:  

• DSLAM 

• Customer site  

• ATM/FR network 

Below is an example of the template: 

DSL TEMPLATE CONNECTION SPECS 

In the ATM/FR template, the following connection types are available: 

• Assignable Bandwidth Links—The physical connections between elements. 

• Inverse Multiplexing Group –An aggregate group of connections used together for more 

capacity.  

DSL 
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• DSL Link—The physical connection between customer sites and the DSLAM. 

• Enterprise Connection—A connection that connects to customer sites. 

• Switched Virtual Circuit (SVC)—A virtual connection that can connect a customer to a 

switch. No set path runs through the network because the route is established on a call-by-

call basis. 

• Internet Connection—A virtual connection that ultimately connects a customer to the 

Internet. 

• Voice Connection—A virtual connection from a customer to the Public Switch Telephone 

Network. 

PRIORITIZED PATHS 

Prioritized paths are the physical paths that a virtual circuit can ride over a transport backbone 

network. The following connections specs have numerous paths: Enterprise, SVC, Internet and Voice.  

Prioritized paths do not exist for physical circuits. 

During service provisioning, a designer can manually provision service or have it done automatically. 

If the designer decides to let the software select the path used for provisioning, the highest priority 

path with available positions will be used to provision service.  

The Priority 1 path for an Internet connection in the ATM Access network is customer site to ATM 

switch to an SMS. 

CUSTOM ATTRIBUTES 

Numerous custom attributes are predefined in M/5.1, including the following:  

• Requested Downstream—The downstream bit rate requested by the customer. 

• Requested Upstream—The upstream bit rate requested by the customer. 

• In Service Downstream Bit Rate—The bit rate of the Internet connection that delivers data 

to the customer site. 

• In Service Upstream Bit Rate—The bit rate of the Internet connection that delivers data 

from the customer site out to the Internet. 

• Qualified Downstream Bit Rate—The qualified downstream bit rate values that reflect the 

actual measured rates. 

• Qualified Upstream Bit Rate—The qualified upstream bit rate values that reflect the actual 

measured rates. 

• Transport Type—The type of DSL service: ASDL, UADSL, and so forth. 



D S L  

©Metasolv Software, Inc. 143 

Scenario 

EGAD! Software, a small software development firm in Dallas, orders DSL service to accommodate 

two voice lines and to reduce the time it takes to research and download files from the Internet. They 

also order an IAD (Integrated Access Device) for their office. 

Zesty Communications owns the local loop and all equipment in the Dallas area. You have a 

connection to one ISP and to the Public Switched Telephone Network.  

Your network should look similar to the following network, except that you will have all switches in 

the ATM Access network: 

ATM Access Network

OC-3

 ATM Core Network

OC-48

Router

Cisco 12000 with OC3 Cards

Voice Gateway

JetStream with OC3 ports

Dallas ATM Access Switch

Lucent CBX500

DLLSTXxxATM

Class 5ESS

Lucent Switch

DSLAM

Lucent Stinger

T3

IP Network

Build Multiple T1s for GR303

connection

DLLSTXxxDS3

DS0 cards

OC3 Card

DLLSTXxxIPN

DLLSTXxxDSL

DSL Network

PSTN

 Frame Relay Access

Network

OC-3
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Network design overview 

Earlier in the course, you created the nn Dallas ATM Access network. Before you can add a new 

network design for your DSL network, you will need to modify the nn Dallas ATM Access network 

as shown in the graphic on the previous page. More details are included in the Modify Dallas ATM 

Access section. 

After you have modified your nn Dallas ATM Access network, you will create the DSL network. 

More details are included in the Build DSL Network section. 

Design network 

Do the following to build out your networks to support your product: 

• Modify your nn DLLS ATM Access Network to include the voice gateway. Embed the IP 

Network and PSTN. 

• Add relationships and design connections in the ATM Access network. 

• Create a new DSL network and embed the ATM/FR network. 

• Add a relationship and design the connection between the ATM switch and the DSLAM. 

The DSL template works in conjunction with the ATM/FR template. You need to embed the PSTN 

and the IP network, which you have already designed. 

MODIFY DALLAS ATM ACCESS 

To support Internet and telephone service, you need to add an IP network and a PSTN network to 

your Dallas ATM Access network. The IP network and a PSTN network have already been created 

and you will need to embed these networks using processes you’ve learned in class. 

The IP network can be found under the IP Technology module and is called Zestynn IP Network. 

The PSTN network is found under the Unclass technology module and is called Zestynn PSTN. 

 Note 
Embedded Networks 

You will find the networks to embed in the  

 

Ensure the embedded networks are In Service. 

Use the directions Embed Networks with the following information to embed the PSTN and IP 

network: 

FIELD VALUE 

Network List nn DLLS ATM Access 
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Element (IP) ZESTYnn IP Network 

Status In Service 

  

Element (Unclass) ZESTYnn PSTN 

Status  In Service 

 

Use the instructions Add and Define Elements with the following information to add a voice 

gateway: 

FIELD VALUE 

Element Type Voice Gateway 

Name nn Dallas Voice Gateway 

Network Locations DLLSTXnnDS3 

Status In Service 

Equipment (Associate to shelf) Newton RR Zesty TBND Voice Gateway 

Jetstream CPX-1000 (shelf) 

Add relationships and identify connections 

Connect the Dallas ATM switch to the Dallas IP router and identify the connection. (Make sure that 

you save after every connection you add.) 

EQUIPMENT LOCATION 

Connection Spec Assignable Bandwidth 

You need to remove the Inverse Multiplexing 
Spec. 

Service OTS 

Service Type Category CLFI 

Service Type Code  OC03 

Rate Code OC3 

Freeform Circuit entry (default)  
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ASSIGN IP ADDRESSES TO ROUTER 

During provisioning, you will assign IP addresses to the customer so that the customer can access the 

public Internet. 

In this case, you will assign a /24 to the router. When you assign an IP address to the customer, it will 

come from the same subnet as the IP address that you assign to the router. 

To assign an IP address, perform the following steps: 

1. Double-click the Dallas IP router. 

2. Click Equipment Association. 

3. Right-click the first unassigned OC3 port and click IP address. 

4. Enter the following information: 
 

FIELD VALUE 

Use Group nn_Backbone 

Use Code nn_IP Router 

 

5. Click 111.1nn.110.1/24. 

6. Click Retrieve. 

7. Click Close. 

Connect the ATM access switch to a voice gateway: 

EQUIPMENT LOCATION 

Connection Spec Assignable Bandwidth 

You need to remove the Inverse Multiplexing 
Spec. 

Service OTS 

Service Type Category CLFI 

Service Type Code OC03 

Rate Code OC3 

Freeform Circuit entry (default) 

 

Connect a voice gateway to the PSTN switch: 

EQUIPMENT LOCATION 

Connection Spec GR-303 Facility Circuit 

Remove the V5.2 Group connection specs. 

Service OTS 
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Service Type Category CLFI 

Service Type Code T1 

Rate Code DS1 

Freeform Circuit entry (default) 

 

Connect the Dallas ATM Switch to the IP Router: 

FIELD VALUE 

Equipment OC3 on Cisco 12008 and Lucent 
CBX500 

Broadband Service Category Cell 

Bit Rate 155.52 Mbps 

NNI/UNI NNI 

DESIGN CONNECTIONS 

You need to design your connection from the ATM switch to the voice gateway and the voice 

gateway to the Class 5 switch. You also need to cross-connect the DS0s at the voice gateway and the 

Class 5 switch to show the GR303 virtual connections and to create a DS1 connection between the 

same two elements. 

ATM to voice gateway: 

FIELD VALUE 

Equipment OC3 assignment at Jetstream CPX-1000 
(Voice Gateway) and Lucent CBX500  

Broadband Service Category Cell 

Bit Rate 155.52 M 

NNI/UNI NNI 

 

CROSS-CONNECT EQUIPMENT 

To cross-connect the DS0s from the voice gateway to the digital switch and to design the DS1 

connection, perform the following steps: 

1. Right-click the connection from the voice gateway to the PSTN switch and click Connection 

Maintenance. 

2. Click the Design Lines tab. 

3. Right-click the canvas and click Equipment. 

4. At the A location, scroll up to the first Lucent GR303 card on the Jetstream CPX-1000. 
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5. Click the  button to collapse the 01 Lucent GR303 card. 

6. At the Z location, scroll to find the 02 Lucent GR303 card on the Lucent 5ESS switch. 

7. Right-click the 0101Lucent GR303 card on the Jetstream CPX-1000 shelf at the A location 

and click Cross-Connect. 

8. Right-click the 02 Lucent GR303 card on the Lucent 5ESS switch and click Cross-Connect 

To. 

9. On the Voice Gateway portion of the screen, click the  button twice until you see the DS0 

ports. 

10. From the 5ESS portion of the screen, click the  button twice until you see the DS0 ports. 

Your screen should look like the following: 

 
11. Click the first DS0 on the left side of the window. 
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12. Hold down the Shift key and click the last DS0 on the left side of the window. 

All DS0s should be selected. 

13. Click the first DS0 on the right side of the window. 

All DS0s should be cross-connected, and your screen should look like the one below: 

 

14. Click Close. 

15. Expand the 0101 Lucent GR303 card at the voice gateway. 

16. Expand the 02 Lucent GR303 card at the Lucent 5ESS switch. 

17. At both locations, expand the first N/A-Unassigned ports. 

18. Right-click the first unassigned DS1 port at both locations and click Assign Circuit. 

19. Click Close. 
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20. Save the design lines. 

 

 Note 
GR303 Connections 

The connection from the digital switch to the voice 

gateway is a GR303 connection. The equipment 

specifications for this equipment is set up with 

virtual ports. 

 

BUILD DSL NETWORK 

Use the instructions Design Network and the information below to build the DSL. 

FIELD VALUE 

Template List DSL 

MetaSolv TM DSL 

Short Name nn Dallas DSL 

Status In Service 

ADD AND DEFINE ELEMENTS 

Add a DSLAM to your DSL network: 

FIELD VALUE 

Element Type DSLAM 

Name nn Dallas DSL 

NETWORK LOCATIONS DLLSTXnnDSL  

Equipment (Associate to shelf) Newton RR ZESTY TBND LAB DSL 

Lucent Stinger LS (shelf) 

Status In Service 

EMBED NETWORK 

Embed your ATM/FR network into your DSL network using the instructions from the Layer 2 VPN 

module: 

FIELD VALUE 

Element Type ATM/FRNetwork 

Network List nn Central ATM/FR 

Status  In Service 
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ADD RELATIONSHIP AND IDENTIFY CONNECTION 

Add the relationship from the DSLAM to the ATM access switch: 

EQUIPMENT LOCATION 

Connection Spec Assignable Bandwidth Link 

Remove the Inverse Multiplexing Group 
connection specs. 

Service OTSFormat 

Service Type Category CLFI 

Service Type Code OC03 

Rate Code OC3 

Freeform Circuit entry (default) 

DESIGN CONNECTION 

Design the connection from the DSLAM to the ATM switch within the DSL network you created: 

FIELD VALUE 

Equipment OC3 on Stinger LS Trunk Module and on Lucent 
CBX500 

Broadband Service Category Cell 

Bit Rate 155.52 Mbps 

NNI/UNI NNI 

Create the product catalog  

Now that you have built out your network, you need to build the products that the network supports. 

You will offer Internet and voice services. 

You will use the Product Bundle to build the following product specs: DSL Product, DSL Physical 

Connection, DSL Voice Connection, and DSL Internet Connection. 

You must build the two virtual connections separately because the voice connection requires a 

telephone number. 

Relate the physical and virtual specs with network templates: 

FIELD VALUE 

Type Product Bundle 

Code nnDSL 

Internal Alias  nn DSL Product 

Product/Package Checked 
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FIELD VALUE 

Type Network Connection 

Code nnDSLphys 

Internal Alias  nn DSL Physical Link 

Network Template Type 

Connection Spec 

DSL 

DSL Link 

 

FIELD VALUE 

Type Network Connection 

Code nnDSLvoi 

Internal Alias  nn DSL Voice Connection 

Network Template Type 

Connection Spec 

DSL 

Voice Connection 

 

FIELD VALUE 

Type Network Connection 

Code nnDSLint 

Internal Alias  nn DSL Internet Connection 

Network Template Type 

Connection Spec 

Elements 

DSL 

Internet Connection 

Customer site to IP router 

 

 

 Note 
Relating Items 

You cannot relate items until you associate the 

network templates.
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RELATE ITEMS 

Open your nn DSL Product and relate the nn DSL physical link, nn DSL voice connection, and the 

nn DSL Internet connection.  

Make sure that you select “one” in the Telephone Numbers field so that you can assign telephone 

numbers to the voice connection. 

BUILD PRODUCT CATALOG 

Define your nn DSL Product and add the physical and virtual connections with the following 

information: 

FIELD VALUE 

Item Alias nn DSL Business 

Marketing Description SDSL Product for Business Customers 

Service Category Business 

Offering Type Retail 

Telephone/Trunk Product Check (To assign telephone numbers for the 
Voice connection) 

Auto-assign TN’s Check (So that the system automatically assigns 
telephone numbers when the item is added to an 
order) 

 

Add your nn DSL physical link: 

FIELD VALUE 

Marketing Description This item provides a connection from the 
customer site to the DSLAM. 

Network Template Types MetaSolv TM DSL 

 

Add your nn DSL Voice connection: 

FIELD VALUE 

Item Alias nn DSL Voice over DSL 

Marketing Description This item provides a voice connection over 
DSL. 

Send to E911 Check 

(With the E911 functionality, you can enter 
and maintain detailed information about a 
telephone number and its service location.) 

Connection Template  MetaSolv TM DSL 
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Add your nn DSL Internet connection. 

FIELD VALUE 

Item Alias nn DSL Internet  

Marketing Description This item allows the customer access to the 
Internet. 

Connection Template  MetaSolv TM DSL 

 

Enter the service request 

Use the order form on the following page to complete the service request. Because this order includes 

a telephone product, you will need to enter the Telephone Number (TN) Switch. Use DLLSTXnnDS3 

for the switch. 

 

Customer Information 

Customer Status Service Type 

 New  Existing  New  Change  Disconnect 

Customer PO # Sales Order # 

 
nn0806 

Customer Acct. # Organization LD Provider Prior LD 
Provider 

 ZestyComm LLD  

Customer Name County Community 

nnEGAD! Software   

Street Address Customer Phone # Customer Fax 
Phone # 

98nn Market Blvd. 214/5nn-6000  

City, State, & Zip Email Address 

Dallas, Texas 75221 rbanks@egad.com 

Contact Name Comments 

Rachel Banks Desired Due Date – One week from today 

Sales Order Date – Today’s Date 

2 voice lines with Lucent IAD 

Internet connection 

Access connection 

Title 
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Contact Phone # Contact Fax # 

214/5nn-7000 

 

Approvals 

Sales Representative Sales Office Date 

   

I have read and understand, and agree to the terms of this order. I understand that changes to this order must 
be in writing and may result in a new in-service date and additional charges. I acknowledge that the prices of 
the ordered products are those in effect on the date that I sign this sales order. 

Customer Signature Date 

 
Nn/nn/nnnn 

 

QUERY FOR CUSTOMER & CREATE SERVICE REQUEST 

Use the instructions in the module Enter Service Request to query for nnEGAD Software and begin 

entering the order. 

FIELD VALUE 

Desired Due Date Select a due date three weeks out. 

Ordered by Last Name, First 
Name and Tel Nbr 

See the sales order. 

Organization Zesty Communications 

PON nnSDSL 

Expedite Check to expedite. 

ORDER PRODUCTS 

Add the location from the primary billing address and use the following TN Switch: DLLSTXnnDS3. 

Order the following products: 

• Zesty Comm CPE – Lucent IAD Cellpipe 

• 1 Access connection 

• 2 Voice Lines 

• 1 Internet Connection 

Enter the following information about the DSL Link: 

FIELD VALUE 
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Broadband Service Category Cell 

NNI/UNI UNI 

Transport Type SDSL 

In Service Downstream Bit Rate 768K 

In Service Upstream Bit Rate 768K 

 

Enter the following information about the voice connections: 

FIELD  VALUE 

Virtual Broadband 
Service Category 

ATM 

ATM Connection Type Channel 

Svc Category Send & 
Receive 

B=CBR 

PCR Send and Receive 64 

PCR Priority Code Send 
and Receive 

A=0 

 

Enter the following information about the Internet connection: 

FIELD  VALUE 

Virtual Broadband 
Service Category 

ATM 

ATM Connection Type Channel 

Svc Category Send & 
Receive 

A=ABR 

PCR Send and Receive 768 

PCR Priority Code Send 
and Receive 

B=0+1 

Assign TNs to voice connections 

Because you have voice connections, perform the following steps to assign telephone numbers to the 

customer: 

1. From the Order Number Level, right-click and click Assign Telephone Numbers. 

2. Check the Auto Assign checkbox at the top left of the window.  

3. Click Auto Assign TN. 

The checkmarks move to the TN Assigned field. 
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4. Click Close. 

Generate tasks 

Use the plan you created (Connection nn) to assign tasks. Change the Engineering queue to 

PROVnn. 

Provision service 

To provision the services, you will install equipment at the customer site. You will also use the EQ 

INST and RID tasks to provision the physical and virtual connections. 

CKTID 

Use the following information to identify the access connection: 

FIELD VALUE 

Network Connection 
Spec 

Access 

Connection Type OTS 

Service Type Category CLCI-SS IntraLATA 

Service Type Code AS 

Freeformat Circuit Entry (default) 

 

Use the following information to identify the Internet connection: 

FIELD VALUE 

Network Connection 
Spec 

Internet 

Connection Type OTS 

Service Type Category CLCI-SS IntraLATA 

Service Type Code AS 

Freeformat Circuit Entry (Accept default.) 

 

EQ INSTALL 

Add the Lucent Cellpipe to the location and then complete the task. 

RID 

Design the physical connection, the Internet, and both voice connections. The prioritized paths are set 

up so that you can design the virtual connections automatically by hops or by distance. 

DSL Link/Physical Bandwidth 

Design the DSL Link connection first. 
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On the Detail tab, select N/A as the rate code of the connection. On the Network tab, select the 

DSLAM network you designed. Then go to the Design Lines tab. 

You will assign to the DSLAM line on the Lucent Cellpipe and then to the N/A port on the Lucent 

Stgr LIM card. 

INTERNET CONNECTION 

Select the Design Options panel and check the Path Analysis by Hops radio button. Continue 

through the provisioning dialog until you get to the window to select a path. Because you checked the 

Path Analysis by Hops radio button, the software will find a path through the network. You can 

expand the path to see the hops that the connection can traverse. Because there is only one path, it is 

automatically checked for you. 

Make sure that you assign an IP address to the customer site. You should use an IP address in the 

same subnet as the IP router. 

Enter the following bandwidth allocation information: 

FIELD VALUE 

Customer Site VPI 0 

Customer Site VPI 32 

DSLAM VPI 1 

DSLAM VCI 32 

IP Router VPI 1 

IP Router VCI 32 

VOICE CONNECTIONS 

Select the Design Options panel and select the Path Analysis by Hops radio button so that the 

software finds the path. 

Enter the following bandwidth allocation information: 

FIELD VALUE 

Voice Gateway VPI 2 

Voice Gateway VCI 43 

 

On the Port Assignment window, make a connection to a DS0 voice port at the customer’s Lucent 

Cellpipe by checking the box next to the port. 

Perform the same  

steps for the second voice line. 
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Ethernet Lab 

What you’ll learn in this chapter 

his module consists of a hands-on activity in which you will use the Ethernet template to build 

a network, enter an order for LAN to LAN service and provision the service. 

 

Ethernet technology module data 

The Ethernet technology module has seven network templates. You can use any combination of these 

templates to build an Ethernet network system. 

ELEMENTS 

As with network systems, you can pick and choose the elements that meet your network requirements, 

or you can add new ones. Below are the elements included with the templates: 

• Ethernet Core and Distribution Network System Elements 

The Ethernet Core network includes only the switched router as a network element. 

• Ethernet Access Network System Elements 

The following elements are included with the Ethernet Access Network: 

• Switched Router 

• Subscriber Management System (SMS) 

Because it is a network system, the IP network is embedded in a cloud. 

• Ethernet VLAN Element 

Ethernet 

Lab 

T 
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The Ethernet VLAN template includes a VLAN switched router. 

• Other Elements 

A provider network, customer site, and an IP network are included with the templates outside of the 

network clouds to depict off-net network elements. 

Ethernet template connection specs 

In the ATM/FR template, the following connection types are available: 

• VLAN—The virtual LAN connection. 

• TLAN –The virtual transparent LAN connection.  

• Ethernet Link—The physical bandwidth connection. 

• VLAN Internet—The virtual connection to the Internet that you can assign a tunneling 

protocol to. 

PRIORITIZED PATHS 

Prioritized paths are the physical paths that a virtual circuit can ride over a transport backbone 

network. You can create multiple paths for virtual circuits and prioritize them.  

You will not see prioritized paths for physical circuits. 

During service provisioning, a designer can manually provision service or have it done automatically. 

If the designer chooses to let the software select the path used for provisioning, the highest priority 

path with available positions will be used to provision service.  

CUSTOM ATTRIBUTES 

You will find numerous custom attributes predefined for use with Ethernet technology. Many of the 

items covered in the Ethernet Overview in this module can appear as custom attributes throughout the 

process of designing, ordering, and provisioning Ethernet services. 

Following are some examples of the predefined custom attributes: 

• VLAN ID—Used for Fast Ethernet and Gigabit Ethernet VLANs. 

• IP Address—Used for policy-based LANs. 

• VLAN Ports—Use for static LANs. 

• VLAN type—Used to identify LANs by static, dynamic MAC, policy-based or protocol. 

• IEEE Architecture—Used to identify either 802.1p (prioritize traffic) or 802.1q (queues) 

architecture. 
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• Duplex—Used to specify full or half duplex. 

• MAC address—Used when VLAN is dynamic MAC based. 

Scenario 

Harrington Community College ordered connections between all of its campuses in Arlington, Irving, 

and Dallas. This connection will allow staff members to share curricula and student records. 

Design an Ethernet backbone  

Zesty Comm needs to build an Access Ethernet Network that connects Arlington, Fort Worth, Irving, 

and Dallas with OC3 fiber. They will install Cisco Catalyst switched routers at each network location.  

Access Ethernet

Arlington
Irving

Fort Worth
Dallas

Use Cisco Catalyst 5509

OC3/DS1 ports

 

DESIGN NETWORK 

Use the information below to create your new network: 

FIELD VALUE 

Network Template MetaSolv TM Ethernet Access Network 

Short Name nn Dallas Ethernet 

Status In Service 

 

DEFINE ELEMENTS AND ASSOCIATE EQUIPMENT 

Define the elements for the four locations in the Ethernet Core. 

FIELD VALUE 

Name nn Fort Worth Eth Access 

Network Location FTWOTXnnETH 
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Status In Service 

Equipment (associate with 
shelf) 

Shelf 

NEWTON RR ZESTY TBND LAB ETHERNET 

Catalyst 5509  

 

FIELD VALUE 

Name nn Dallas Eth Access 

Network Location DLLSTXnnETH 

Status In Service 

Equipment (associate with 
shelf) 

Shelf 

NEWTON RR ZESTY TBND LAB ETHERNET 

Catalyst 5509  

 

FIELD VALUE 

Name nn Arlington Eth Access 

Network Location ARLNTXnnETH 

Status In Service 

Equipment (associate with 
shelf) 

Shelf 

NEWTON RR ZESTY TBND LAB ETHERNET 

Catalyst 5509  

 

FIELD VALUE 

Name nn Irving Eth Access 

Network Location IRNGTXnnETH 

Status In Service 

Equipment (associate with 
shelf) 

Shelf 

NEWTON RR ZESTY TBND LAB ETHERNET 

Catalyst 5509  

 

ADD RELATIONSHIPS AND IDENTIFY CONNECTIONS 

Connect Ft. Worth to Dallas, Dallas to Irving, Irving to Arlington and Arlington to Ft. Worth. Use the 

following information to create and identify all the connections. 

FIELD VALUE 

Network Connection Spec Ethernet Link 

Connection Type OTS 
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Service Type Category CLFI 

Service Type Code OC03 

Freeformat Circuit Entry (default) 

 

DESIGN CONNECTIONS 

Use the following information to design each of the Ethernet Link connections: 

FIELD VALUE 

Equipment Assign to first available OC3 port at each location. 

Broadband Service Category N or LAN 

Bit Rate 155.52 M 

Duplex Mode Full Duplex 

 

DESIGN NETWORK 

Use the information below to create your Ethernet network: 

FIELD VALUE 

Network Template MetaSolv TM Ethernet Network 

Short Name nn MAN 

Status In Service 

 

EMBED NETWORK 

Embed the nn Dallas Ethernet network into the Ethernet Network. You do not need to connect 

anything. 

 

 Note 
Ethernet Network Template 

This template was modified from the original 

so that only an access network is required. The 

original template is set up so that an access 

network and a core network are required. 

 

Create a LAN-to-LAN product 

Create a LAN-to-LAN service offering. Follow the guidelines below. 
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• LAN to LAN Service (PRDBUNDLE – Don’t tie to a template) 

• Access Link (Connector – Physical) 

• Data Connection (Connector – Virtual) 

• Switched Router (CPE - Cisco Catalyst 5002) 

BUILD PRODUCT SPECS  

Use the following information to build the LAN product bundle: 

FIELD VALUE 

Type Product Bundle 

Code nnETH 

Internal Alias nn LAN product 

Product/Package Checked 

 

Use the following information to build the physical access link: 

FIELD VALUE 

Type Network Connection 

Code nnETHphy 

Internal Alias nn LAN physical link 

Network Template Type` 

Connection Spec 

Element A  

Element Z 

Ethernet 

Ethernet Link 

Customer Site 

Switched Router 

 

Use the following information to build the virtual data connection: 

FIELD VALUE 

Type Network Connection 

Code nnETHvirt 

Internal Alias nn LAN virtual data connection 

Network Template Type` 

Connection Spec 

Elements A and Z 

Ethernet 

Virtual LAN 

Customer Site 
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RELATE ITEMS 

Open your nn LAN product and relate the nn LAN physical link and the nn LAN virtual data 

connection. 

BUILD PRODUCT CATALOG 

Define your nn LAN product and add the physical and virtual connections with the following 

information: 

 

FIELD VALUE 

Item Alias nn LAN Business 

Marketing Description LAN Enterprise Product for Business Customers 

Service Category Business 

Offering Type Retail 

 

Add your nn LAN physical link: 

FIELD VALUE 

Marketing Description This item provides the Ethernet Link from the 
customer site to the switched router. 

Network Template Type Ethernet 

Customer Site to Switched Router 

 

Add the nn LAN virtual data connection: 

FIELD VALUE 

Item Alias nn LAN virtual data connection 

Marketing Description This item provides the virtual data connection 
between customer sites. 

Network Type Ethernet 

Customer Site to Customer Site 

Enter a service request 

You will enter Harrington Community College’s request to connect their Arlington, Irving, and Dallas 

campuses. 
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QUERY FOR CUSTOMER AND CREATE SERVICE REQUEST 

Use the instructions in the module Enter Service Request to query for nn Harrington Community 

College. Then enter the order. 

FIELD VALUE 

Desired Due Date Select a due date 3 weeks out. 

Ordered by Last Name, 
First Name and Tel Nbr 

Smith, Karen 

817 867-5309 

Organization Zesty Communications 

PON nnLAN 

Expedite Checked 

 

ORDER PRODUCTS 

Add the location from the primary billing address, and add these additional locations: 

nnHarrington Irving 

84nn Wild Horse 

Irving, TX 75060 

 

nn Harrington Dallas 

37nn Mockingbird 

Dallas, TX75245 

 

Order the following products: 

• A Physical LAN Ethernet link to each campus location 

• 3 virtual data connections 

Enter the following information about the Virtual Data Connections: 

FIELD  VALUE 

Virtual Broadband 
Service Category 

Ethernet 

 

Enter the following information about the Physical Ethernet Links: 
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FIELD  VALUE 

Broadband Service 
Category 

N or LAN 

Bit Rate 1.544 M 

Duplex Mode Full Duplex 

 

GENERATE TASKS 

Use the plan you created (Connection nn) to assign tasks. Change the Engineering queue to 

PROVnn. Delete the EQ INST task. 

Provision service 

To provision the services, you provision the physical and virtual connections with the RID tasks. 

Ethernet links 

Design the Ethernet Links first.  

On the General tab, select DS1 as the rate code of the connection. On the Network tab, select the 

Ethernet network you designed. Then go to the Design Lines tab. 

You will not assign to the customer site since they did not order equipment that needs to be 

inventoried. Assign to the DS1 port on the Cisco Catalyst 5509. 

Virtual connection 

Select the Design Options panel and select the Path Analysis by Hops radio button. Continue through 

the provisioning dialog until you get to the window to select a path. Because you selected Path 

Analysis by Hops, the software will automatically find a path through the network. You can expand 

the path to see the hops that the connection will traverse. Because there is only one path, it is 

automatically checked for you. 
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MPLS Lab 

What you’ll learn in this chapter 

his module consists of a hands-on activity in which you will use the MPLS template to build a 

network, enter an order for network service and provision the service. 

 

MPLS technology module data 

The data included with the MPLS technology module appears in two templates: MPLS transport and 

MPLS VPN. The data includes network elements, connections, and custom attributes.  

The MPLS template includes the following embedded templates: 

• ATM/FR 

• MPLS Core 

• MPLS Access 

• Customer Site 

• MPLS Other Provider 

Below is an example of the template: 

MPLS 

Lab 

T 
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ELEMENTS 

As with network systems, you can select the elements that meet your network requirements or add 

new ones. Below are the elements included with the MPLS template: 

• Label Switched Router—In the core network, it switches MPLS labels. 

• Label Edge Router—Connects customers into the access network. 

• SMS—Routes traffic to multiple IP provider routers. 

MPLS TEMPLATE CONNECTION SPECS 

In the MPLS template, the following connection types are available: 

• Assignable Bandwidth Links—The physical connections between elements. 

• Inverse Multiplexing Group –An aggregate group of connections used together for more 

capacity.  

• LSP (Label Switched Path)—The physical connection between label edge routers and 

label switched routers. 

• Enterprise Connection—A connection that connects customer sites. 
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• Internet Connection—A virtual connection that ultimately connects a customer to the 

Internet. 

PRIORITIZED PATHS 

Prioritized paths are the physical paths that a virtual circuit can ride over a transport backbone 

network. Enterprise and Internet connections have numerous paths.  

In the figure below, notice the predefined Priority 1 path for the Enterprise connection. 

 

Custom attributes 

Numerous custom attributes are predefined in M/5.1, including the following, which you may see 

when you use the MPLS templates:  

• Broadband Service Category—The category of service such as MPLS, Cell, and so forth. 

• VPN ID—The identification given to MPLS VPNs. 

• CE Topology—The topology of a VPN, as a hub or a spoke. 

Scenario 

Emory and Brown, an architectural firm headquartered in Boston, orders a private network to connect 

its headquarters to its Tulsa and Dallas offices. The firm frequently sends large graphics files 

containing confidential plans between its offices. It is concerned about the quality of the transmissions 

and data security. Emory and Brown does not currently have routers at any of its locations.  
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 MPLS Core Network

OC-12

Tulsa

Boston

Dallas

Boston

Dallas

Tulsa

 MPLS Access Network

OC-03

 MPLS Access Network

OC-03

 MPLS Access Network

OC-03

DS1

DS1

DS1

Emory & Brown

Headquarters

Emory & Brown

Dallas

Emory & Brown

Tulsa

 

Design network 

Zesty Comm has a Central MPLS OC12 core network that connects Boston, Dallas, and Tulsa. Each 

city has an OC3 access network, which should look like the following network: 
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 MPLS Core Network

OC-12

Tulsa

Juniper M10 Router

Boston

Junper M10 Router

Dallas

Junier M10 Router

Boston

Juniper M5 Router

Dallas

Juniper M5 Router

Tulsa

Juniper M5 Roter

 MPLS Access Network

OC-03

 MPLS Access Network

OC-03

 MPLS Access Network

OC-03

 

DEFINE NETWORK PROPERTIES  

Use the following information to define the properties of the core network: 

NETWORK PROPERTIES INPUT 

Network Template MetaSolv TM MPLS Core 

Network Short Name User nn MPLS Core 

Status In Service 

 

DEFINE ELEMENTS AND ASSOCIATE EQUIPMENT 

Use the following information to add and define the elements: 

ELEMENT PROPERTIES INPUT 

MPLS Router Name User nn Tulsa LSR 

Network Location TULSOKnnMPL 

Status In Service 

Relay Rack ZESTY TBND Lab MPLS 

Shelf Juniper M10 Router  

  

MPLS Router Name User nn Boston LER 
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Network Location BSTNMAnnMPL 

Status In Service 

Relay Rack ZESTY TBND Lab MPLS 

Shelf Juniper M10 Router 

  

MPLS Router Name User nn Dallas IP Router 

Network Location DLLSTXnnMPL 

Status In Service 

Relay Rack ZESTY TBND Lab MPLS 

Shelf Juniper M5 Router 

ADD RELATIONSHIP AND DESIGN CONNECTION 

 Note 
Inverse Multiplexing Spec 

Remove the Inverse Multiplexing Group specification from 

the Network Connection Specs pane by right-clicking and 

selecting Remove Connection Spec. 

 

Use the following information to add the relationship and design: 

RELATIONSHIP 

PROPERTIES 

INPUT 

Network Connection Spec Assignable Bandwidth Link 

Connection Type OTS Format 

Service Type Category CLFI 

Service Type Code OC12 

Equipment Use the first unassigned OC12 port. 

Broadband Service Category MPLS 

Bit Rate 622.56 M 

 

Use the following information to define the properties of the various access networks: 

NETWORK PROPERTIES INPUT 

Network Template MetaSolv TM MPLS Access 

Network Short Name User nn MPLS City name Access 

Status In Service 
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DEFINE ELEMENTS AND ASSOCIATE EQUIPMENT 

Use the following information to add and define the elements for each individual access network: 

ELEMENT PROPERTIES INPUT 

MPLS Router Name User nn Tulsa LER 

Network Location TULSOKnnMPL 

Status In Service 

Relay Rack ZESTY TBND Lab MPLS 

Shelf Juniper M5 Router  

  

MPLS Router Name User nn Boston LER 

Network Location BSTNMAnnMPL 

Status In Service 

Relay Rack ZESTY TBND Lab MPLS 

Shelf Juniper M5 Router 

  

MPLS Router Name User nn Dallas LERr 

Network Location DLLSTXnnMPL 

Status In Service 

Relay Rack ZESTY TBND Lab MPLS 

Shelf Juniper M5 Router 

 

DEFINE THE TRANSPORT NETWORK 

Use the following information to define the properties of the transport network: 

NETWORK PROPERTIES INPUT 

Network Template MetaSolv TM MPLS  

Network Short Name User nn MPLS Transport 

Status In Service 

 

EMBED NETWORKS 

Use the instructions found in the Design Network module to embed all the access networks and the 

core network. Connect each access network to the corresponding state core router. 
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Create the product catalog 

Use the steps in the Layer 2 VPN module to build your product catalog. You should include the 

following items: 

• MPLS Private Network (System)  

• Offices (Element) with a Cisco Router (CPE - tied to a Cisco 2611 Spec) 

• Access Connection (Connector - Physical) 

• Data Connection (Connector - Virtual) 

BUILD PRODUCT SPECS 

Use the following information to build the product specifications: 

• MPLS VPN: 

FIELD VARIABLE 

Type Network System 

Code nnmplsvpn 

Internal Alias nn mpls VPN 

Product/Package Checked 

 

End User Locations: 

FIELD VARIABLE 

Type Network Element 

Code nnmplseu 

Internal Alias nn MPLS End User Location 

 

Physical Connections: 

FIELD VARIABLE 

Type Network Connection 

Code nnmplslink 

Internal Alias nn MPLS VPN physical link 

 

Virtual Connections: 

FIELD NAME INPUT VALUE 

Type Network Connection 

Code nnmplsvirt 
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Internal Alias nn mpls vpn virtual data connection 

 

ASSOCIATE WITH NETWORK TEMPLATES  

Use the information below to associate the product specifications to the network templates: 

PRODUCT SPEC NETWORK TEMPLATE 

nn MPLS VPN MetaSolv TM MPLS VPN 

nn MPLS End User Location MetaSolv TM MPLS VPN 

nn MPLS VPN physical link MetaSolv TM MPLS VPN/VPN Link/MetaSolv TM 
MPLS VPN/Customer Edge Router/Label Edge 
Router/MetaSolv TM MPLS Access Network 

nn MPLS vpn virtual data 
connection 

MetaSolv TM MPLS VPN/CE 
Community/MetaSolv TM MPLS VPN/Customer 
Edge/Customer Edge/MetaSolv TM MPLS VPN 

 

RELATE ITEMS 

Relate the following items: 

• Type 1 and Type 2 product specifications 

• The nn MPLS end user location, the nn MPLS VPN physical link, and the nn MPLS VPN 

virtual with the nn MPLS VPN 

• Equipment with the nn MPLS end user location 

Ensure that the Cisco Catalyst 5500 is associated with the equipment. 

BUILD PRODUCT OFFERING 

Use the following information to build the product catalog for the nn MPLS VPN: 

FIELD VARIABLE 

Market Description Customer Ordered VPN over MPLS Transport 
network 

Service Category Business 

Offering Type Retail 

Network Template Type MetaSolv TM MPLS VPN 

 

End User Location: 

FIELD VARIABLE 
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Spec nn MPLS end user location 

Item Alias nn Office 

Network Template Type MetaSolv TM MPLS VPN 

 

You need to add equipment under your end user location. Also, add the Cisco Catalyst 5500 as the 

equipment specification. 

Physical MPLS VPN Connection: 

VARIABLE INPUT 

Spec nn MPLS vpn physical link 

Item Alias nn MPLS VPN Physical link 

Network Template Type MetaSolv TM MPLS VPN 

 

Virtual MPLS VPN Connection: 

VARIABLE INPUT 

Spec nn MPLS vpn virtual 

Item Alias nn MPLS VPN virtual 

Network Template Type MetaSolv TM MPLS VPN 

 

ENTER THE SERVICE REQUEST 

Use the following information to enter the service request. 

Query for customer nnEmory & Brown, open in the Customer Profile, and create a new order.  

Use the information below to complete the Service Order tab: 

FIELD VALUE 

Desired Due Date: 2 weeks out 

Ordered by Last Name Bland 

Ordered by First Name Paul 

Ordered by Telephone 
Nbr 

617 878-9099 

Organization Zesty Communications 

PON nn MPLS VPN 

 

Use the following information to order the nn IP VPN. 

FIELD VALUE 

Orderable item nn MPLS VPN 
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Short Name nn E&B VPN 

VPN ID 00034B 

CE Topology Hybrid 

NETWORK ELEMENTS 

Enter the following locations: 

LOCATIONS VALUE 

Location Name nn E&B main office 

Address Use the customer’s primary billing address. 

  

Location Name nn Tulsa  

Address 28nn Violet 

Tulsa, OK 74121 

  
Location Name nn Dallas  

Address 68nn Bluebonnet 

Dallas, TX 75023 

 

Order the following routers for each location: 

LOCATION VALUE 

nn 12 E&B nn Home Office, CE_RTR 

nn Tulsa  nn Branch Office, CE_RTR 

nn  nn Branch Office, CE_RTR 

Name the routers and enter the following attributes: 

FIELD VALUE 

Name nn E&B 

CE Manager Provider 

SA Agent Regular 

  

Name nn Tulsa  

CE Manager Provider 

SA Agent Regular 
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Name nn Houston  

CE Manager Provider 

SA Agent Regular 

 

Add the Cisco Catalyst 5500 to all locations. 

ADD CONNECTIVITY 

Connect all locations physically to the provider network and virtually to each other. 

Use the following information for all three virtual connections: 

FIELD VALUE 

Virtual Broadband 
Service Category 

MPLS 

 

 

Use the following information for all three physical connections:  

FIELD VALUE 

Virtual Broadband 
Service Category 

MPLS 

Bit Rate 44.736 M 

NNI/UNI UNI 

GENERATE TASKS 

Use the nn VPN provisioning plan to generate tasks. 

Provision service 

Use the NetDsgn task to create the access connections to the three sites. You will also install Cisco 

Catalyst 5500 routers at each location. 

 

 Note 
Auto ID 

The physical connections are auto identified because the 

Auto ID checkbox on the VPN Link connection spec is 

checked in the network template. 

 

Use the following information to identify the virtual connections: 
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CONNECTION FIELDS VALUES 

Connection Type OTS Format 

Service Type Category CLCI—SS LATA Access 

Service Type Code HC 

Freeform Circuit entry (Default) 

 

INSTALL ORDERED EQUIPMENT 

Add the Cisco Catalyst 5500 router. It is listed under the Equipment Type CPE-Customer Premise 

Equipment. 

ASSOCIATE CPE WITH THE LOCATIONS 

Select each customer location and put it “In Service.” Then associate the Cisco Catalyst 5500 router 

that you just installed.  

EMBED THE NETWORK 

You need to embed the IP network. To connect to the MPLS network, use the instructions in the 

Layer 2 VPN module, along with the following information: 

FIELD VALUES 

Element Type to Add MPLS Network 

Network to embed User nn MPLS 

ASSOCIATE CONNECTIONS  

Connect both Houston locations to the Houston router, and connect the Tulsa location to the Tulsa 

router. Design the Physical Connections 

Select VPN Links as your connection spec, and use the ordered connections you have already 

identified. 

To design the physical connections, use the instructions in the Layer 2 VPN module, along with the 

following information: 

 VALUES 

General Tab-Rate Code DS1 

Equipment on Design Lines Assign the Cisco 5500 router and the Juniper 
M05 router to the first available unassigned DS1 
ports. 

Broadband Service Category MPLS 

NNI/UNI UNI 
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Bit Rate 1.544 M 

 

Complete the NET DSGN task. 

DESIGN THE VIRTUAL CONNECTION 

Open the RID task to design the virtual connections. 

Set the Design Options to Path Analysis by Hops, or design the connection manually. 
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IP VPN Lab 

What you’ll learn in this chapter 

his module consists of a hands-on activity in which you will use the IP VPN template to build 

a network, enter an order for VPN service and provision the service. 

 

IP VPN technology module data 

The data included with the IP VPN technology module appears in the IP VPN template: 

 

ELEMENTS 

The following elements are included with the IP VPN technology module: 

• IP Network 

IP VPN 

Lab 

T 
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• Customer Edge Router 

• Remote User 

IP VPN CONNECTION SPECS 

The following connection specs are included with the IP VPN technology module: 

• CPE-based VPN Connection—The virtual connection that connects the customer 

equipment. 

• Network-Based VPN Connection—The virtual connection that connects customer 

routers. 

• VPN Link—The physical bandwidth connections that connect the customer routers to the 

transport network. 

• VLAN- Internet Connection—The virtual connection that connects a customer to the IP 

router. 

PRIORITIZED PATHS 

Below is the predefined Priority 1 path to connect to customer routers. 

 

CUSTOM ATTRIBUTES 

Custom attributes that you may see when creating IP VPNs include: 

• Tunneling Protocol—Identifies the tunneling protocol associated with network-based 

VPNs. 

• Userid/Password—Identifies the user ID and password associated with a remote user. 

• CE Topology—The customer edge topology (either a hub or a spoke). 

• VPN ID—The VPN identifier that identifies the organization providing the VPN. 
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Scenario 

Good Faith Insurance orders a private network to connect its main office in Houston to its branch 

offices in Houston and Tulsa. This network will give the insurance firm the ability to share rates, 

quotes, and claim information. The firm has a router installed at its main office, but it needs to install 

routers at both branch locations. 

Good Faith also has two traveling employees who need remote access connections. 

 

 

Design network 

Zesty Comm has an IP Core Network that consists of a Tulsa router, a Houston router, and a Dallas 

router. Each router connects the public Internet over OC48 fiber.  

Use the following information to define the properties of the network: 

NETWORK PROPERTIES INPUT 

Network Template MetaSolv TM IP Network 

Network Short Name nn IP 

Status In Service 
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DEFINE ELEMENTS AND ASSOCIATE EQUIPMENT 

Use the following information to add and define the elements: 

ELEMENT PROPERTIES INPUT 

IP Router Name User nn Tulsa IP router 

Network Location TULSOKnnIPN 

Status In Service 

Relay Rack ZESTY TBND IP Network 

Shelf Cisco IP router  

  

IP Router Name User nn Houston IP router 

Network Location HSTNTXnnIPN 

Status In Service 

Relay Rack ZESTY TBND IP Network 

Shelf Cisco IP router  

  

IP Router Name User nn Dallas IP router 

Network Location DLLSTXnnIPN 

Status In Service 

Relay Rack ZESTY TBND IP Network 

Shelf Cisco IP router  
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ADD THE RELATIONSHIP AND DESIGN THE CONNECTION 

 Note 
Remove Inverse Multiplexing Spec 

The Inverse Multiplexing Spec already displays in the 

Connection Spec pane and needs to be removed. 

Right-click Inverse Multiplexing Spec and select 

Remove Connection Spec. 

 

Use the following information to add the relationship and design: 

RELATIONSHIP 

PROPERTIES 

INPUT 

Network Connection Spec Assignable Bandwidth Link 

Connection Type OTS Format 

Service Type Category CLFI 

Service Type Code OC48 

Equipment Use the first Unassigned OC48 port. 

Broadband Service Category IP 

Bit Rate 2.4 Gbps 

Create the product catalog  

Use the steps in the Layer 2 VPN module to build your product catalog. You should include the 

following items: 

• IP Private Network (System)  

• Home Office (Element) with a Cisco Router (CPE - tied to a Cisco 2611 Spec) 

• Branch Office (Element) with a Cisco Router (CPE - tied to a Cisco 2611 Spec) 

• Access Connection (Connector - Physical) 

• Data Connection (Connector - Virtual) 

BUILD PRODUCT SPECS 

Use the following information to build the product specifications: 

IP VPN: 
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FIELD VARIABLE 

Type Network System 

Code nnipvpn 

Internal Alias nn IP VPN 

Product/Package Checked 

 

End User Locations: 

FIELD VARIABLE 

Type Network Element 

Code nnipeuloc 

Internal Alias nn IP End User Location 

 

Physical Connections: 

FIELD VARIABLE 

Type Network Connection 

Code nnIPlink 

Internal Alias nn IP VPN physical link 

 

Virtual Connections: 

FIELD NAME INPUT VALUE 

Type Network Connection 

Code nnipvirt 

Internal Alias nn ip vpn virtual  

 

ASSOCIATE WITH NETWORK TEMPLATES  

Use the information below to associate the product specifications with the network templates: 

PRODUCT SPEC NETWORK TEMPLATE 

nn IP VPN MetaSolv TM IP VPN 

nn IP End User Location MetaSolv TM IP VPN 

nn IP VPN physical link MetaSolv TM IP VPN/VPN Link/MetaSolv TM IP 
VPN/Customer Edge Router/IP Router/MetaSolv 
TM IP Network 

nn ip vpn virtual MetaSolv TM IP VPN/Network-based 
VPN/MetaSolv TM IP VPN/Customer 
Edge/Customer Edge/MetaSolv TM IP VPN 



I P  V P N  

©Metasolv Software, Inc. 189 

RELATE THE ITEMS 

Use the following information to relate the items: 

• Type 1 and Type 2 product specifications 

• The nn IP end user location, the nn IP VPN physical link, and the nn IP VPN virtual 

connection with the nn IP VPN 

• Equipment with the nn IP end user location. 

Ensure that the Cisco 2611is associated with the equipment. 

BUILD PRODUCT CATALOG 

Use the following information to build the product catalog for the nn IP VPN: 

FIELD VARIABLE 

Market Description Customer Ordered VPN over IP transport 
network 

Service Category Business 

Offering Type Retail 

Network Template Type MetaSolv TM IP VPN 

 

Use the following information to build the product catalog: 

End User Location for Home Office: 

FIELD VARIABLE 

Spec nn ip end user location 

Item Alias nn Home Office 

Network Template Type MetaSolv TM IP VPN 

End user location for the branch office: 

FIELD VARIABLE 

Spec nn ip end user location 

Item Alias nn Branch Office 

Network Template Type MetaSolv TM IP VPN 

 

Add the Equipment specification to each of the end user locations and add the Cisco 2611 on the 

Equipment Spec tab. 

Physical IP VPN Connection: 
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FIELD VARIABLE 

Spec nn ip vpn physical link 

Item Alias nn IP VPN Physical link 

Network Template Type MetaSolv TM IP VPN 

 

Virtual IP VPN Connection: 

FIELD VARIABLE 

Spec nn ip vpn virtual 

Item Alias nn IP VPN virtual 

Network Template Type MetaSolv TM IP VPN 

QUERY FOR THE CUSTOMER AND CREATE THE ORDER 

Query for customer nnGood Faith in the Customer Profile and create a new order.  

Use the information below to complete the Service Order tab: 

FIELD VALUE 

Desired Due Date: 2 weeks out 

Ordered by Last Name Wilson 

Ordered by First Name Sara 

Ordered by Telephone 
Nbr 

713 599-0099 

Organization Zesty Communications 

PON nn IP VPN 

 

Use the following information to order the nn IP VPN: 

FIELD VALUE 

Orderable item nn IP VPN 

Short Name nn GF Ins VPN 

VPN ID 00038A 

CE Topology Hybrid 

NETWORK ELEMENTS 

Enter the following locations: 

LOCATIONS VALUE 

Location Name nn GFI main office 
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Address Use the customer’s primary billing address. 

  

Location Name nn Tulsa Claims Office 

Address 35nn Division 

Tulsa, OK 74119 

  
Location Name nn Houston Claims Office 

Address 36nn Marine Blvd. 

Houston, TX 77204 

 

Order the following routers for each location: 

LOCATION VALUE 

nn GFI Main Office nn Home Office, CE_RTR 

nn Tulsa Claims Office nn Branch Office, CE_RTR 

nn Houston Claims Office  nn Branch Office, CE_RTR 

Name the routers and enter the following attributes: 

FIELD VALUE 

Name nn Good Faith CER 

CE Manager Provider 

SA Agent Regular 

  
Name nn Tulsa Claims CER 

CE Manager Provider 

SA Agent Regular 

  
Name nn Houston Claims CER 

CE Manager Provider 

SA Agent Regular 

Add the Cisco 2611 to all locations. 

Add connectivity 

Connect all locations physically to the provider network and virtually to each other. 

Use the following information for all three virtual connections:  
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FIELD VALUE 

Virtual Broadband Service 
Category 

IP 

Tunneling Protocol IP Sec 

 

Use the following information for all three physical connections: 

FIELD VALUE 

Virtual Broadband 
Service Category 

IP 

Bit Rate 44.736 M 

NNI/UNI UNI 

 

GENERATE TASKS 

Use the nn VPN provisioning plan to generate tasks. Change the Engineer queue to Provnn. 

Provision service 

Use the NET DSGN task to identify connections, install equipment, and design the physical 

connections. Then use the RID task to design the virtual connections. 

IDENTIFY THE CONNECTIONS 

The VPN link for the Layer 2 VPN was set in the template as Auto Identifiable. Therefore, the 

software has already identified those connections for you. 

Use the following information to identify the virtual connections: 

CONNECTION FIELDS VALUES 

Connection Type OTS Format 

Service Type Category CLCI—SS LATA Access 

Service Type Code HC 

Freeform Circuit entry (default) 

INSTALL ORDERED EQUIPMENT 

Add the Cisco 2611 router, which is listed under the Equipment Type CPE-Customer Premise 

Equipment. 
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ASSOCIATE THE CPE WITH LOCATIONS 

Select every customer location and put them “In Service.” Then associate the Cisco 2611 router that 

you just installed.  

Embed the network 

You need to embed the IP network. Use the instructions in the Layer 2 VPN module and the following 

information to connect to the IP network: 

FIELD VALUES 

Element Type to Add IP Network 

Network to embed User nn IP 

ASSOCIATE CONNECTIONS WITH NETWORK 

Connect both Houston locations to the Houston router. Also connect the Tulsa location to the Tulsa 

router. 

DESIGN PHYSICAL CONNECTIONS 

Select VPN Links as your connection spec and use the ordered connections you have already 

identified. 

Use the instructions in the Layer 2 VPN module and the following information to design the physical 

connections: 

 VALUES 

Rate Code on General tab DS3 

Equipment on Design Lines Assign the Cisco 2611 router and the Cisco 
12008 router to the first available unassigned 
DS3 ports. 

Broadband Service Category IP 

NNI/UNI UNI 

Bit Rate 44.736 M 
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ASSIGN AN IP ADDRESS 

Use the IP addresses associated with the nn_Backbone use group to assign a /30 IP address to each 

customer equipment assignment and at each IP router assignment. 

Complete the NET DSGN task. 

DESIGN THE VIRTUAL CONNECTION 

Open the RID task to design the virtual connections. 

Set the Design Options to Path Analysis by Hops and select paths that have the fewest hops. 

Complete the RID task. 
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Appendix A  

What you’ll learn in this chapter 

his module consists of a hands-on activity in which you will use the Ethernet template to build 

a network, enter an order for LAN to LAN service and provision the service. 

Module Answers 

Module 1—Network Template Overview 

1. The template type is the transport technology or network system type, such as ATM or DLC. 

Templates are used to order and provision services over a transport technology. There can be 

multiple templates for a technology or template type such as Layer 2 VPN or Ethernet 

transport. 

2. To retain the relationships between embedded templates. 

3. Layer 2 VPN. 

4. IP Network. 

5. See figure below. 

 

Appendix A 

 

T 



A P P E N D I X  A  

©Metasolv Software, Inc. 196 

IP Network

Customer  Site

Voice Gateway

PSTN Switch

ATM  Switch

Aggregator

Service Management

System (SMS)

ATM  Core Network

1.

3.

4.

2.

Network Template

Relationship

Element Type Element Type

 

Module 2—Identify ATM/FR Technology Module Data 

6. Assignable Bandwidth Link, Inverse Multiplexing Group and Unassignable Bandwidth Link. 

7. Assignable Bandwidth Link, Inverse Multiplexing Group and Unassignable Bandwidth Link 

8. No. 

9. Enterprise. 

10. IP Network, Customer Site, ATM Switch, SMS, PSTN, Aggregator, Voice Gateway. 

11. Customer Site>Other Provider Network>ATM Core Switch>ATM Access Switch>ATM Core 

Switch>Other Provider Network>Customer Site. 

12. ATM-VC Send and Receive Parameters, ATM address, ATM ConnectionType, Bc Send and 

Receive, Be + Bc Send and Receive, and so on. 

Module 3—Design Network 

The ATM Core network should look similar to the one below.  
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The Dallas to Boston connection design lines should look similar to the ones below: 

 

 

 

ATM Access Network 
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The design lines for the connection between Dallas and Plano should look similar to the one below: 

 

 

Your Central ATM/Frame Relay network should look similar to the one below when the embedded 

networks are collapsed. 
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The design lines for the connection between the Boston ATM core switch and the Boston Frame 

Relay access network should look similar to the ones below: 

 

 

Module 4—Build Product 

Below are screenshots of the Virtual Connection as part of the Dedicated PVC Product. 
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Below are screenshots of the VPN Provisioning Plan. 
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Module 6—Test Network 

Your GLR should look similar to the one below: 
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DSL Lab 

Your ATM access should have the same element types as the ones shown below: 

 

 

Your DSL network should look similar to the one shown below: 
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Your product catalog should look similar to the one below: 

 

 

Your completed order should resemble the one below: 

 

 

Your voice connection design should look similar to the one below: 
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You Internet connection design should look similar to the following: 

 

 

LAN to LAN Lab 

Your network should look similar to the one below: 
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MPLS Lab 

Your MPLS network system should look similar to the one shown below: 

 

 

Your VPN should look similar to the one shown below: 

 

 

Your virtual connections should all look similar to the one below: 
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LAN to LAN Lab 

Your network should look similar to the one below: 

 

 

IP VPN 

Your IP network should look similar to the one shown below: 
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Your product catalog should look like the one below: 
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You order should look similar to the one below: 

 

 

You NETDSGN task should look similar to the one shown below: 

 

 

Below is an example of the virtual connection between the two claims’ offices: 
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Appendix B  

Equipment 

Below are equipment definitions for various equipment types: 

• Aggregator—The aggregator combines high-speed outputs onto a higher speed 

connection. Example: This can be used to aggregate multiple DS1s to DS3s or it can be 

used to aggregate traffic from multiple DSLAMs. 

• Authorization Server—The server used to provide validations for Internet access. 

• Class 5 Switch—The switch used for POTS (Plain Old Telephone Service).  

• DSLAM—The Digital Subscriber Line Access Multiplexer combines many DSL services 

into one high-speed connection. It can also split the frequency band used for the data 

connection from the voice connection. 

• DSL Modem—The modem typically used at a residential customer site to access the 

Internet over a DSL connection. 

• Integrated Access Device—The equipment typically used by a business customer to 

deliver voice and data services via LAN ports  

• IP Router—The router used to access an ISP (Internet Service Provider). 

• Label Switch Router (LSR)—The switch router used at network edges to apply labels 

used for MPLS. 

• Subscriber Management System—The device that aggregates DSL traffic and provide 

access to multiple ISPs. 

• Voice Gateway—The equipment that converts voice from ATM to Digital Loop Carrier 

(DLC) technology. With DLC, the channels between the voice gateway and the Class 5 

Switch are dynamically selected as calls are processed. 

Appendix B 

 



A P P E N D I X  B  

©Metasolv Software, Inc. 212 

Bit Rate Equivalents 

Below are bit rate equivalents for various transmission rates. 

• OC1 = 51.84 Mbps 

• OC3 = 155.52 Mbps 

• OC12 = 622.08 Mbps 

• OC48 = 2.4 Gbps 

• OC192 = 9.9 Gbps 

•  

Peak Cell Rate Equivalents 

Below are various cells per second for various transmission rates. 

• T1 = 3,641 Cells Per Second (CPS) 

• T3 = 107,868 Cps 

• OC03 = 365,566 Cps 

Field Descriptions—Managing a Template 

The table below provides fields and descriptions for this window: 

 

FIELD DESCRIPTION 

Template Type Type of network template. 

Network Template Name Name of network template. 

External/Internal Specifies whether the template is internal (to the service provider) or external (for 
sale to a customer). 

Active (checkbox) Indicates that the network template type is currently active. 

Custom Attributes When modified in a utility tool, these specify values to building blocks. 
Customizable because your business processes and practices dictate how these 
will be used. 
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Field Descriptions—Managing a Template Element Type 

The table below provides the fields and descriptions for this window in alphabetical order: 

 

FIELD DESCRIPTION 

Element Label User-defined element name. 

Image Scale Size of the element’s graphical image, expressed as a percentage of the 
canvas default. 

Element Type Name The name of the element.  

Min Required Per System Minimum number of element types required in a network system. 

Max Allowed Per System Maximum number of element types allowed in an entire network system. 

Outside Assignments How the system handles assignments made outside of itself. (An outside 
assignment reduces the available capacity of a system.) 

Base Component Element type to which a service item is connected last. For example, an LDS is 
the last element type to which a circuit riding a DS0 connects. Intermediate 
element types can be COTs or RDTs or both. A secondary element type is 
DCS. 

Location Required Indicates that a service location is required when you use an element type in a 
system. 

Allow Port Association Indicates that you can associate port addresses with a specified element. 

Network Extension Indicates that an element is an extension of a service provider's network. 

Allow Equipment at Multiple Locations Indicates that you can associate equipment from multiple locations with an 
element. 

Orderable Indicates that the template element type can be included on an order. 

Active Indicates that the element type specification is currently active. 
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Field Descriptions—Managing a Template Relationship (General 
View) 

The table below provides the fields and descriptions for this window in alphabetical order: 

 

FIELD DESCRIPTION 

(Element Type 1) Role Function of the element type at the top or left end of an element relationship in a 
network template. <Element Type 1> is a variable for different element types, 
such as ATM_SW, EUL, and DSLAM. 

(Element Type 2) Role Function of the element type at the bottom or right end of an element 
relationship in a network template. <Element Type 2> is a variable for different 
element types, such as ATM_SW, EUL, and DSLAM. 

Intra/Inter Network Specifies the element type relationship is between two element types in either 
the same network (intranetworking) or in different networks (internetworking). 

Maximum Allowed The maximum number of secondary elements you can connect to each primary 
element. 

Minimum Required The minimum number of secondary elements you must connect to each primary 
element. 

 

Field Descriptions—Managing an Element Type 

The table below provides the fields and descriptions for this window in alphabetical order: 

 

FIELD DESCRIPTION 

Active Indicates the element type is currently active. 

Continuous Add Indicates you can create new records without returning to the panel. 

Element Type Used as an abbreviation of the Element Type Name 

Element Type Name Name of the element type. 

Image Name Name of the image you associate with an element type. 

 

Field Descriptions—Connection Type  

The table below provides the fields and descriptions for this window in alphabetical order: 

 

FIELD DESCRIPTION 

Active Indicates the connection type is currently active. 

BW/TDM Specifies whether the connection is bandwidth or TDM. 

Category Category of connection specification type. 

Connection Type Type of connection that joins two network template element types or network 
system elements. 

Continuous Add Indicates you can create new records without returning to the panel. 
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FIELD DESCRIPTION 

Name Name associated with the connection type. 

 

Field Descriptions—Managing a Connection Spec (General 
View) 

The table below provides the fields and descriptions for this window in alphabetical order: 

 

FIELD DESCRIPTION 

Active Indicates the connection specification is currently active. 

Assignment Required Indicates an assignment must be made to a connection. 

Auto Id Indicates the connection can be auto ID’ed. 

Capacity Calculation Specifies how to handle the transmission rate for segments of a multi-point 
connection. You can add the transmission parameter for each segment, or use 
the transmission parameters of the connection. 

Connection Spec Name Name of a connection specification. 

Connection Type Type of connection that joins two network template element types or network 
system elements. 

Continuous Add Indicates you can create new records without returning to the panel. 

Max Connections Allowed Per Spec Maximum number of connections per specification you can relate to a parent 
connection. 

Max Specs Allowed Per System Maximum number of connection specifications that can exist in an entire 
network system. 

Min Connection Required Per Spec Minimum number of connections per specification you must relate to the parent 
connection. 

Min Specs Required Per System Minimum number of connection specifications required in a network system. 

Multipoint Type The multipoint status of a connection. Either a connection is point to point or it is 
multipoint. 
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Glossary 

A 
Activation: This term, in the context of this document, is used to describe the process of translating an order into a 

usable service.  

Addled: The state in which we sometimes find Celita, Fred, and Cathie, but never Susan, Laurie or Connie.  

B 
Backlog: This term will eventually refer to the number of courses we’ve been requested to write.  

Battering Ram: The instrument occasionally used to make a successful suggestion to management. 

C 
Canvas: The area of the software used to view graphical representations of templates and networks.  

Connector: The item type used to create product specifications for network connections and standalone 

connections, for example: a virtual connection to connect two branch offices, or an access connection from a customer 
to a DSLAM. 

Custom Attributes: The information that describes a building block. They can be customized for the four 

following building block types: templates, elements, connections, and connection allocations. 

D 
Disposition Days: A user-defined number of days that can be inserted between tasks when no work is to be 

completed. 

Doggie: The mammal with which a human being is most likely to experience unconditional love.  

E 
Element: The item type used to create product specifications for network elements, for example: a home office.  

Element Type: Representations of nodes in a network system. Element types can be equipment or other network 

systems. 

F 

G 

H 
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I 

J 

K 

L 

M 

N 
Network Template: The elements, rules and connections associated with a particular technology. There can be 

multiple network templates for one technology. 

 

O 

P 
Prioritized Path: The various paths through a network that a virtual connection can traverse.  

Prdbundle: The item type used to create product specifications for product bundles, for example: DSL.  

Product Service Request (PSR): A customer request for service that includes customer  and service 

information. 

Product Specifications: Blueprints for products. These are items that are offered based on the networks. 

Provisioning Plan: A set of tasks, work queues, and due dates required to manage the flow of work to provision 

service. 

Q 

R 
Relationship: The representation of connections between elements. Relationships can be Intranetworking and 

connect elements within the same network, or they can be Internetworking and connect elements in different networks.  
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S 
System: The item type used to create product specifications that represents network systems, for example: MPLS 

virtual private network. 

T 
Tasks: The actual work that needs to be done to provision customer service.  

Technology Module: A network system type that includes predefined network templates that you use to build 

networks, build products and provision service. You receive a technology module when you license a specific 
technology. 

 

V 

W 
Work queues: The various work groups responsible for performing tasks. For example, there may be an Engineer 

work queue that designs circuits and a Field Service work queue for wire office testing tasks.  

X 

Y 

Z 
 

 

 

 


